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DiscoverSim™ Version 3.0 Feature List Summary 
 

• Excel add-in for Monte Carlo Simulation and Optimization  

• Uses Six Sigma Language: Specify Inputs (X’s) and Outputs (Y’s) 

• Monte Carlo simulation with 53 Continuous and 10 Discrete Distributions 

• Batch Distribution Fitting for all Continuous and Discrete Distributions (excluding custom) 

• Nonnormal Process Capability for all Continuous and Discrete Distributions (excluding 
custom) 

• Percentiles to Parameters Calculator 

• Specify Input Correlations 

• Excel Formula Interpreter for Accelerated Calculations 

• Sensitivity Analysis based on correlation or stepwise regression 

• Optimization using Input Controls: 

o Mixed Integer Distributed Ant Colony Global Optimization (MIDACO) 

o Genetic Algorithm (GA) Global Optimization 

o Sequential Quadratic Programming (SQP) for fast local optimization 

o Nelder-Mead (NM) simplex optimization for fast local non-smooth problems 

o Exhaustive Discrete optimization – all combinations for small discrete problems 

o Powerful hybrid of the above methods: 

1. All discrete controls: MIDACO or Exhaustive Discrete if applicable 

2. All continuous controls: MIDACO, GA, followed by SQP or NM 

3. Mixed continuous/discrete controls: MIDACO 1 (Course), MIDACO 2 (Fine), 
followed by SQP or NM 

o Specify linear and nonlinear constraints 

o Stochastic Optimization – minimize dpm or maximize Ppk 

o Insert DSIM functions such as Percentiles or Capability Metrics. These can then be 
used in constraints. 

o Multiple Response Optimization using Desirability, Weighted Sum or Deviation from 
Target 

• Recall DiscoverSim Dialog button. 

• DiscoverSim is bundled with SigmaXL Version 11.0 for statistical and graphical analysis. 
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MIDACO 
 
DiscoverSim utilizes MIDACO, one of the world’s strongest evolutionary solvers for mixed discrete, 
continuous, constrained global optimization. 

MIDACO stands for Mixed Integer Distributed Ant Colony Optimization.  It is suitable for problems 
with up to several hundreds to some thousands of optimization variables. It was developed in 
collaboration with the European Space Agency (ESA) and represents the state-of-the-art in 
interplanetary space trajectory optimization. MIDACO holds the benchmark world record best 
solution to Full Messenger (Mission to Mercury), which is considered the most difficult space 
trajectory problem in the ESA Global Trajectory Optimization Database.  
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Common Continuous Distributions: 
 

1. Normal 

2. Triangular 

3. Uniform 

4. Pearson Family (specify Mean, StdDev, Skewness, Kurtosis) 

5. Log Normal** 

6. Exponential**  

7. Weibull** 

8. PERT 

9. Custom Continuous (Weighted and Unweighted) 
 

Advanced Continuous Distributions: 
 

1. Beta 
2. Beta (4 Parameter) 
3. Box-Cox** 
4. Burr** 
5. Cauchy 
6. Chi-Squared** 
7. Chi-Squared with Scale  

(3 Parameter)** 
8. Error Function (ERF) 
9. F** 
10. F with Scale (4 Parameter)** 
11. Fatigue Life** 
12. Fisk** 
13. Folded Normal 
14. Frechet** 
15. Gamma** 
16. Generalized Error 
17. Generalized Gamma** 
18. Generalized Logistic 
19. Generalized Pareto 
20. Half Normal** 
21. Inverse Gamma** 
22. Inverse Gaussian 

 

23. Johnson SB 
24. Johnson SL 
25. Johnson SU 
26. Laplace 
27. Largest Extreme Value 
28. Levy 
29. Logistic 
30. Log Gamma** 
31. Log Logistic** 
32. Maxwell 
33. Non-Central Chi-Squared** 
34. Non-Central F** 
35. Non-Central T 
36. Pareto 
37. Power 
38. Rayleigh 
39. Reciprocal 
40. Skew Normal 
41. Smallest Extreme Value 
42. Student’s T 
43. Student’s T with Location and Scale (3 

Parameter) 
44. Von Mises 

 
** denotes with/without Threshold 
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Discrete Distributions: 
 

20. Bernoulli (Yes/No) 
21. Binomial 
22. Geometric 
23. Hypergeometric 
24. Logarithmic 
25. Negative Binomial 
26. Poisson 
27. Step 
28. Uniform (Discrete) 
29. Custom Discrete (Weighted and Unweighted) 

 
 

Stochastic Information Packet (SIP): 
 

• Import Stochastic Information Packet (SIP).  
• A SIP is a standard library of data (see ProbabilityManagement.org for more details on 

this standard).  DiscoverSim treats this as a custom distribution with unweighted data 
and is sampled sequentially. 
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What’s New in Version 3.0 
 
New features in DiscoverSim Version 3.0 include: 

• DiscoverSim is bundled with SigmaXL Version 11.0 for statistical and graphical analysis, now 
with Advanced Design of Experiments.  See “What’s New in SigmaXL Version 11.0” in the 
SigmaXL workbook. 

• Convert SigmaXL Regression/DOE Model.  Modify a Regression or DOE Model so that it can 
be used for Monte Carlo simulation in DiscoverSim. Case Study 8 has been added to 
demonstrate this feature: Optimization of Yield for a 5 Factor Definitive Screening Design. 

• Accelerated Simulation and Optimization support for Excel 2021 functions:  XLOOKUP and 
XMATCH. 

  



DiscoverSim: Feature List, Installation Notes, Getting Help and Product Registration 

8 

Installation Notes  
 
1. This installation procedure requires that you have Administrator rights to install the software 

on your computer. Also, please ensure that you have the latest Microsoft Office service pack 
by using Windows Update before installing DiscoverSim. 

 
2. Download DiscoverSim from the link that is provided.  Double-click on the file 

DiscoverSim_Setup.msi.  The setup file will launch the installation of DiscoverSim.  Click on the 
“Next” button to begin the installation. 

 

 
 

 
 

3. Read the License Agreement and select the option “I accept the terms of the license 
agreement” to continue.   
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4. Press the “Install” button. 
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The wizard will then install the version of DiscoverSim which is required for your system.  A 
progress bar window will appear as the files are transferred. 
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5. Press the “Finish” button. 
 

 
 
6. To start DiscoverSim, double-click on the DiscoverSim desktop icon or click Start > Programs 

>All Programs > SigmaXL > DiscoverSim. 
 
 

 
 

7. The DiscoverSim Ribbon appears as shown below: 
 

 
 
Note: SigmaXL is bundled with DiscoverSim, so the SigmaXL menu tab is also available. See 
the SigmaXL workbook for further details. 
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DiscoverSim™ System Requirements  
 
Minimum System Requirements: 
 

Computer and processor:  1.6 gigahertz (GHz) or faster, 2-core. 

Memory:  4 GB of RAM or greater. 

Hard disk:  1 GB of available hard-disk space. 

Display:  1280x768 or higher resolution monitor. 

Windows Operating System:  Microsoft Windows 11 with current Service Packs, or later operating 
system. 

Microsoft Windows Excel version:  Excel 2021+, Microsoft 365 with latest service packs installed.  
64-bit versions of Excel are highly recommended for large simulation or optimization models. 
 
Administrative Rights to install software. 
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Getting Help and Product Registration 
 
To access the help system, please click DiscoverSim > Help > Help. 
 
Technical support is available by phone at 1-866-475-2124 (toll-free in North America) or 1-519-
579-5877 or e-mail support@sigmaxl.com. 
 
Please note that registered users obtain free technical support and upgrades for one year from 
date of purchase.  Optional maintenance renewal is available for purchase prior to the anniversary 
date. 
 
To register by web, simply click DiscoverSim > Help > Register DiscoverSim. 
  

mailto:support@sigmaxl.com
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Initializing DiscoverSim Workbook 
 
When you create a new workbook, and click DiscoverSim Input Distribution or Input Control, the 
following message appears: 
 

 
 
Initialization is only done once in a workbook.  This creates the following hidden worksheets: 

• Options 

• XLDta 

• DSim_Correlations 

These hidden sheets should not be modified. Modifications will likely corrupt the DiscoverSim 
model. 
If you create a DiscoverSim model, and then wish to completely delete it, you can delete all of the 
above hidden worksheets using DiscoverSim > Help > Clear DiscoverSim Data. 
 



  

Copyright © 2011 - 2025, SigmaXL Inc. 
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Introduction to Monte Carlo Simulation and Optimization 
with DiscoverSim™ 
 
The Y=f(X) Model 
 
DiscoverSim utilizes the “Y=f(X)” model, where Y denotes a key process output response and X 
denotes a key process input.  This is shown pictorially as: 
 

 
 
The DiscoverSim menu buttons to specify inputs are: 
 

 
 
An input distribution is stochastic and includes random variation. It can be continuous or discrete. 
The most common continuous distribution is the normal distribution with parameters mean and 
standard deviation.  DiscoverSim includes 53 continuous and 10 discrete distributions.  
 
An input control is set to a constant value, but it can be varied like the temperature control knob of 
a thermostat and is used for optimization. An input control can be continuous or discrete.  
 
The DiscoverSim menu button to specify an output response is: 
 

 
 

ProcessX Y
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A DiscoverSim model requires at least one input and one output. The output cell must contain an 
Excel formula that is a function of the inputs and references the cell address of the inputs or 
intermediate calculations including the inputs. The formula can be linear or non-linear and include 
Excel functions. The formula can reference other sheets within the workbook, but should not 
reference other workbooks. 
 
The DiscoverSim Excel Formula Interpreter is used to dramatically accelerate the speed of 
calculations during simulation or optimization.  
 
The Y = f(X) equation should be based on theory, process knowledge, or the prediction formula of a 
designed experiment or regression analysis. In Design for Six Sigma (DFSS), this is referred to as the 
“Transfer Function.”  This prediction equation should be validated prior to use in DiscoverSim. As 
the eminent statistician George Box said, “All models are wrong, some are useful,” so while the 
model does not have to be exact, it should be a reasonable approximation of reality.  The results of 
a DiscoverSim analysis should also be validated with further experimentation or use of prototypes. 
 
Monte Carlo Simulation 
 
The Y = f(X) model gives us a starting point in the relationship between X and Y.  After the  
Y = f(X) relationship has been validated, an important question that then needs to be answered is: 
“What does the distribution of Y look like when I cannot hold X constant, but have some 
uncertainty in X?” In other words, “How can I quantify my risk?” 
 
Take an example of a sales forecast.  Y is the predicted monthly sales, which is a sum of forecasts 
from five different product line sales managers.  If each manager simply reports a single “most 
likely” estimate, the total predicted sales will also be a single “most likely” estimate. The problem 
with this approach is obvious; it does not take the uncertainty into account.  So what then should 
be done?  In addition to the most likely estimates, each sales manager could include best and worst 
case estimates. Alternatively, an estimate of the mean and standard deviation could be reported. 
 
The challenge then becomes how to best take the uncertainty into account. One could simply sum 
the best and worst case values (or the +/-3 standard deviation values), and thus report the total 
range.  This approach, however, is unsatisfactory because it does not take into account the very 
low likelihood that each line will simultaneously have a best case or worst case value.  This would 
be akin to rolling 5 dice and getting 5 ones or 5 sixes. 
 
If each of the sales managers assume a normal distribution, the distribution for total sales will also 
be normal with: 
 
Total Mean = Mean1 + …+ Mean5 

 
Total StdDev = SQRT( (StdDev1)2 +…+ (StdDev5)2). 
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If, however, some of the product lines have correlated sales, i.e., an increase in sales for product A 
also means an increase in sales for product B, then “things get complicated.” The StdDev formula 
given above does not hold because it assumes independence.  Further complications arise if the 
sales managers need to use different distributions or if the total sales involve more than a simple 
sum.  This is where Monte-Carlo simulation comes in to solve the complex problem of dealing with 
uncertainty by “brute force” using computational power. 
 
The Monte Carlo method was coined in the 1940s by John von Neumann, Stanislaw Ulam and 
Nicholas Metropolis, while they were working on nuclear weapon projects in the Los Alamos 
National Laboratory. It was named in homage to Monte Carlo Casino, a famous casino, where 
Ulam's uncle would often gamble away his money  
(Ref: http://en.wikipedia.org/wiki/Monte_Carlo_method). 
 
The following diagram illustrates a simple Monte Carlo simulation using DiscoverSim with three 
different input distributions (X’s also known as “Assumptions”): 
 

 
 
A random draw is performed from each input distribution, Y is calculated, and the process is 
repeated 10,000 times.  The histogram and descriptive statistics show the simulation results. While 
not shown here, requirements (specification limits) can easily be added to Y to obtain probability of 
nonconformance. 
 
Notice that even though input distributions A2 and A3 are not normal, the distribution for the total 
is normal. This is due to the central limit theorem.  Of course, this will not always be the case when 
performing a Monte-Carlo simulation! 
 

Y = A1 + A2 + A3 
10,000 Replications 

http://en.wikipedia.org/wiki/Monte_Carlo_method
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The areas of application for Monte-Carlo simulation are very wide, including Design for Six Sigma 
(DFSS), Tolerance Design, Project Management and Risk Management with common use in 
Engineering, Finance, Telecommunications and Oil & Gas Exploration. 
 
The following books are recommended for further reading: 
 
Savage, Sam (2009), The Flaw of Averages: Why We Underestimate Risk in the Face of Uncertainty, 
Hoboken, NJ, Wiley. 
 
Sleeper, Andrew (2006), Design for Six Sigma Statistics: 59 Tools for Diagnosing and Solving 
Problems in DFSS Initiatives, NY, McGraw-Hill. 
 
Components of Uncertainty 
 
There are two components to uncertainty: one is the actual process variation, and the second is 
measurement error or error due to lack of knowledge. The contribution of the latter can be 
incorporated into a model, but for simplicity in our discussions and case studies, we will assume 
that the measurement error is negligible.  
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Selecting a Distribution 
 
Selecting the correct distribution is a critical step towards building a useful model. 
 
The best choice for a distribution is one based on known theory. For example, the use of a Weibull 
Distribution for reliability modeling. 
 
A common distribution choice is the Normal Distribution, but this assumption should be verified 
with data that passes a normality test with a minimum sample size of 30; preferably 100. 
 
If data is available and the distribution is not normal, use DiscoverSim’s Distribution Fitting tool to 
find a best fit distribution. Alternatively, the Pearson Family Distribution allows you to simply 
specify Mean, StdDev, Skewness and Kurtosis. 
 
In the absence of data or theory, commonly used distributions are: Uniform, Triangular and PERT. 
Uniform requires a Minimum and Maximum value, and assumes an equal probability over the 
range. This is commonly used in tolerance design. Triangular and PERT require a Minimum, Most 
Likely (Mode) and Maximum.  PERT is similar to Triangular, but it adds a “bell shape” and is popular 
in project management. 
 
The following table is a summary of all distributions in DiscoverSim (** denotes with/without 
Threshold).   
 

Common Continuous Advanced Continuous Discrete 

• Normal 
• Triangular 
• Uniform 
• Pearson Family (specify 

Mean, StdDev, Skewness, 
Kurtosis) 

• Log Normal** 
• Exponential**  
• Weibull** 
• PERT 
• Custom Continuous 

 

• Beta 
• Beta (4 Parameter) 
• Box-Cox** 
• Burr** 
• Cauchy 
• Chi-Squared** 
• Chi-Squared with Scale  

(3 Parameter)** 
• Error Function (ERF) 
• F** 
• F with Scale (4 Parameter)** 
• Fatigue Life** 
• Fisk** 
• Folded Normal 
• Frechet** 

• Bernoulli 
(Yes/No) 

• Binomial 
• Geometric 
• Hypergeometric 
• Logarithmic 
• Negative 

Binomial 
• Poisson 
• Step 
• Uniform 

(Discrete) 
• Custom Discrete 
• SIP (Stochastic 

Information 
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Common Continuous Advanced Continuous Discrete 
• Gamma** 
• Generalized Error 
• Generalized Gamma** 
• Generalized Logistic 
• Generalized Pareto 
• Half Normal** 
• Inverse Gamma** 
• Inverse Gaussian 
• Johnson SB 
• Johnson SL 
• Johnson SU 
• Laplace 
• Largest Extreme Value 
• Levy 
• Logistic 
• Log Gamma** 
• Log Logistic** 
• Maxwell 
• Non-Central Chi-Squared** 
• Non-Central F** 
• Non-Central T 
• Pareto 
• Power 
• Rayleigh 
• Reciprocal 
• Skew Normal 
• Smallest Extreme Value 
• Student’s T 
• Student’s T with Location and Scale 

(3 Parameter) 
• Von Mises 

 

Packet – 
Unweighted 
Sequential 
Custom Discrete) 
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Specifying Truncation Values 
 
DiscoverSim allows you to specify truncation values for any input distribution.  For example, a 
truncated normal distribution would be appropriate if you have a component supplier that starts 
with a normal distribution, then rejects the parts that fail the lower and upper specification, and 
ships you the good parts. 
The following histogram illustrates a truncated normal distribution (Mean = 0, StdDev = 1) with 
Minimum = -2 and Maximum = 2. 
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Specifying Correlations 
 
DiscoverSim allows you to specify correlations between any inputs. DiscoverSim utilizes correlation 
copulas to achieve the desired Spearman Rank correlation values.  
 
The following surface plots illustrate how a correlation copula results in a change in the shape of a 
bivariate (2 input) distribution: 
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Optimization: Stochastic Versus Deterministic 
 
Monte-Carlo simulation enables you to quantify risk, whereas stochastic optimization enables you 
to minimize risk.  
 
Deterministic optimization is a commonly used tool (e.g. with Excel Solver) but has the drawback 
that it does not take uncertainty of the inputs into account. Stochastic optimization will not only 
find the optimum X settings that result in the best mean Y response value, it will also look for a 
solution that will reduce the standard deviation of Y. 
 
Deterministic optimization will look for a minimum or maximum, whereas stochastic optimization 
looks for a minimum or maximum that is robust to variation in X, thus reducing the transmitted 
variation in Y. This is referred to as “Robust Parameter Design” in Design For Six Sigma (DFSS).  In 
Case Study 4, Catapult Variation Reduction, the transmitted variation of Catapult distance is 
significantly reduced by shifting the launch angle mean from 30 degrees to 45 degrees, as 
illustrated in the diagram below: 
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Optimization: Local Versus Global 
 
Local optimization methods are good at finding local minima and have fast convergence.  
DiscoverSim uses Sequential Quadratic Programming (SQP) which takes derivatives of the objective 
function to find the path of greatest improvement for fast optimization. However, it requires a 
smooth response so will not work with discontinuous functions. Nelder-Mead simplex optimization 
is used for local non-smooth problems. 
 
Global optimization finds the global minimum, and is derivative free, so will work with 
discontinuous functions.  However, because of the larger design space, convergence is much slower 
than that of local optimization. DiscoverSim uses Mixed Integer Distributed Ant Colony 
Optimization (MIDACO) and Genetic Algorithm (GA) for global optimization. 
 
A hybrid of the above methodologies is also available in DiscoverSim, and in the case of all 
continuous input variables, starts with MIDACO to do a thorough initial search, followed by GA, and 
then fine tuning with SQP or Nelder-Mead (if SQP fails). 
 
The following surface plot illustrates a function with local minima and a global minimum. 
 

 
 
Note: The Schwefel function is a standard n dimensional global optimization benchmark problem. 
Function details are widely available. The plot was created using Excel’s 3D Surface Plot.  
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Components of Optimization 
 
Output: The output will be a function of the model equation, intermediate cell calculations, as well 
as input distributions and input controls. 
 
Input Control: The permissible range for the control is specified and, unlike an input distribution, 
has no statistical variation. Think of this as the temperature control knob of a thermostat. This is 
also known as a “Decision Variable.”  An input control can be referenced by an input distribution 
parameter, constraint and/or an output function. It is possible to have a model that consists solely 
of controls with no input distributions. (In this case, the optimization is deterministic, so the 
number of replications, n, should be set to the minimum of 3 to save computation time.) An input 
control can be continuous or discrete. 
 
Constraint: A constraint can be applied to an Input Control or DSIM Function but cannot directly 
reference a stochastic (statistical) Input Distribution or stochastic Output Response. Constraints can 
be simple linear or complex nonlinear. Each constraint will contain a function of Input Controls on 
the Left Hand Side (LHS), and a constant on the Right Hand Side (RHS).  A constraint formula or cell 
reference is specified in the LHS. 
 
Constraints are managed automatically within SQP and Discrete Exhaustive; for MIDACO, GA and 
NM, the Oracle Penalty Function is applied. 
 
DSIM Function: Insert a function such as DSim_Mean, DSim_Pcntle (Percentile) or Dsim_Ppk 
(Capability Metric). The returned function value is a single number computed using all of the 
replications within a simulation run or optimization function evaluation.  These computed values 
can then be referenced in a constraint LHS. 
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Summary of Optimization Features 
 
DiscoverSim optimization features include: 

• Mixed Integer Distributed Ant Colony Global Optimization (MIDACO) 

• Genetic Algorithm (GA) Global Optimization 

• Sequential Quadratic Programming (SQP) for fast local optimization 

• Nelder-Mead (NM) simplex optimization for fast local non-smooth problems 

• Exhaustive Discrete optimization – all combinations for small discrete problems 

• Powerful hybrid of the above methods: 

o All discrete controls: MIDACO or Exhaustive Discrete if applicable 

o All continuous controls: MIDACO, GA, followed by SQP or NM 

o Mixed continuous/discrete controls: MIDACO 1 (Course), MIDACO 2 (Fine), followed 
by SQP or NM 

• Specify linear and nonlinear constraints 

• Stochastic Optimization – minimize dpm or maximize Ppk 

• Insert DSIM functions such as Percentiles or Capability Metrics. These can then be used in 
constraints. 

• Multiple Response Optimization using Desirability, Weighted Sum or Deviation from Target 
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Getting Started Tutorial 
 
1. Open the workbook DMAIC Project Duration.  This is an example model of a Six Sigma project 

with five phases: Define, Measure, Analyze, Improve and Control.  We are interested in 
estimating the total project duration in days. Management requires that the project be 
completed in 120 days.  We will model duration simply as: 
 
Total Duration = Define + Measure + Analyze + Improve + Control 

 

 
 
2. We will model each phase using a Triangular Distribution, which is popular when data or theory 

is not available to estimate or identify the distribution type and parameter values. (Another 
similar distribution that is commonly used for project management is PERT). The Minimum, 
Mode (Most Likely) and Maximum durations were estimated by the Six Sigma project team 
based on their experience. 
 

3. Click on cell C4 to specify the Input Distribution for Define.  Select DiscoverSim > Input 
Distribution:  

 
 

4. Select Triangular Distribution. A brief description of the Triangular Distribution is given in the 
dialog. 
 

5. Click input Name cell reference  and specify cell B4 containing the input name “Define.” After 
specifying a cell reference, the dropdown symbol changes from  to . 
 

6. Click the Minimum parameter cell reference  and specify cell F4 containing the minimum 
parameter value = 5.  
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7. Click the Mode parameter cell reference  and specify cell G4 containing the mode (most 
likely) parameter value = 10.  
 

8. Click the Maximum parameter cell reference  and specify cell H4 containing the maximum 
parameter value = 15. 
 

9. Click Update Chart to view the triangular distribution as shown: 
 

 
 

10.  Click OK. Hover the cursor on cell C4 to view the DiscoverSim graphical comment showing the 
distribution and parameter values: 
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11. Click on cell C4. Click the DiscoverSim Copy Cell menu button  (Do not use Excel’s 
Copy – it will not work!). 
 

12. Select cells C5:C8. Click the DiscoverSim Paste Cell menu button   (Do not use Excel’s 
Paste – it will not work!). 
 

13. Verify that the input comments appear as shown: 
 
Cell C5: 
 

 
 
Cell C6: 
 

 
 
Cell C7: 
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Cell C8: 
 

 
 

14. Click on cell C11. Note that the Excel formula =SUM (C4:C8) has already been entered. Select 
DiscoverSim > Output Response: 
 

 
 

15. Enter the output Name as “Total.” Enter the Upper Specification Limit (USL) as 120 (or specify 
cell reference C13).  Optimization Settings are not used in this example since this is strictly a 
simulation.  
 

 
 
Click OK. 
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16. Hover the cursor on cell C11 to view the DiscoverSim Output information.  
 

 
 

17. Select DiscoverSim > Run Simulation: 
 

 
 

18. Click Report Options/Sensitivity Analysis. Check Sensitivity Charts and Correlation 
Coefficients. Select Seed Value and enter “12” as shown, in order to replicate the simulation 
results given below (note that 64 bit DiscoverSim will show slightly different results). 
 

  
 
Click Run. 
 

19. The DiscoverSim output report shows a histogram, descriptive statistics and process capability 
indices:  
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From the histogram and capability report we see that the Total Project duration should easily 
meet the requirement of 120 days, assuming that our model is valid. The likelihood of failure 
(based on the actual simulation performance) is approximately .01%.  
 
Note: If Seed is set to Clock, there will be slight differences in the reported values with every 
simulation run due to a different starting seed value derived from the system clock. 
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20. A summary of the model input distributions, parameters and output response is also given in 
the simulation report. 
 

 
Tip: Use this summary to keep track of simulation runs with modified parameter values. 
 
If we needed to improve the performance, the sensitivity charts would guide us where to focus 
our efforts. Click on the Sensitivity Correlations sheet: 

 
 
The control phase is the dominant input factor affecting Total Duration, followed by Measure 
and Improve. 

 
Tip: This Sensitivity Chart uses the Spearman Rank Correlation, and the results may be positive 
or negative.  If you wish to view R-Squared percent contribution to variation, rerun the 
simulation with Sensitivity Regression Analysis and Sensitivity Charts, Regression Coefficients 
checked. 
 

The results in this simple example are intuitively obvious from the input values, but keep in mind 
that a real model will likely be considerably more complex with sensitivity analysis results 
identifying important factors that one might not have expected.  
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Overview of DiscoverSim™ Menu and Dialogs 
 
DiscoverSim Menu 
 

 
 
 
 
Recall DiscoverSim Dialog 
 

 
 
 
Recall is used to activate the last data worksheet and recall the last dialog, making it very easy to do 
repetitive analysis. 
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DiscoverSim Options 
 

   
 

1. Default colors for Input Distributions, Input Controls, Output Responses and Constraints can be 
modified by clicking on the Color button. 
 

2. Check Comments to display DiscoverSim comments in Input/Output cells. 
 

3. System timeout (seconds) is the maximum time for a messaging instance (communication 
between Excel and Windows) in optimization. 
 

4. Click Save to save option default changes. 
 

5. To restore the options to the original default values, click Help > Clear Saved Defaults. 
 

  



Introduction to DiscoverSim and Getting Started Tutorial 

38 

Create/Edit Input Distribution 
 

   
1. Input Number is provided for reference purposes only. (To switch to a different input cell, click 

cancel, select the input cell and click Input Distribution.) 
 

2. Input Name is the cell address by default.  Enter a name to describe the input or click the cell 
reference  and specify the cell containing the input name. After specifying a cell reference, 
the dropdown symbol changes from  to  . 
 

3. Input cell color can be modified by clicking on Cell Address (default colors can be changed in 
Help > DiscoverSim Options). 
 

4. Select from Common Continuous, Advanced Continuous, Discrete or SIP Distributions. A brief 
description of the selected distribution is given in the dialog. Click View Distribution Formulas 
for distribution formula details: Probability Density Function (PDF) and Cumulative Distribution 
Function (CDF). These distribution formulas are also given in the Appendix. 
 

5. If distribution fitting has been performed, the Select Stored Distribution Fit option will become 
available for selection of variable name(s) and stored distribution(s). The parameter values will 
automatically be populated. 
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6. Parameter values can be manually entered or click the cell reference  and specify the cell 
containing the parameter value.  
 

7. Click Update Chart after changing parameter values to view distribution. 
 

8. Check Truncate and enter truncation minimum and/or maximum values to produce a truncated 
distribution.  Blank entries will be treated as negative infinity for minimum and positive infinity 
for maximum. 
 

9. Check Include in Specified Input Correlations (checked by default) to allow correlations to be 
specified for this input. 
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Create/Edit Output Response 

   
 

1. Output Number is provided for reference purposes. (To switch to a different output cell, click 
cancel, select the output cell and click Output Response.) 
 

2. Output Name is the cell address by default.  Enter a name to describe the output or click the 
cell reference  and specify the cell containing the output name. After specifying a cell 
reference, the dropdown symbol changes from  to  . 
 

3. Output cell color can be modified by clicking on Cell Address. (Default colors can be changed in 
Help > DiscoverSim Options). 
 

4. Function displays the output cell equation. The equation can also be changed in this field. 
 

5. LSL is the Lower Specification Limit; USL is the Upper Specification Limit for the output. Entry is 
optional for simulation but required to produce Process Capability Indices. LSL and USL are also 
used as the lower and upper bounds for the desirability function in multiple response 
optimization. Specification limits can be manually entered or click the cell reference  and 
specify the cell containing the specification value.  
 

6. Include in Optimization, Weight and Output Goal are not used for simulation - they are 
optional output settings used for multiple response optimization. If Include in Optimization is 
unchecked this output will not be considered for optimization.  Note that the Output Goal 
(Target, Maximize or Minimize) is specific to each output.  For example, if Output 1 is 
production rate, the goal would be set to maximize, whereas Output 2, cost, would have a 
minimize goal. For further details, see Run Optimization. 
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Copy Cell, Paste Cell, Clear Cells 
 
DiscoverSim Copy Cell and Paste Cell are used to quickly create duplicate input distributions, input 
controls, or output responses. Clear Cells deletes the input or output from the DiscoverSim model. 
A cell address reference is relative (A1) by default, but can be changed to absolute ($A$1) by using 
the F4 key. 
 

 
 
Note that Excel’s copy, paste and delete commands cannot be used since DiscoverSim needs to 
update hidden model worksheets for any additions or deletions. 
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Model Summary 
 
Click Model Summary and select a summary of Input Distributions, Input Controls, Constraints, 
Output Responses, or Correlation Matrix. 

   
The Input Distributions summary table displays all of the Input Distributions with the selected 
distributions, parameter values and settings. The Input Controls summary table displays all of the 
Input Controls, type, and optimization boundaries. The Constraints summary table displays all of 
the constraints. The Output Responses summary table displays all of the Output Responses, 
specification limits and optimization options. The Correlation Matrix summary table displays the 
entire specified Correlation Matrix. 
 
Clicking a button scrolls the selected summary table to the top and is useful to view a summary for 
a large model. Click Exit to remove the Model Summary dialog. 
 

  

Tip: Summaries of the Input 
Distributions, Input Controls and 
Output Responses are also included 
in the Simulation Report. 
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Run Simulation 
 

  
1. Replications value sets the number of simulation replications. 

 
2. Seed is set to Clock by default so that the starting seed of random number generation will be 

different with each run.  If you want the simulation results to match every time (for example in 
a classroom setting where you want all students to obtain the same results), select Value and 
enter an integer number.  Note that the results of a fixed seed for 32-bit Excel will be slightly 
different for 64-bit Excel. 
 

3. Select Monte Carlo (Random) for full randomization. Latin Hypercube Sampling is less random 
than Monte Carlo but enables more accurate simulations with fewer replications. For further 
details see Appendix: Input Distribution Sampling. 
 

4. For details on Random Number Generation (RNG) in DiscoverSim, see Appendix: Input 
Distribution Random Number Generation. 
 

5. Accelerated Mode uses DiscoverSim’s Excel Formula Interpreter to dramatically increase the 
speed of calculations for rapid simulation. If unchecked, the calculations are performed using 
native Excel. The interpreter supports the majority of all Excel numeric functions (for more 
details see Appendix: DiscoverSim Engine and Excel Formula Interpreter).  If the DiscoverSim 
interpreter sees a function that it does not support, you will be prompted to use Excel’s Native 
mode.  
 

6. Run Validation using Native Excel runs a validation test to compare Accelerated Mode versus 
Native Excel. Each output is assessed by comparing the simulation means. If the worst case 
relative difference is less than or equal to 1e-10%, the test passes and the status is “Success.” If 
the relative difference is between 1e-10% to 1e-4%, the status is “Good,” and if greater than or 
equal to 1e-4%, the test status is “Poor.” 
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7. Check Independence (Ignore Correlations) to run the simulation with all inputs independent of 
each other (zero correlation). This is recommended if you are running a Sensitivity Regression 
Analysis. 
 

8. Check Store Simulation Data in Worksheet to store simulation input and output data in a 
worksheet.  The number of simulation replicates or runs must not exceed the maximum 
number of rows permitted in the version of Excel that you are using and the total number of 
inputs and outputs cannot exceed the maximum number of columns permitted by Excel. 

 
9. Click Report Options/Sensitivity Analysis to display all report options. 
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10. Histograms, Probability Plots, and Process Capability Report are checked by default for display 
in the simulation report.  These graphs and tables apply only to the output response data.   A 
report will be produced for each output.  

 
• Descriptive Statistics are always reported. They include confidence intervals for 

Mean, StdDev, and Median with a default 95% level. The Confidence Level can be 
modified. Descriptive statistics also include the normality tests: Anderson-Darling, 
Skewness and Kurtosis. 

• Histograms will display a normal curve and specification limits (if applicable). 
• Probability Plots are normal probability plots, but only display a small sample (500) 

of the data to speed up the report display. 
• Process Capability Report indices require at least one specification limit. 

 

11. Check Percentile Report to view a table with the following percentiles: 
0.135, 1, 5, 10, 15, 20, 25, 30, 35, 40, 45, 50, 55, 60, 65, 70, 75, 80, 85, 90, 95, 99, 99.865. 
Additional Percentiles can be added to the report by entering the desired values, separated by 
a space.  

A Percentile Process Capability report is also produced. These indices should be used if the 
output response is not normally distributed: 
 
Percentile Pp = (USL – LSL)/( 99.865 percentile – 0.135 percentile) 
Percentile Ppu = (USL – 50th percentile)/(99.865 percentile – 50th percentile) 
Percentile Ppl = (50th percentile – LSL)/(50th percentile – 0.135 percentile) 
Percentile Ppk = min(Ppu, Ppl) 
 
Tip: Percentile Process Capability indices require a minimum of 10,000 replications in order 
to be reliable. 
 

12. Check Scatter Plot/Correlation Matrix to view a Scatter Plot of outputs versus outputs, outputs 
versus inputs, and inputs versus inputs.  The correlation matrix includes both Pearson and 
Spearman Rank correlation coefficients.  Spearman Rank is recommended for non-normal data. 
 

13. Check Sensitivity/Regression Analysis to perform a backwards stepwise regression analysis. 
This will automatically be run on all outputs.  

Hierarchy options are:  
 

• Linear (Main Effects) 
• Linear & Quad (Main Effects and Quadratic Terms) 
• Linear & Cross (Main Effects and Cross-Product 2-Way Interactions) 
• Linear, Cross & Quad (Main Effects, Cross-Product 2-Way Interactions and Quadratic 

Terms) 
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If selected, Cross-Product and Quadratic terms are calculated and included in the initial 
stepwise regression model along with the Main Effects. Following Hierarchy means that the 
second order terms are removed from the model before the first order terms.  If a Cross-
Product or Quadratic term remains in the model, the associated Main Effects will also 
remain in the model, even if the Main Effect term is not significant. 
Standardize options are: 
 

• None 
• Std: Mean=0, StdDev=1 ((Xi – Mean)/StdDev) 
• Range -1 to +1 (Coded Xmin = -1; Xmax = +1) 

Use one of the standardize options if you have a second order model and wish to avoid 
additional collinearity that is introduced due to the multiplication of different units.  The 
disadvantage of this is that the model coefficients are then standardized or coded so will 
not be as easy to interpret. 
F to Enter allows you to set the value of F to enter a new variable in the model (default is 4). 
F to Remove allows you to set the value of F to remove a variable from the model (default is 
4). 
Note: As mentioned above, it is highly recommended that you check Independence (Ignore 
Correlations) when performing a Sensitivity/Regression Analysis to avoid problems with 
multi-collinearity. 
 

14. Check Sensitivity Charts to view vertical bar chart(s) of: 
 

• Correlation Coefficients – Sorted Spearman Rank correlation for output versus each 
input. The sort is by magnitude, with the chart x-axis range being -1 to +1. 

• Regression Coefficients – Sorted R-Square values for output versus each input, 
Cross-Product and Quadratic terms that remain in the Stepwise Regression model. 
R-Square for each final model term is obtained by sequentially removing and 
replacing each term from the model, with the decrease in model R-Square used as 
the term value. 
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Distribution Fitting: Batch Distribution Fit 
 

     
 

 
 

1. Select Continuous or Discrete.  Continuous distributions will be sorted in ascending order using 
the Anderson Darling goodness of fit statistic. Discrete distributions will be sorted with the Chi-
Square goodness of fit statistic.  P-Values and distribution parameter values are also reported 
for each distribution. 
 
• See Appendix: Distribution Fitting - Maximum Likelihood Estimation of Parameters for 

further details on parameter estimation. 
• See Appendix: Distribution Fitting – Goodness of Fit for further details on goodness of fit 

estimation.    
 

2. Check Exclude Threshold Distributions to run the batch distribution fit without estimation of 
distributions that have a Threshold parameter.  The default is checked because it is much 
faster.  Note, however, that if the data contains negative values then Threshold distributions 
will be included in the batch fit. 
 

Tip: If Threshold distributions are included, and two candidate distributions with similar 
Anderson Darling statistic values are being considered, one with a Threshold and one 
without, choose the simpler model without the Threshold.  For further details on Threshold 
distributions and estimation, see Appendix: Distribution Fitting – Threshold Distributions. 
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3. Select All Distributions or Automatic Best Fit. Automatic Best Fit will return the distribution 
with the lowest Anderson-Darling or Chi-Square statistic. 
 

4. If distribution fitting has been performed, the Select Stored Distribution Fit option will become 
available in the Input Distribution dialog for selection of variable name(s) and stored 
distribution(s). The input distribution parameter values will automatically be populated. 
 

5. See Case Study 1 – Basic Profit Simulation for examples of Batch Distribution Fit. 
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Distribution Fitting: Specified Distribution Fit 
 

   
 

  
 

1. Specified Distribution Fit provides a more detailed distribution fit report for a selected variable 
and specified distribution.  Select Distribution Fit Variable and Select Distribution provide a 
drop down list with available variable/distribution options from the Batch Distribution Fit 
(similar to Select Stored Distribution Fit in the Create/Edit Input Distribution dialog). 
 

2. The Specified Distribution Fit report includes: 
• Histogram and Probability Plot (optional with check box). 
• Parameter estimates, standard errors (SE Estimate) and confidence intervals for parameter 

estimates.  
o The Confidence Level can be set in the dialog above with default value = 95%. 
o In some cases standard errors and confidence intervals may not be available. 

• Percentile Report with the following percentiles: 0.135, 1, 5, 10, 15, 20, 25, 30, 35, 40, 45, 
50, 55, 60, 65, 70, 75, 80, 85, 90, 95, 99, 99.865.   

o Other values can be added by entering in the Estimate Percentiles box.   
o Note that the percentiles are computed using the distribution and estimated 

parameters, not the empirical data as is the case with the percentiles in the 
simulation report. 
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• Standard errors and confidence intervals for the percentile values, at the Confidence Level 
specified above (95% default). 

o In some cases standard errors and confidence intervals may not be available. 
• Model Summary and Goodness-of-Fit statistics. 

 
3. See Case Study 1 – Basic Profit Simulation for examples of Specified Distribution Fit. 
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Distribution Fitting: Nonnormal Process Capability 
 

    
 

 
 

1. Nonnormal Process Capability provides a nonnormal process capability report with capability 
indices computed from the specified distribution with estimated parameters.   
• Empirical Performance is also reported for comparison.  
• Capability indices are for individual observations (subgrouping is not available). 

   
2. Select Distribution Fit Variable and Select Distribution provide a drop down list with available 

variable/distribution options from the Batch Distribution Fit (similar to Select Stored 
Distribution Fit in the Create/Edit Input Distribution dialog). 
 

3. Enter Upper Specification Limit (USL) and/or Lower Specification Limit (LSL).  Target is optional 
(used in the Cpm calculation). 
 

4. For details on Z-Score versus ISO methods and Control Charts see Appendix: Distribution Fitting 
– Nonnormal Process Capability Indices and Distribution Fitting – Nonnormal Control Charts. 
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5. Standard formulas for Process Capability Indices are given in the Appendix: Formulas for Quality 
and Process Capability Indices, but note that indices here use the specified distribution, not the 
normal distribution. 
 

6. See Case Study 1 – Basic Profit Simulation for an example of Nonnormal Process Capability. 
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Distribution Fitting: Percentiles to Parameters Calculator 
 

    
 

 
 

1. If one does not have sufficient data to do distribution fitting but does know some percentile 
values of a specified distribution, these can be converted to parameter values for use in 
simulation. 

2. Select Distribution using drop down.  Select Percentage values using drop down.  Enter 
Percentile X Values. 

3. Percentiles not used by a distribution are blacked out. 
4. Click Calculate Parameters. Parameter Name and Values are shown in cells C12 to D15.  If the 

Parameter Value cells are blank, please ensure that the Percentile X Values are viable for the 
chosen distribution.   

5. Due to the complexity of calculations, this template uses VBA macros rather than Excel 
formulas.  DiscoverSim must be initialized and appear on the menu in order for this template to 
function. 

6. For further details on calculation methods, see Appendix: Distribution Fitting – Percentiles to 
Parameters Calculator. 
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Correlations 
 

  
 

1. Specify Correlations for Input Distributions. Enter the desired Spearman Rank Correlation  
(-1 to 1) value in the lower triangle matrix.   
• Ensure that you press enter after entering a correlation value in a cell, otherwise the 

correlation will remain unchanged. 
• It is not necessary to enter a correlation value in the upper triangle.   
• The lower triangle specifies the correlations so any value entered in the upper will be 

ignored.  
• The diagonal of 1’s should not be altered. 

 
2. Only those input distributions with “Include in Correlations” checked will be displayed here.  

Input Controls are not included in the correlation matrix. 
 

3. Reset with Zeros clears any specified correlations in the lower triangle and replaces them with 
zeros. 
 

4. Reset with Blanks clears any correlations in the lower triangle and replaces them with blanks.   
This is useful if you wish to then specify correlations between inputs without the constraint of 
requiring independence on the other inputs. 
 

5. Click OK to close the Correlation dialog and revert back to the model sheet. 
 

6. See Case Study 1 – Basic Profit Simulation for an example of specifying Correlations. 
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Optimization: Control 
 

  
 

1. The Input Control, unlike an input distribution, has no statistical variation. Think of this as the 
temperature control knob of a thermostat. This is also known as a “Decision Variable.” 
 

2. An Input Control can be referenced by an input distribution parameter, constraint and/or an 
output function. 
 

3. It is possible to have a model that consists solely of controls with no input distributions. (In this 
case, the optimization is deterministic, so the number of optimization replications should be set 
to the minimum of 3 to save computation time.) 
 

4. Input Control Number is provided for reference purposes only.  
 

5. Input Control Name is the cell address by default.  Enter a name to describe the input control or 
click the cell reference  and specify the cell containing the input control name. Note that 
DiscoverSim copy/paste uses relative addressing (see Copy Cell, Paste Cell, Clear Cells). 
 

6. Input Control cell color can be modified by clicking on Cell Address (default colors can be 
changed in Help > DiscoverSim Options). 
 

7. Specify the Start Value, Minimum (Min) and Maximum (Max) boundaries for the Input Control. 
You can also click the cell reference  and specify a cell containing the min or max value.  After 
specifying a cell reference, the dropdown symbol changes from  to  . 
 

8. An input control can be Continuous or Discrete with Step (default = 1, i.e. integer increment). 
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Optimization: Constraint 
 

   
1. A constraint can be applied to an Input Control or DSIM Function but cannot directly reference 

a stochastic (statistical) Input Distribution or stochastic Output Response.  
 

2. Each constraint will contain a function of Input Controls on the Left Hand Side (LHS), and a 
constant on the Right Hand Side (RHS).  The LHS can be simple linear or complex nonlinear. 
 

3. A constraint formula or cell reference is specified in the LHS. You can manually enter a simple 
formula in the LHS box, or click the cell reference  and specify a cell containing the constraint 
formula.  After specifying a cell reference, the dropdown symbol changes from  to  
 

4. You can manually enter a constant in the RHS box, or click the cell reference  and specify a 
cell containing the constant.  Note that the RHS value must be a fixed constant. After specifying 
a cell reference, the dropdown symbol changes from  to  
 

5. Select the comparison operator: <, <=, =, >=, >.  
• Note that optimization is much harder with equality constraints than with inequality 

constraints.   
• The equality tolerance can be set in Optimization > Advanced Options (default = 0.001, i.e. 

the equality constraint is satisfied if LHS is within +/- 0.001 of RHS). 
 

6. Constraint Number is provided for reference purposes only.  
 

7. Constraint Name is the cell address by default.  Enter a name to describe the constraint. 
 

8. Constraint cell color can be modified by clicking on Cell Address (default colors can be changed 
in Help > DiscoverSim Options). 
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Optimization: DSIM Function 
 

 
 

  
 

 
 

1. Insert a function in a cell such as DSim_Mean, DSim_Pcntle (Percentile) or Dsim_Ppk 
(Capability Metric). The returned function value is a single number computed using all of the 
replications within a simulation run or optimization function evaluation.  These computed 
values can then be referenced in a constraint LHS. 

 
2. See Appendix: Table of DSIM Functions for all DSIM Function descriptions and formulas. 

 

3. See Case Study 3 – Six Sigma DMAIC Project Portfolio Selection for an example of DSIM 
Function used in optimization. 
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Run Optimization 
 

  
 

1. Optimization Goal/Multiple Output Metric: Minimize or Maximize Weighted Sum: minimize 
or maximize the weighted sum of statistic. Weights are specified for each output in the Output 
Response dialog. For example, if the selected statistic was the Mean, and there were two 
outputs, the objective function would be: 
 

Weight1Mean1 + Weight2Mean2 

 
Note, if there is a single output in the model, this simplifies to minimize or maximize the 
statistic value. 
 
Note that the Output Goal specified in the Output Response dialog is not used here.  It is 
only used in Maximize Desirability. 
 

2. Optimization Goal/Multiple Output Metric: Minimize Deviation from Target: minimize the 
square root of weighted sum of deviations squared. A target must be specified for each output 
in the Output Response dialog. The only statistic available for this option is the mean.  This is 
also known as the Taguchi or Quadratic Loss Function. If there were two outputs, the objective 
function would be: 
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SQRT( Weight1(Mean1 – Target1)2 + Weight2(Mean2 – Target2)2) 
 

3. Optimization Goal/Multiple Output Metric: Maximize the weighted linear sum of the 
Desirability Function (Derringer and Suich, 1980). Each output must specify: 
 

• Weight (default = 1). This is also referred to as “Importance”.  (Note, another factor, 
the desirability shape is sometimes called “weight.” In DiscoverSim, the desirability 
shape factor is fixed at 1.) 

• Output Goal (Target, Maximize or Minimize) – this is specific to an output. For 
example, if Output 1 is production rate, the goal would be set to maximize, and 
Output 2, cost, would have a minimize goal.  However, the specified overall 
objective function goal is to maximize desirability. 

o If the output goal is Target, then LSL, Target, and USL are required. LSL and 
USL are the lower and upper specification limits used for process capability 
and dpm calculations, but are also used as the lower and upper bounds for 
desirability. 

o If the output goal is Minimize, then Target and USL are required. 
o If the output goal is Maximize, then LSL and Target are required. 

 
The only statistic available for Desirability is the mean. 
 

4. For further details on Multiple Output Metrics see Appendix: Formulas for Multiple Output 
Metrics. 
 

5. Statistic: The following tables give the Statistic options available depending on the selected 
Optimization Goal and Multiple Output Metric: 
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Optimization 
Goal: 

Minimize 

Multiple 
Output 
Metric: 

Weighted Sum Deviation from Target 

Statistic: Mean 
Median 

1st quartile 
3rd quartile 

Percentile (%) 
Minimum 
Maximum 

Standard Deviation 
Variance 

Mean Squared Error (requires Target) 
Skewness 
Kurtosis 
Range 

IQR (75-25) 
Span (95-5) 

Actual DPM (defects per million – requires LSL/USL) 
Actual DPMU (Upper – requires USL) 
Actual DPML (Lower – requires LSL) 

Calculated DPM (defects per million assuming normal 
distribution – requires LSL/USL) 

Calculated DPMU (Upper – requires USL) 
Calculated DPML (Lower – requires LSL) 

 

Mean (requires Target) 
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Optimization 
Goal: 

Maximize 

Multiple 
Output 
Metric: 

Weighted Sum Desirability 

Statistic: Mean 
Median 

1st quartile 
3rd quartile 

Percentile (%) 
Minimum 
Maximum 

Standard Deviation 
Variance 

Mean Squared Error (requires Target) 
Skewness 
Kurtosis 
Range 

IQR (75-25) 
Span (95-5) 

Pp (requires LSL/USL) 
PpU (Upper – requires USL) 
PpL (Lower – requires LSL) 

Ppk (requires LSL/USL) 
Cpm (requires Target/LSL/USL) 

%Pp (Percentile Pp – requires LSL/USL) 
%PpU (Percentile PpU – requires USL) 
%PpL (Percentile PpL – requires LSL) 

%Ppk (Percentile Ppk – requires LSL/USL) 

Mean (requires Target 
and LSL, USL or 

LSL/USL) 
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6. Formulas for general statistical measures are given in Appendix: Formulas for Statistical 
Measures. 
 

7. Formulas for Quality and Process Capability Indices are given in Appendix: Formulas for Quality 
and Process Capability Indices. 
 

8. DiscoverSim includes the following Global and Local optimization methods: 
 

• Mixed Integer Distributed Ant Colony Global Optimization (MIDACO) 
o See Appendix: MIDACO Mixed Integer Distributed Ant Colony Global 

Optimization for more details, including Advanced Settings for MIDACO. 
 

• Genetic Algorithm (GA) Global Optimization 
o See Appendix: Genetic Algorithm (GA) Global Optimization for more details, 

including Advanced Settings for GA. 
 

• Discrete Exhaustive optimization – all combinations for small discrete problems 
o See Appendix: Discrete Exhaustive Global Optimization for more details, 

including Advanced Settings for Discrete Exhaustive. 
 

• Sequential Quadratic Programming (SQP) for fast local smooth optimization 
o See Appendix: Sequential Quadratic Programming (SQP) Local Optimization 

for more details, including Advanced Settings for SQP. 
 

• Nelder-Mead (NM) simplex optimization for fast local non-smooth problems 
o See Appendix: Nelder-Mead (NM) Local Optimization for more details, 

including Advanced Settings for NM. 
 

• Powerful Hybrid of the above methods: 
o All discrete controls: MIDACO or Exhaustive Discrete if applicable 
o All continuous controls: MIDACO, GA, followed by SQP or NM 
o Mixed continuous/discrete controls: MIDACO 1 (Course), MIDACO 2 (Fine), 

followed by SQP or NM 
o See Appendix: HYBRID Optimization for more details, including Advanced 

Settings for Hybrid. 
 

• Note that the Advanced Settings button will open a dialog with settings specific to 
the selected method. 

9. Replications value sets the number of replications used in optimization to obtain the Statistic.  
The default value is 1000. 
 

10. Seed is set to Clock by default so that the starting seed of random number generation will be 
different with each run.  If you want the optimization results to match every time (for example 
in a classroom setting where you want all students to obtain the same results), select Value and 
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enter an integer number. Stochastic optimization requires a fixed seed in order to avoid 
“chatter” that would result in inconsistent comparisons.  If the Seed is set to Clock, the initial 
seed value will be obtained from the system clock and then kept fixed throughout the 
optimization. Note that the results of a fixed seed for 32-bit Excel will be slightly different for 
64-bit Excel. 
 

11. Select Monte Carlo (Random) for full randomization. Latin Hypercube Sampling is less random 
than Monte Carlo but enables more accurate simulations with fewer replications. 
 

12. Accelerated Mode uses DiscoverSim’s Excel Formula Interpreter to dramatically increase the 
speed of calculations for rapid optimization. If unchecked, the calculations are performed using 
native Excel. The interpreter supports the majority of all Excel numeric functions (for more 
details see Appendix: DiscoverSim Engine and Excel Formula Interpreter).  If the DiscoverSim 
interpreter sees a function that it does not support, you will be prompted to use the Excel 
Native mode.  
 

13. Check Independence (Ignore Correlations) to run the optimization with all inputs independent 
of each other (zero correlation). 
 

14. Optimization in process may be interrupted/paused or stopped. Upon completion, the user can 
paste the optimum input control values in order to perform further simulation studies. 
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DiscoverSim™: Case Studies  

  



DiscoverSim Case Studies 

66 

Case Study 1 – Basic Profit Simulation 
 
Introduction: Profit Simulation 
 
This is an example of how DiscoverSim Monte Carlo simulation can be used to determine 
probability of daily profit using a basic profit model for a small retail business.  We will apply 
distribution fitting to historical data and specify input correlations to define the model in a way that 
closely matches our real world business. 
 
The profit (Pr) requirement is Pr > 0 dollars (i.e., the lower specification limit LSL = 0) 
 
The profit equation, or “Y = f(X) transfer function,” is calculated as follows: 
 
Total Revenue, TR = Quantity Sold * Price 
 
Total Cost, TC = Quantity Sold * Variable Cost + Fixed Cost 
 
Profit, Pr = TR – TC 
 

 
 
In this study we will use DiscoverSim to help us answer the following questions: 
 

1. What is the predicted probability of daily profit? 
 

2. What are the key X variables that influence profit Y?  Can we reduce the variation in profit by 
reducing the variation of the important input variables? 
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Summary of DiscoverSim Features Demonstrated in Case Study 1: 

• Distribution Fitting – Discrete Batch Fit 
• Distribution Fitting – Continuous Batch Fit 
• Distribution Fitting – Specified Distribution Fit 
• Create Input Distributions with Stored Distribution Fit 
• Specify Input Correlations 
• Run Simulation and display 

o Histograms, Descriptive Statistics, Process Capability Report 
o Percentile Report 
o Scatter Plot/Correlation Matrix 
o Sensitivity Chart of Correlation Coefficients 
o Sensitivity Chart of Regression Coefficients 

• Distribution Fitting – Nonnormal Process Capability 
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Profit Simulation with DiscoverSim 
 

1. Open the workbook Profit Simulation. DiscoverSim Input Distributions will simulate the 
variability in Quantity Sold, Price and Variable Cost. We will use distribution fitting with 
historical data to determine which distributions to use and what parameter values to enter.  
Input Distributions will then be specified in cells C11, C12 and C13.  The output, Profit, will be 
specified at cell C21 using the formula given above. 
 

 
2. Select the Historical_Data sheet.  This gives historical data for Quantity Sold, Price and Variable 

Cost. 

 
 
Tip: At this point use the SigmaXL tool (bundled with DiscoverSim) to obtain descriptive 
statistics to test for normality (SigmaXL > Statistical Tools > Descriptive Statistics). Quantity 
Sold has an Anderson Darling Normality test p-value =  0.83, so may be considered a Normal 
Distribution, but since it is a count we will apply DiscoverSim’s distribution fitting using 
discrete distributions. Price and Variable Cost are non-normal with AD p-values less than 
.05, so we will use DiscoverSim’s distribution fitting for continuous data. SigmaXL’s 
correlation matrix should also be used to evaluate correlations (SigmaXL > Statistical Tools 
> Correlation Matrix). The Spearman Rank correlation for Quantity Sold versus Price is -0.8 
(Note: DiscoverSim uses the more robust Spearman Rank correlation rather than Pearson’s 
correlation). SigmaXL’s graphical tools such as Histograms and Scatterplots should also be 
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used to view the historical data. 
 

3. Select DiscoverSim > Distribution Fitting > Batch Distribution Fit:  
 

 
4. The data range has been preselected and appears in the dialog. Note: if a different range is 

required, click on  to change it or select Use Entire Data Table to automatically select the 
data. 

 
5. Click Next. Since Quantity Sold is count data, i.e. a discrete variable, select Discrete. Select 

Quantity Sold as the Numeric Data Variable (Y). For Distribution Options use the default All 
Discrete Distributions as shown: 

 
6. Click OK. The resulting discrete distribution report is shown below: 
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Since these are discrete distributions, Chi-Square is the statistic used to determine 
goodness-of-fit. The distributions are sorted by Chi-Square in ascending order. The best fit 
distribution is Negative Binomial with Chi-Square = 35.4 and p-value = 0.99. The parameters 
are Number of Required Events = 33 and Event Probability = 0.2534.  (See Appendix for 
further details on distributions and distribution fitting). 
 
Tip: If the best fit discrete distribution has a p-value less than .05, indicating a poor 
goodness-of-fit, none of the discrete distributions are adequate for use in Monte-Carlo 
simulation. In this case you should redo the distribution fit using the Continuous option 
(Note that you can use the continuous option for discrete data, but you cannot use discrete 
distributions for continuous data). After creating a DiscoverSim input distribution with the 
best fit (or normal if applicable), use Excel’s ROUND(number, 0) function to obtain integer 
values from the continuous distribution.   
 

7. Now we will apply distribution fitting to Price and Variable Cost. Select the Historical_Data 
sheet and repeat the above steps.  Both variables are continuous so use the default Select 
Distribution Type Continuous.  The resulting distribution reports are shown below. 

 

 
 

 
 

8. DiscoverSim uses the Anderson Darling statistic to determine goodness-of-fit for continuous 
distributions. The distributions are sorted by the AD statistic in ascending order. The best fit 
distribution for Price is Beta (4 Parameters) with AD Stat = .34 and AD p-value = 0.47. The best 
fit distribution for Variable Cost (%) is Johnson SB with AD Stat = .31 and AD p-value = 0.41. 
(See Appendix for further details on distributions and distribution fitting). 
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9. Optional Specified Distribution Fit analysis: This is a detailed view of the distribution fit for a 
specified distribution with: 
• Histogram and Probability Plot. 
• Parameter estimates, standard errors (SE Estimate) and confidence intervals for parameter 

estimates.  
• Percentile Report with the following percentiles: 0.135, 1, 5, 10, 15, 20, 25, 30, 35, 40, 45, 

50, 55, 60, 65, 70, 75, 80, 85, 90, 95, 99, 99.865.   
o Note that the percentiles are computed using the distribution and estimated 

parameters, not the empirical data. 
• Standard errors and confidence intervals for the percentile values 
• Model Summary and Goodness-of-Fit statistics. 

 
Select DiscoverSim > Distribution Fitting > Specified Distribution Fit:  

 

 
 

 
 
Using the default settings as shown, click OK.  This produces a detailed distribution fit report 
for Quantity Sold using the Negative Binomial distribution: 
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10. Now we will apply specified distribution fitting to Price and Variable Cost. Repeat the above 
steps using the default best fit distributions to produce a detailed distribution fit report: 
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11. The detailed distribution analysis clearly shows that we have a good fit for all 3 variables.  Now 
we will use the stored distribution fits to create a DiscoverSim model. 
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12. Select Profit_Model sheet.  Click on cell C11 to specify the Input Distribution for Quantity Sold.  
Select DiscoverSim > Input Distribution: 

 

 
 

13. Click Select Stored Distribution Fit.  We will use the default variable Quantity Sold for Select 
Distribution Fit Variable and Negative Binomial for Select Distribution. The parameter values 
for Number of Required Events and Event Probability are automatically populated from the 
distribution fit results for Quantity Sold. 
 

14. Enter “Quantity Sold” as the Input Name. 
 

15. Click Update Chart. The completed Create/Edit Input Distribution dialog is shown below: 
 

 
 

16. Click OK.  Hover the cursor on cell C11 in the Profit_Model sheet to view the DiscoverSim 
graphical comment showing the distribution and parameter values: 
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17. Click on cell C12 to specify the Input Distribution for Price.  Select DiscoverSim > Input 
Distribution.  
 

18. Click Select Stored Distribution Fit.  Select the variable Price for Select Distribution Fit Variable 
and the default Beta (4 Parameters) for Select Distribution. The parameter values for this 
distribution are automatically populated from the distribution fit results for Price. 

 
19. Enter “Price” as the Input Name. 

 
20. Click Update Chart. The completed Create/Edit Input Distribution dialog is shown below: 
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21. Click OK.  Hover the cursor on cell C12 in the Profit_Model sheet to view the DiscoverSim 
graphical comment showing the distribution and parameter values: 

 

 
 

22. Click on cell C13 to specify the Input Distribution for Variable Cost.  Select DiscoverSim > Input 
Distribution.  
 

23. Click Select Stored Distribution Fit.  Select Variable Cost for Select Distribution Fit Variable and 
the default Johnson SB for Select Distribution. The parameter values for this distribution are 
automatically populated from the distribution fit results for Variable Cost. 
 

24. Enter “Variable Cost” as the Input Name. 
 

25. Click Update Chart. The completed Create/Edit Input Distribution dialog is shown below: 
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26. Click OK.  Hover the cursor on cell C13 in the Profit_Model sheet to view the DiscoverSim 
graphical comment showing the distribution and parameter values:  

 

 
 

27. Now we will specify the correlation between the inputs Quantity Sold and Price.  Select 
DiscoverSim > Correlations: 

 

 
 

28. As discussed above, the Spearman Rank correlation between Quantity and Price is -.8. This 
negative correlation is expected: as order quantity increases, unit price decreases.  Enter the 
value -.8 in the column Price, row Quantity and press Enter. 

 

 
 
Tips: It is not necessary to enter a correlation value in the upper triangle. The lower triangle 
specifies the correlations so any value entered in the upper will be ignored. The diagonal of 1’s 
should not be altered. Reset with Zeros clears any specified correlations in the lower triangle 
and replaces them with zeros. Reset with Blanks clears any correlations in the lower triangle 
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and replaces them with blanks. This is useful if you wish to then specify correlations between 
inputs without the constraint of requiring independence on the other inputs. 
 
Click OK. 

 

29. Now we will specify the Profit model output. Click on cell C21. Select DiscoverSim > Output 
Response: 
 

 
 

30. Enter the output Name as “Profit”. Enter the Lower Specification Limit (LSL) as 0. The Include in 
Optimization, Weight and Output Goal settings are used only for multiple response 
optimization, so do not need to be modified in this example. 

 

 
 
Click OK. 
 

31. Hover the cursor on cell C21 to view the DiscoverSim Output information.  
 

 
 

32. Select DiscoverSim > Run Simulation:  
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33. Click Report Options/Sensitivity Analysis. Check Percentile Report, Scatter Plot/Correlation 
Matrix, Sensitivity Regression Analysis, Sensitivity Charts - Correlation Coefficients and 
Regression Coefficients. Select Seed Value and enter “12” as shown, in order to replicate the 
simulation results given below (note that 64 bit DiscoverSim will show slightly different results). 

 

 
 
Click Run. 
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34. The DiscoverSim Output Report shows a histogram, normal probability plot, descriptive 
statistics, process capability indices, a percentile report and a percentile process capability 
report:  
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From the histogram and detailed report we see that typically we should expect a positive 
daily profit, but the variation is large. The likelihood of profit loss is approximately 0.20% 
(see Actual Performance (Empirical): %Total (out of spec)). Note that the “expected” loss 
of 1.36% assumes a normal distribution, so that is not applicable here because the output 
distribution is not normal (Anderson-Darling p-value is much less than .05). 
 
Note: If Seed is set to Clock, there will be slight differences in the reported values with 
every simulation run due to a different starting seed value derived from the system clock. 
 
The Percentile Process Capability report computes capability indices for non-normal data as 
follows: 
 
Percentile Pp = (USL – LSL)/( 99.865 percentile – 0.135 percentile) 
 
Percentile Ppu = (USL – 50th percentile)/(99.865 percentile – 50th percentile) 
 
Percentile Ppl = (50th percentile – LSL)/(50th percentile – 0.135 percentile) 
 
Percentile Ppk = min(Ppu, Ppl) 
 
Since we only have a lower specification limit (LSL = 0), Percentile Ppl is calculated as: 
 
Percentile Ppl = (385.03 - 0) / (385.03 - (-5.07)) = 0.99 
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35. Optional Nonnormal Process Capability Analysis: DiscoverSim Version 2.1 now includes 
Nonnormal Process Capability with Distribution Fitting.  To utilize this stand-alone feature for 
the Profit data, perform the following steps: 

• Click Run Simulation, select Store Simulation Data, click Run.  
• Select DSim Data sheet, select Profit column (D1:D10001).  
• Select Distribution Fitting > Batch Distribution Fit, click Next, select Profit, uncheck 

Exclude Threshold Distributions:  

 
 

• Click OK. The batch fit will take approximately 1-2 minutes due to the large dataset 
and inclusion of Threshold distributions. 

• The best fit distribution is Generalized Gamma with Threshold. Unfortunately, it is 
not a good fit to the data with the AD P-Value < .001, but we will proceed for 
demonstration purposes.  Select Distribution Fitting > Nonnormal Process 
Capability.  

• Select Profit.  Enter LSL = 0.  The best fit distribution is selected as Generalized 
Gamma with Threshold. Uncheck Control Chart Options. 

 
 

• Click OK. The Ppk using Generalized Gamma is 0.95 which, even though a poor fit, is 
closer to the above Percentile Ppk value of 0.99 than the normal distribution Ppk of 
.74. 
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36. Click on the Scatter Plot Matrix sheet to view the Input-Output relationships graphically:  
 

 
Here we see the negative correlation that was specified between the inputs “Price” and 
“Quantity Sold,” as well as the strong negative correlation between “Variable Cost” and 
“Profit.” 
 

37. Click on the Correlation Matrix sheet to view the Input-Output correlations numerically: 

 

DiscoverSim uses the robust Spearman 
Rank correlation but the Pearson is also 
reported here for reference purposes.   
 
The correlations highlighted in red are 
statistically significant (p-value < .05). 
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38. In order to increase profit (and reduce the variation), we need to understand what is driving 
profit, i.e., the key “X” factor.  To do this we will look at the sensitivity charts.  Click on the 
Sensitivity Correlations sheet: 

 

 
 

Here we see that “Variable Cost” is the dominant input factor affecting “Profit” with a 
negative correlation (lower variable cost means higher profit).  The next step would then be 
to find ways to minimize the variable cost (and reduce the variation of variable cost).  
“Quantity Sold” is the second important input factor.  It is interesting to note that “Price” is 
the least important factor in this Profit simulation model. 
 

39. To view R-Squared percent contribution to variation, click on the Sensitivity Regression sheet: 

 
Variable Cost contributes to 68% of the variation in Profit (R-Square = 0.68). 
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40. When strong correlations are present in the inputs, Sensitivity Correlation Analysis and 
Sensitivity Regression Analysis may be misleading, so it is recommended that the simulation be 
rerun with Independence (Ignore Correlations) checked to validate the sensitivity results: 

 

 
In this case the input factor prioritization remains the same, but “Price” shows a small 
positive correlation rather than negative. 
 

41. The revised R-Square Percent Contribution report is shown below: 
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Case Study 2 –Magazine Production Optimization 
 
Introduction: Simulation and Optimization to Determine Optimal 
Magazine Production Quantity to Maximize Profit 
 
This is an example of DiscoverSim simulation and optimization to determine optimal magazine 
production quantity to maximize net profit. 
 
Monthly Demand is modeled using a discrete custom distribution. 
 
A DiscoverSim Input Control is used to set the number of magazines produced (in steps of 10,000). 
 
Production and disposal costs are variable costs per unit. (Note: content and fixed printing costs 
are covered by advertising and subscriptions). 
 
Revenue = 
MIN(Monthly_Demand,Monthly_Demand,Magazines_Produced)*Selling_Price_to_Retailers 
 
Total Production Cost = Magazines_Produced*Production_Cost 
 
Total Disposal Cost = IF((Magazines_Produced-Monthly_Demand)>0,Magazines_Produced-
Monthly_Demand,0)*Disposal_Cost 
 
Net Profit = Revenue - (Total_Production_Cost + Total_Disposal_Cost) 
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Summary of DiscoverSim Features Demonstrated in Case Study 2: 

• Create Input Distributions with Custom Discrete 
• Create Discrete Input Controls 
• Run Simulation 
• Run Optimization 
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Optimization of Magazine Production Quantity with DiscoverSim 
 

1. Open the workbook Magazine Production – Optimization. A custom discrete input distribution 
will simulate the variability in monthly demand and is specified in cell C15.  The demand 
quantity data for this custom distribution is given in cells F15: F24 with weights specified in cells 
G15:G24.  The weights are converted to calculated probabilities in cells H15:H24.  A 
DiscoverSim Input Control (Discrete) will be used to specify the magazine production quantity 
(10,000 to 100,000) at cell C17.  The output, Net Profit will be specified at cell C27. 

 

 
 

2. Click on cell C15 to specify the “Monthly Demand” discrete custom input distribution.  Select 
DiscoverSim > Input Distribution: 

 

 
 

3. Select Discrete > Custom Discrete Distribution. 
 

4. Click the input name cell reference  and specify cell B15 containing the input Name “Monthly 
Demand” (Note: spaces are replaced with the underscore “_” character for all input names). 
After specifying a cell reference, the dropdown symbol changes  
from  to  . 
 

5. Click the Data Range cell reference  and specify cells F15:F24 as the data range for the 
custom discrete distribution.  
 

6. Click the checkbox to enable Weight Range followed by the cell reference  and specify cells 
G15:G24 as the weight range for the custom discrete distribution.  These weights are used to 
determine the distribution probabilities as displayed in cells H15:H24. 
 

7. Click Update Chart to view the custom discrete distribution as shown: 
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8. Click OK. Hover the cursor on cell C15 to view the DiscoverSim graphical comment showing the 
distribution and parameter values: 

 

 
 

9. Now we will add the Discrete Input Control (also referred to as a “Decision Variable”). This will 
be used to set the magazine production quantity.  DiscoverSim will use Stochastic Global 
Optimization to determine what quantity will maximize the mean net profit. 
 

10. Click on cell C17. Select Control:  
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11. Click input Name cell reference  and specify cell B17 containing the Input Control name 
“Magazines Produced”. 
 

12. Select Discrete (this Input Control setting will consider only discrete values). The Start value is 
set to 100000 from cell C17 (current production volume per month). Set the Min value to 
10000, Max value to 100000 and Step to 10000 as shown: 

 
13. Click OK. Hover the cursor on cell C17 to view the comment displaying the Input Control 

settings: 
 

 
 

14. Now we will specify the output. Click on cell C27. The cell contains the Excel formula for the Net 
Profit: = _Revenue - (_Total_Production_Cost + _Total_Disposal_Cost). 
 

15. Select DiscoverSim > Output Response:  
 

 
 
 

16. Click output Name cell reference  and specify cell B27 containing the Output name “Net 
Profit.” Enter the Lower Specification Limit (LSL) as 0. The Weight and Output Goal settings are 
used only for multiple response optimization, so do not need to be modified in this example.  
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Click OK. 
 

17. Hover the cursor on cell C27 to view the DiscoverSim Output information.  
 

 
 

18. Select DiscoverSim > Run Simulation: 
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19. Select Seed Value and enter “12” as shown, in order to replicate the simulation results given 
below (note that 64 bit DiscoverSim will show slightly different results). 
 

 
Click Run. 
 

20. The DiscoverSim Output Report displays a histogram, descriptive statistics and process 
capability indices: 
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The Mean Net Profit is approximately $42,300, which is good, but we also see from the 
Actual Performance report, we have a 22.9% chance of monthly loss.  The standard 
deviation is also quite high at $47,800.   
 

21. Now we are ready to perform the discrete optimization to maximize the mean of net profit.  
Select DiscoverSim > Run Optimization: 

 

 
  



DiscoverSim Case Studies 

95 

22. Select “Maximize” for Optimization Goal, “Weighted Sum” for Multiple Output Metric and 
“Mean” for Statistic. Select Discrete Exhaustive. Set Seed Value to 12 and Replications to 2500 
in order to replicate the optimization results given below.  All other settings will be the defaults 
as shown:  

 
Tip: Here we are using Discrete Exhaustive because this particular problem is not complex, 
given that there is only one input control variable with 10 discrete levels. The Time Limit 
determines how long Discrete Exhaustive will run. A single simulation run is first performed 
and the computation time is measured. If the total number of discrete combinations * 
single run time exceed the Time Limit, an error message is produced, so you can either 
increase the Time Limit, or use a different optimization method. 
 

23. Click Run.  
 

24. The final optimal parameter value is given as: 
 

 
 
The optimum number of magazines to produce per month is 60,000, resulting in an 
expected mean profit of $59,077. 
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25. You are prompted to paste the optimal value into the spreadsheet: 
 

 
 
Tip: If you check Display History, the complete history of optimization iterations will be 
displayed in a separate window after clicking Yes or No to the paste prompt. 
 
Click Yes. This sets the input control value to the optimum value of 6 as shown: 
 

 
 

26. Select DiscoverSim > Run Simulation: 
 

 
 

27. Select Seed Value and enter “12” as shown, in order to replicate the simulation results given 
below. 
 

 
 

Click Run. 
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28. The DiscoverSim Output Report displays a histogram, descriptive statistics and process 
capability indices for the optimized setting: 
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From the histogram and capability report we see that the expected mean net profit has 
increased from $42,300 to $59,300.  The standard deviation has decreased from $47,800 to 
$33,500.  Looking at the Actual Performance report we see a decrease in the likelihood of a 
profit loss from 22.9% to 5.2%.   
 

29. Obviously the quality of this prediction will depend on the validity of the custom distribution 
and does not take into account hidden soft costs like customer dissatisfaction due to lack of 
availability.  If necessary, the model can be refined.  Nevertheless, the tool is very useful to help 
us to determine what our production rate should be in order to maximize net profit. 
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Case Study 3 – Six Sigma DMAIC Project Portfolio Selection 
 
Introduction: Optimizing DMAIC Project Portfolio to Maximize 
Cost Savings 
 
This is an example of DiscoverSim optimization used to select Six Sigma DMAIC projects that 
maximize expected cost savings. 
 
This example model was contributed by: 
 
Dr. Harry Shah, Business Excellence Consulting. 
 
The goal is to select projects that maximize Total Expected Savings subject to a constraint of Total 
Resources <= 20. Management requires a minimum total project savings of $1 Million (Lower 
Specification Limit, LSL = 1000 $K). We will explore the optimal selection of projects that maximize 
the Mean Savings and also consider maximizing the Process Capability Index Ppl. 
 
Cost Savings are specified with a Triangular Distribution. 
 
The Probability of Success is modeled using the Bernoulli (Yes/No) Distribution. 
 
“Resources Required” are specified for each project.  DiscoverSim Input Controls (Discrete) are 
used to select the project (0,1). 
 
Expected Project Savings are calculated as the sum of: Cost Savings * Probability of Success (if 
project is selected) or 0 (if project is not selected). 
 

 
Summary of DiscoverSim Features Demonstrated in Case Study 3: 

• Create Input Distributions (Continuous Triangular) 
• DiscoverSim Copy/Paste Cell 
• Create Input Distributions (Discrete Bernoulli) 
• Create Discrete Input Controls 
• Specify Constraints 
• Run Optimization 
• Run Simulation 
• Insert DSIM Function 
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Optimization of Project Portfolio with DiscoverSim 
 

1. Open the workbook DMAIC Project Selection - Optimization.  DiscoverSim Input Distributions 
will simulate the variability in the cost savings and probability of success for each project.  We 
will specify cost savings as a Triangular Distribution for each project in cells G14 to G22. The 
probability of success will be specified at cells K14 to K22 using the Bernoulli (Yes/No) 
Distribution.  

 

 
 
 

2. DiscoverSim Input Controls (Discrete) will be used to “select” the project (0,1) and specified in 
cells O14 to O22. 

 

 
 
 

3. Click on cell G14 to specify the “Cost Savings” Input Distribution for Project_A.  Select 
DiscoverSim > Input Distribution: 

 

 
 

4. Select Triangular Distribution. 
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5. Click the input name cell reference  and specify cell F14 containing the input Name 
“Project_A_CS” (denoting “Project A Cost Savings”). After specifying a cell reference, the 
dropdown symbol changes from  to  . 
 

6. Click the Minimum parameter cell reference  and specify cell C14 containing the minimum 
parameter value = 100 ($K).  
 

7. Click the Mode parameter cell reference  and specify cell D14 containing the mode (most 
likely) parameter value = 125 ($K). 

 
8. Click the Maximum parameter cell reference  and specify cell E14 containing the maximum 

parameter value = 150 ($K). 
  

9. Click Update Chart to view the Triangular Distribution as shown: 
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10. Click OK. Hover the cursor on cell G14 to view the DiscoverSim graphical comment showing the 
distribution and parameter values: 
 

 
 

11. Click on cell G14. Click the DiscoverSim Copy Cell menu button  (Do not use Excel’s 
Copy – it will not work!).  
 

12. Select cells G15:G22.  Now click the DiscoverSim Paste Cell menu button  (Do not use 
Excel’s Paste – it will not work!). 

 
13. Review the input comments in cells G15 to G22. 

 

14. Click on cell K14 to specify the “Probability of Success” Input Distribution for Project_A.  Select 
DiscoverSim > Input Distribution: 

 

 
 

15. Select Discrete and Bernoulli Distribution. Bernoulli is also sometimes referred to as the 
“Yes/No” distribution. 
 

16. Click the input Name cell reference  and specify cell J14 containing the input name 
“Project_A_Pr” (denoting “Project A Probability of Success”). 
 

17. Click the Event Probability parameter cell reference  and specify cell I14 containing the 
probability parameter value = 0.9.  
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18. Click Update Chart to view the Bernoulli distribution as shown: 
 

 
 
 

19. Click OK. Hover the cursor on cell K14 to view the DiscoverSim graphical comment showing the 
distribution and parameter values: 
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20. Click on cell K14. Click the DiscoverSim Copy Cell menu button  (Do not use Excel’s 
Copy – it will not work!).  
 

21. Select cells K15:K22.  Now click the DiscoverSim Paste Cell menu button   (Do not use 
Excel’s Paste – it will not work!). 
 

22. Review the input comments in cells K15 to K22. 
 

23. Now we will add Discrete Input Controls (also referred to as “Decision Variables”). These will be 
used to “select” the project (0 denotes project not selected, 1 denotes project selected).  
DiscoverSim will use stochastic global optimization to determine which projects to select and 
which not to select in order to maximize total cost savings.  A constraint will also be added to 
ensure that the total number of resources is <= 20. 
 

24. Click on cell O14. Select Control:  
 

 
 

25. Click input Name cell reference  and specify cell N14 containing the input control name 
“Project_A_Select.” 
 

26. Select Discrete (this input control setting will consider only integer values). Use the default 
values as shown: 
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27. Click OK. Hover the cursor on cell O14 to view the comment displaying the Input Control 
settings: 
 

 
28. Click on cell O14. Click the DiscoverSim Copy Cell menu button  (Do not use Excel’s 

Copy – it will not work!).  
 

29. Select cells O15:O22. Click the DiscoverSim Paste Cell menu button   (Do not use 
Excel’s Paste – it will not work!). 
 

30. Review the input control comments in cells O15 to O22. 
 

31. Now we will add the constraint. Click on cell O26. Select Constraint:  
 

 
 

32. Enter the Constraint Name as “Resource_Constraint.” Enter O24 in the “Left Hand Side” (LHS) 
or click the LHS cell reference  and select O24. Select <= . Enter 20 in the “Right Hand Side” 
(RHS). 

 
 
Note: Cell O24 contains the Excel formula: =SUMPRODUCT(O14:O22,M14:M22).  This sums 
the product of resources*selected(0,1). In other words, the sum of selected project 
resources. 
 

33. Click OK. Review the comment at cell O26. 
 

 
 
The cell display is “TRUE” since the initial value for O24 is zero which obviously satisfies the 
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constraint. 
 

34. Now we will specify the output. Click on cell Q24. The cell contains the Excel formula for the 
sum of expected savings as the sum of: Cost Savings * Probability of Success (if project is 
selected) or 0 (if project is not selected). 
 

35. Select DiscoverSim > Output Response:  
 

 
 

36. Enter the output Name as “Total Savings.” Enter the Lower Specification Limit (LSL) as 1000. 
The Weight and Output Goal settings are used only for multiple response optimization, so do 
not need to be modified in this example.  
 

 
 
Click OK. 
 

37. Hover the cursor on cell Q24 to view the DiscoverSim Output information.  
 

 
 

38. Now we are ready to perform the optimization to select projects.  Select DiscoverSim > Run 
Optimization: 
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39. Select “Maximize” for Optimization Goal and “Mean” for Statistic. Select Seed Value and enter 
“12” in order to replicate the optimization results given below.  Change Replications to 1000 to 
reduce the optimization time. All other settings will be the defaults as shown:  

 

 
 
Note: Maximize Mean may not produce the lowest possible standard deviation, so we will 
consider Maximize Ppl later. 
 
We will use the Hybrid optimization method which may require more time to compute, but 
is powerful to solve complex optimization problems. Since this is a small discrete problem, 
Discrete Exhaustive will be used. If there were more projects, say 20, then MIDACO would 
have been used. 
 

40. Click Run.  
 

41. The final optimal parameter values are given as: 
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Projects E, F, H and I have been selected giving a predicted mean cost savings of 2004 ($K).  
Intuitively, these would be the projects one would select given that they have the highest 
expected values per resource. However, a simple “pick the winner” approach fails to take 
into account the variability and likelihood of meeting the minimum total cost saving 
requirement of 1000 $K. 
 

42. The constraint equation evaluated at this optimum has been satisfied (amount violated = 0):  
 

 
 
Project E requires 10 resources, F requires 2, H requires 5 and I requires 3 for a total of 20, 
satisfying our constraint that the total resources be less than or equal to 20. 
 
 

43. You are prompted to paste the optimal value into the spreadsheet: 
 

 
 
Tip: If you check Display History, the complete history of optimization iterations will be 
displayed in a separate window after clicking Yes or No to the paste prompt. 
 
Click Yes. This sets the Input Control values to the optimum values as shown: 
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44. Select DiscoverSim > Run Simulation:  
 

 
 

45. Select Seed Value and enter “12” as shown, in order to replicate the simulation results given 
below. 
 

 
 
Click Run. 
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46. The DiscoverSim Output Report displays a histogram, descriptive statistics and process 
capability indices: 
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From the histogram and capability report we see that the expected mean total savings are 
good (1997 $K), but the standard deviation is very large (1085 $K).  Looking at the Actual 
Performance report we see that there is a 19.5% chance of failing to meet the management 
requirement of 1000 $K.   
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47. Now we will rerun the optimization to select projects, but this time, we will maximize the 
process capability index Ppl.  (Ppl is used since we only have a lower specification limit).  This 
will simultaneously maximize the mean and minimize the standard deviation: 
 
 Ppl = (Mean – LSL)/(3*StdDev). 
 
An equivalent alternative would be to minimize Calculated DPM. 
 
Note: A nonparametric alternative statistic would be %Ppl (percentile Ppl): 
 
            %Ppl = (Median – LSL)/(Median - 0.135 Percentile).  
 
This is robust to the assumption of normality. Another robust statistic would be Actual DPM.  
With either of these we would recommend increasing the number of replications to 10,000 to 
improve the precision of the statistic, but this would require significantly more computation 
time for optimization. 
 

48. Reset the project selection by changing the Input Control values to 0: 
 

 
 

49. Select DiscoverSim > Run Optimization: 
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50. Select “Maximize” for Optimization Goal, “Weighted Sum” for Multiple Output Metric and 
“PpL” for Statistic. Select Seed Value and enter “12,” in order to replicate the optimization 
results given below.  Set Replications to 1000 to reduce the optimization time. All other 
settings will be the defaults as shown:  

 

 
 
Click Run. 
 

51. The final optimal parameter values are given as: 
 

 
Projects A, C, F, G, H, and I have been selected giving a predicted Ppl of 0.62.   
 

Note: Project E, previously selected to maximize the mean, was not selected when the goal 
was to maximize the process capability, Ppl. 
 
The constraint requirement that the total number of resources be <= 20 is satisfied with this 
selection. 
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52. You are prompted to paste the optimal values into the spreadsheet: 
 

 
 
Click Yes. This sets the Input Control values to the optimum values as shown: 
 

 
 

53. Select DiscoverSim > Run Simulation:  
 

 
 

54. Select Seed Value and enter “12” as shown, in order to replicate the simulation results given 
below. 

 
Click Run. 
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55. The DiscoverSim Output Report displays a histogram, descriptive statistics and process 
capability indices: 

 

 

 



DiscoverSim Case Studies 

116 

 
Note that the mean total savings have been reduced somewhat from 2011 to 1915 $K, 
however, the standard deviation has been reduced from 1080 to 490 $K and the chance of 
failing to meet the management requirement of 1000 $K has been reduced from 18.9% to 
4.35% (actual performance). 
 
Considering the two selection scenarios, one can present the risks to management and 
make the case for either option: take the risk and maximize the mean with potential larger 
savings, or choose the safer projects that result in less variation and significantly improve 
the chance of meeting a minimum savings of 1 million. 
 

56. Clearly, Project E is the key project to consider in this analysis. The impact of this project can be 
confirmed with a sensitivity analysis. 
 

57. Set all of the Input Control values to 1 as shown: 
 

 
 

58. Select DiscoverSim > Run Simulation:  
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59. Click Report Options/Sensitivity Analysis. Check Sensitivity Regression Analysis, Sensitivity 
Charts -   Correlation Coefficients and Regression Coefficients. Select Seed Value and enter 
“12” as shown, in order to replicate the simulation results given below. 

 

 
 
Click Run. 
 

60. Click on the Sensitivity Correlations sheet: 
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61. Click on the Sensitivity Regression sheet to view the R-Square percent contribution to 
variation: 

 

 
 
The sensitivity charts confirm that Project E is the dominant “X” factor.  This is a high impact 
project, but is also a difficult project with a probability of success of only 0.5 and a large 
variation (min = 2000, max = 2500).  If possible, this project might be split into smaller, 
lower risk (higher probability of success) projects with less variation. 
 

62. Optional Insert DSIM Function: As an alternative to Maximize CpL as shown above, we could 
also Maximize Mean Savings subject to an added constraint that the Standard Deviation of 
Savings be < 500.  Click on cell Q27 and select DiscoverSim > DSIM Function: 

 

 
 

 
Scroll down to select DSIM_Stdev. Click OK.  
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63. Select the Output Q24 as the DSIM Variable. 

 
The DiscoverSim Range Name for Q24 is _Output_1_Q24.  Click OK. 
 

64. The DSIM function formula is now in cell Q24: 
 
=DSim_Stdev(_Output_1_Q24) 
 

65. Now we will add a constraint at cell O27 that references the DSIM function.  Click on cell O27. 
Select Constraint:  

 

 
 

66. Enter the Constraint Name as “StDev_Constraint.” Enter Q27 in the “Left Hand Side” (LHS) or 
click the LHS cell reference  and select Q27. Select < . Enter 500 in the “Right Hand Side” 
(RHS). 

 
 
 

67. Click OK. Review the comment at cell O27: 
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The cell display is “TRUE” since the initial value for Q27 is zero which obviously satisfies the 
constraint. 

 
 

68. With all of the Input Control values set to 1, select DiscoverSim > Run Optimization: 
 

 
 

69. Select “Maximize” for Optimization Goal, “Weighted Sum” for Multiple Output Metric and 
“Mean” for Statistic. Select Seed Value and enter “12,” in order to replicate the optimization 
results given below.  Set Replications to 1000 to reduce the optimization time. All other 
settings will be the defaults as shown:  

 

 
 
Click Run. 
 

70. The final optimal parameter values are given as: 
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Projects A, C, F, G, H, and I have been selected giving a predicted Mean of 1899.9. These are 
exactly the same projects that were selected above with maximize PpL. 
 

71. You are prompted to paste the optimal values into the spreadsheet: 
 

 
 
Since we have already analyzed this project selection, we will not pursue this further. Click 
No. 
 

72. The use of Insert DSIM Function as shown provides flexibility in specifying the optimization 
objective function. For example in a multiple output scenario, you can Maximize the Mean of 
Output 1, with a constraint that Output 2 Ppk process capability must be > 1. 
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Case Study 4 – Catapult Variation Reduction 
 
Introduction: Optimizing Catapult Distance Firing Process 
 
This is an example of DiscoverSim stochastic optimization for catapult distance variation reduction, 
adapted from: 
 
John O'Neill, Sigma Quality Management.  
 
This example is used with permission of the author. 
 
The figure below is a simplified view of the catapult:  
 

 
 
The target catapult firing distance, Y = 50 +/- 2.5 feet. 
 
To keep the model simple, only four factors (X’s) are included: 
 

1. Spring Constant (k) – The spring constant is the force/foot required to pull back the catapult 
arm (in lbf/ft.). The initial parameters for this factor: normally distributed, mean of 47.3, 
standard deviation of 0.1. 
 

2. Pull Distance (x) – This is the distance in feet the arm is pulled back to launch the mass. The 
initial parameters for this factor: normally distributed, mean of 6.0, standard deviation of 0.1. 
 

3. Mass (m) – This is the mass of the object in slugs (lbf/ft/sec^2). The initial parameters for this 
factor: normally distributed, mean of 0.5, standard deviation of 0.01. 
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4. Launch Angle (θ) – This is the angle in degrees to the horizontal at which the mass leaves the 
catapult. The initial parameters for this factor: normally distributed, mean of 35, standard 
deviation of 3.   

 

Note: The degrees must be converted into radians for input to the Excel sine and cosine 
functions. 
 

The Y = f(X) relationship is derived from conservation of energy and basic time, distance, 
acceleration relationships. Note that air resistance and other “real world” factors have been 
ignored to keep the model simple. Standard Gravity (g) is 32.174 ft/sec^2: 

 

 
 

In this study we will use DiscoverSim to help us answer the following questions: 
 

• What is the predicted process capability with these nominal settings? 
 

• What are the key X variables that influence catapult firing distance Y?  
 

• Can we adjust the nominal settings of X to reduce the transmitted variation in Y, thereby 
making the distance response robust to the variation in inputs? 
 

• Can we further reduce the variation of the key input X’s in order to achieve an acceptable 
process capability? 
 
 

Summary of DiscoverSim Features Demonstrated in Case Study 4: 
• Create Input Distributions (Continuous Normal) 
• DiscoverSim Copy/Paste Cell 
• Run Simulation with Sensitivity Chart of Correlation Coefficients 
• Create Continuous Input Controls for Parameter Optimization 
• Run Optimization 
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Catapult Simulation and Optimization with DiscoverSim 
 

1. Open the workbook Catapult Model. DiscoverSim Input Distributions will simulate the 
variability in the catapult input factor X’s. We will specify the Normal Distribution for each X in 
cells D30 to D33. The output, Distance, will be specified at cell D36 using the formula given 
above. 

 

 
 

2. The Input Distribution parameters are given in the following table: 
 

 
 

3. Click on cell D30 to specify the Input Distribution for X1, Spring Constant. Select DiscoverSim > 
Input Distribution: 

 

 
 

4. We will use the selected default Normal Distribution. 
 

5. Click input Name cell reference  and specify cell F30 containing the input name 
“Spring_Constant”. After specifying a cell reference, the dropdown symbol changes from  to 

 . 
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6. Click the Mean parameter cell reference  and specify cell I30 containing the mean parameter 
value = 47.3.  
 

7. Click the StdDev parameter cell reference  and specify cell K30 containing the Standard 
Deviation parameter value = 0.1. 
 

8. Click Update Chart to view the Normal Distribution as shown: 
 

 
 

9. Click OK. Hover the cursor on cell D30 to view the DiscoverSim graphical comment showing the 
distribution and parameter values: 
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10. Click on cell D30. Click the DiscoverSim Copy Cell menu button  (Do not use Excel’s 
Copy – it will not work!).  
 

11. Select cells D31:D33. Now click the DiscoverSim Paste Cell menu button   (Do not use 
Excel’s Paste – it will not work!). 
 

12. Review the input comments in cells D31 to D33: 
 
Cell D31: 

 
 
Cell D32: 
 

 
 
Cell D33: 
 

 
 

13. Click on cell D36. Note that the cell contains the Excel formula for Catapult Firing Distance. 
Excel range names are used rather than cell addresses to simplify interpretation. 
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14. Select DiscoverSim > Output Response:  
 

 
 

15. Enter the output Name as “Distance.” Enter the Lower Specification Limit (LSL) as 47.5, Target 
as 50, and Upper Specification Limit (USL) as 52.5. 
 

 
 
Click OK. 
 

16. Hover the cursor on cell D36 to view the DiscoverSim Output information.  
 

 
 

17. Select DiscoverSim > Run Simulation:  
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18. Click Report Options/Sensitivity Analysis. Check Sensitivity Charts and Correlation 
Coefficients. Select Seed Value and enter “12” as shown, in order to replicate the simulation 
results given below. 

 

 
 
Click Run. 
 

  



DiscoverSim Case Studies 

129 

19. The DiscoverSim Output Report shows a histogram, descriptive statistics and process capability 
indices: 
 

 

 
 

From the histogram and capability report we see that the catapult firing distance is not 
capable of meeting the specification requirements. The variation is unacceptably large. 
Approximately 35% of the shots fired would fail, so we must improve the process to reduce 
the variation. 
Note: The output distribution is not normal (skewed left), even though the inputs are 
normal. This is due to the non-linear transfer function. 
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20. Click on the Sensitivity Correlations sheet: 
 

 
 
Launch Angle is the dominant input factor affecting Distance, followed by Pull Distance. At 
this point we could put procedures in place to reduce the standard deviation of these input 
factors, but before we do that we will run optimization to determine if the process can be 
made robust to the input variation. 
 

21. In order to perform parameter optimization, we will need to add Input Controls in cells I30 to 
I33. Select Sheet1. The Input Control parameters (min/max) are also shown below: 

 

 
 
These controls will vary the nominal mean values for Spring Constant, Pull Distance and 
Launch Angle. Mass is kept fixed at 0.5. The standard deviation values will also be kept fixed 
for this optimization.  
 

22. Click on cell I30. Select Control: 
 

 
 

23. Click Input Name cell reference  and specify cell M30 containing the input control name 
“Spring_Constant_Control”. 
 

24. Click the Min value cell reference  and specify cell N30 containing the minimum optimization 
boundary value = 30. 
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25. Click the Max value cell reference  and specify cell O30 containing the maximum optimization 
boundary value = 70: 
 

 
 

26. Click OK. Hover the cursor on cell I30 to view the comment displaying the input control settings: 
 

 
 

27. Click on cell I30. Click the DiscoverSim Copy Cell menu button  (Do not use Excel’s 
Copy – it will not work!).  
 

28. Select cells I31:I33. Click the DiscoverSim Paste Cell menu button  (Do not use Excel’s 
Paste – it will not work!). 
 

29. Review the Input Control comments in cells I31 to I33. 
 

30. The completed model is shown below: 
 

 
 
 
 
 

31. Now we are ready to perform the optimization. Select DiscoverSim > Run Optimization: 
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32. Select “Maximize” for Optimization Goal, “Weighted Sum” for Multiple Output Metric and 
“Cpm” for Statistic. Set Seed Value to 12 and Replications to 1000 in order to replicate the 
optimization results given below. All other settings will be the defaults as shown:  
 

 
 

Maximize Cpm is used here because it incorporates a penalty for mean deviation from 
target. We want the distance mean to be on target with minimal variation. 
 
We will use the Hybrid optimization method which requires more time to compute, but is 
powerful to solve complex optimization problems. 
 
Tip: To speed up this optimization, change the maximum number of iterations in Hybrid 
Midaco 1 (first MIDACO run) from 1000 to 100. Click Advanced Settings. Select Midaco 1 
Maximum Iterations. Enter 100 as shown. Click OK. 
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33. Click Run. 
 

34. The final optimal parameter values are given as: 
 

 
The predicted Cpm value is 0.48, which is an improvement over the baseline value of 0.3. 
 

35. You are prompted to paste the optimal values into the spreadsheet: 
 

 
 
Click Yes. This replaces the nominal Input Control values to the optimum values. 
 

 
 
Note that the expected values displayed in the Input Distributions are not automatically 
updated, but the new referenced Mean values will be used in simulation. To manually 
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update the expected values and chart comments, click on each input cell, select Input 
Distribution and click OK. 
 

36. Select Run Simulation. Click Report Options/Sensitivity Analysis. Check Sensitivity Charts and 
Correlation Coefficients. Select Seed Value and enter “12,” in order to replicate the simulation 
results given below. Click Run.  
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37. The resulting simulation report confirms the predicted process improvement: 
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The standard deviation has been reduced from 2.73 to 1.75. The % Total (out-of-spec) has 
been decreased from 35.0% to 15.3%.  This was achieved simply by shifting the mean input 
values so that the catapult transmitted variation is reduced. The key variable here is the 
launch angle mean shifting from 30 degrees to 45 degrees as illustrated in the simplified 
diagram below: 

 

 
 

Note: the illustrated improvement here is more dramatic than what was actually realized in 
the optimization due to the influence of the other input variables. 
 

38. We will continue our improvement efforts, now focusing on reducing the variation of the 
inputs.  Click on the Sensitivity Correlations (2) sheet: 
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Pull Distance and Mass are now the dominant input factors affecting Distance.   
Note: Launch Angle now has the least influence due to the minimized transmitted variation 
at 45 degrees. 
 

39. Select Sheet1, and change the standard deviation for Pull Distance from 0.1 to 0.01 (K31), and 
standard deviation for Mass from .01 to .001 (K32) as shown. 

 

 
Of course it is one thing to type in new standard deviation values to see what the results 
will be in simulation, but it is another to implement such a change. This requires updates to 
standard operating procedures, training of operators, tightening of component tolerances 
and likely increased cost.  Robust parameter optimization, as demonstrated above, is easy 
and cheap. Reducing the variation of inputs can be difficult and expensive. 
 

40. Select Run Simulation. Click Run. The resulting simulation report shows the further process 
improvement: 
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The standard deviation has been further reduced from 1.73 to 0.46. The % Total (out-of-
spec) has decreased from 15.3% to 0.2% 
 
Note: The distribution is not normal (skewed left) due to the non-linearity in the transfer 
function. 
 
This is not yet a Six Sigma capable process, but it has been dramatically improved. 
Additional process capability improvement could be realized by optimizing %Ppk (Percentile 
based Ppk is best for non-normal distributions) rather than Cpm. This would shift the mean 
to the right of the target, to compensate for the skew left distribution, but the trade-off of 
mean being on target versus reduction in defects below the lower specification would need 
to be considered. 
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Case Study 5 – Robust New Product Design 
 
Introduction: Optimizing Shutoff Valve Spring Force 
 
This is an example of DiscoverSim stochastic optimization for robust new product design, adapted 
from:  
 
Sleeper, Andrew (2006), Design for Six Sigma Statistics: 59 Tools for Diagnosing and Solving 
Problems in DFSS Initiatives, NY, McGraw-Hill, pp. 782-789. 
 
Sleeper, Andrew, “Accelerating Product Development with Simulation and Stochastic 
Optimization,” E-mail: AndrewDSleeper at gmail.com. 
 
This example is used with permission of the author. 
 
The figure below is a simplified cross-sectional view of a solenoid-operated gas shutoff valve: 
 

 
 
 
The arrows at the bottom of the figure indicate the direction of gas flow. A solenoid holds the plate 
(shaded) open when energized. When the solenoid is not energized, the spring pushes the plate 
down to shut off gas flow. If the spring force is too high, the valve will not open or stay open. If the 
spring force is too low, the valve can be opened by the inlet gas pressure. 
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The method of specifying and testing the spring is shown below: 
 

 
 
The spring force requirement is 22 +/- 2 Newtons. 
 
The spring force equation, or the Y = f(X) transfer function, is calculated as follows: 
 
Spring Length, L = -X1 + X2 - X3 + X4 
 
Spring Rate, R = (X8 - X7)/X6 
 
Spring Force, Y = X7 + R * (X5 - L) 
 
The shut off valve features, tolerances and nominal settings are given as:  
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In this study we will use DiscoverSim to help us answer the following questions: 
 

• What is the predicted process capability with these feature tolerances and nominal 
settings? 
 

• What are the key X variables that influence spring force Y?  Can we improve the process 
capability by tightening the tolerance of the important variables? Can this be done 
economically? 
 

• Can we adjust the nominal settings of X to reduce the transmitted variation in Y, thereby 
making the Spring Force robust to the variation due to feature tolerances? 
 
 

Summary of DiscoverSim Features Demonstrated in Case Study 5: 
• Create Input Distributions (Continuous Uniform) 
• DiscoverSim Copy/Paste Cell 
• Run Simulation with Sensitivity Chart of Correlation Coefficients 
• Create Continuous Input Controls 
• Specify Constraints 
• Run Optimization 
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Spring Force Simulation and Optimization with DiscoverSim 
 

1. Open the workbook Shutoff Valve Spring Force. DiscoverSim Input Distributions will simulate 
the variability in feature tolerance. We will use the Uniform Distribution, since we do not have 
historical data to estimate a best fit distribution, and will assume an equal probability for a 
feature to have a minimum tolerance or maximum tolerance value.  Input Distributions with 
Uniform Distributions (Random) will be specified in cells I15 to I22.  Nominal (midpoint) values 
are specified in cells H15 to H22 with initial values determined by engineering best estimate. 
Input Controls will be applied here for optimization. The sum of Nominal + Random is used to 
calculate the X1 to X8 variables and given in cells J15 to J22. The output, Spring Rate, will be 
specified at cell J27 using the formula given in the introduction. 

 

 
 

2. The Input Distribution parameters are given in the following table: 
 

 
 
 

3. Click on cell I15 to specify the Input Distribution for X1, Lip Height.   
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Select DiscoverSim > Input Distribution: 

 
 

4. Select Uniform Distribution. 
 

5. Click input Name cell reference  and specify cell L15 containing the input name “X1_Dist.” 
After specifying a cell reference, the dropdown symbol changes from  to  . 
 

6. Click the Minimum parameter cell reference  and specify cell M15 containing the minimum 
parameter value = -0.1.  
 

7. Click the Maximum parameter cell reference  and specify cell N15 containing the maximum 
parameter value = 0.1. 
  

8. Click Update Chart to view the Uniform Distribution as shown: 
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9. Click OK. Hover the cursor on cell I15 to view the DiscoverSim graphical comment showing the 
distribution and parameter values: 
 

 
 

10. Click on cell I15. Click the DiscoverSim Copy Cell menu button  (Do not use Excel’s 
Copy – it will not work!).  
 

11. Select cells I16:I22. Click the DiscoverSim Paste Cell menu button   (Do not use 
Excel’s Paste – it will not work!). 

 
12. Review the input comments in cells I16 to I22: 

 
Cell I16: 
 

 
 
Cell I17: 
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Cell I18: 
 

 
 
Cell I19: 
 

 
 
Cell I20: 
 

 
 
Cell I21: 
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Cell I22: 
 

 
 

13. Click on cell J27.  
 

Note: The cell contains the Excel formula for Spring Force: 
 =_X7 + _R * (_X5 - _L). Excel range names _X7, _R, _X5 and _L are used rather than cell 
addresses to simplify interpretation. 
 

14. Select DiscoverSim > Output Response:  
 

 
 

15. Enter the output Name as “Spring_Force.” Enter the Lower Specification Limit (LSL) as 20, 
Target as 22, and Upper Specification Limit (USL) as 24.  
 

 
 
Click OK. 
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16. Hover the cursor on cell J27 to view the DiscoverSim Output information.  
 

 
 

17. Select DiscoverSim > Run Simulation:  
 

 
 

18. Click Report Options/Sensitivity Analysis. Check Sensitivity Charts and Correlation Coefficients. 
Select Seed Value and enter “12” as shown, in order to replicate the simulation results given 
below: 

 

 
 
Click Run. 
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19. The DiscoverSim Output Report shows a histogram, descriptive statistics and process capability 
indices: 
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From the histogram and capability report we see that the Spring Force is not capable of 
meeting the specification requirements. The process mean is off target and the variation 
due to feature tolerance is unacceptably large. Approximately 12.3% of the shutoff valves 
would fail, so we must improve this design to center the mean and reduce the variation. 
 

20. Click on the Sensitivity Correlations sheet: 
 

 
 
X5 (Initial Compression) is the dominant input factor affecting Spring Force, followed by X4 
(Spring Gap Depth).  The tolerance on Initial Compression is +/- 0.5.  Discussing this with our 
supplier it turns out that the tolerance for this spring feature can be tightened to +/- 0.25 
without increasing the cost. 
 
This Sensitivity Chart uses the Spearman Rank Correlation, and the results may be positive 
or negative.  If you wish to view R-Squared percent contribution to variation, rerun the 
simulation with Sensitivity Regression Analysis and Sensitivity Charts, Regression 
Coefficients checked. 
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21. Select Sheet1, click on cell M19. Change the Uniform Minimum value from -0.5 to -0.25. Click 
on cell N19. Change the Uniform Maximum value from 0.5 to 0.25. 

 

 
 

22. DiscoverSim references to cells are dynamic, so this change will take effect on the next 
simulation run, but the input comment will need to be refreshed manually. Click on cell I19 
(Input X5_Dist). Select Input Distribution. Click OK. Review the revised input comment in cell 
I19: 

 

 
 

23. Rerun the simulation without sensitivity charts: 
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Tightening the tolerance of X5, Initial Compression resulted in an improvement with the 
Spring Force standard deviation reduced from 1.24 to 0.86, actual percent out of 
specification from 12.5 to 4.0% and Ppk increased from .43 to .63.  However a Six Sigma 
design should have a minimum Ppk value of 1.5. 
 
At this point one could use Excel’s Solver to further improve the process by finding the 
nominal values that center the mean, but that still would not achieve the desired quality 
level. 
 
DiscoverSim’s Stochastic Global Optimization will not only find the optimum X settings that 
result in the best mean spring force value, it will also look for a solution that will reduce the 
standard deviation. Stochastic optimization looks for a minimum or maximum that is robust 
to variation in X, thus reducing the transmitted variation in Y. This is referred to as “Robust 
Parameter Design” in Design For Six Sigma (DFSS). 
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24. In order to run optimization, we will need to add Input Controls (also known as Decision 
Variables). Select Sheet1.  The Input Control parameters are given in the table: 

 

 
 
The controls will vary the nominal X values in H15 to H22. The nominal values are added to 
the random input distribution (J15 to J22) as discussed above in Step 1. 
 
Constraints will also be added as shown so that there can be no overlap due to tolerance.  
For example if X2, Height, was at the low end of its tolerance and X1, Lip Height, was at the 
high end of its tolerance, it is possible that an overlap would leave no place for the spring to 
be seated. 
 

25. Click on cell H15. Select Control:  

 
 

26. Click input Name cell reference  and specify cell P15 containing the input control name 
“X1_Control.” 
 

27. Click the Min value cell reference  and specify cell Q15 containing the minimum optimization 
boundary value = 2. 
 

28. Click the Max value cell reference  and specify cell R15 containing the maximum optimization 
boundary value = 5: 
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29. Click OK. Hover the cursor on cell H15 to view the comment displaying the input control 
settings: 

 

 
 

30. Click on cell H15. Click the DiscoverSim Copy Cell menu button  (Do not use Excel’s 
Copy – it will not work!).  
 

31. Select cells H16:H22. Click the DiscoverSim Paste Cell menu button   (Do not use 
Excel’s Paste – it will not work!). 
 

32. Review the input control comments in cells H16 to H22. 
 

33. Now we will add the Constraints. Click on cell U16. Select Constraint: 
 

  
 

34. Type X2_Control – X1_Control in the “Left Hand Side” (LHS). Select “Greater Than >.” Enter 0.2 
in the “Right Hand Side” (RHS).  

 

 
 

35. Click OK. Review the comment at cell U16. 
 

 
 
The cell display is “TRUE” since the initial value for X2_Control (5) is greater than the initial 
value for X1_Control (3). 
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36. Repeat steps 33 to 35 with constraints at cells U18 and U22 as shown: 
 

 
 

 
 

37. The completed model is shown below: 
 

 
 

38. Now we are ready to perform the optimization.  Select DiscoverSim > Run Optimization: 
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39. Select “Maximize” for Optimization Goal, “Weighted Sum” for Multiple Output Metric and 
“Cpm” for Statistic. Select Seed Value and enter “12,” in order to replicate the optimization 
results given below.  Set Replications to 1000 to reduce the optimization time. All other 
settings will be the defaults as shown:  

 

 
 
Maximize Cpm is used here, rather than Ppk, because it incorporates a penalty for mean 
deviation from target.  We want the spring force mean to be on target with minimal 
variation. Note, however, that this solution may not produce the lowest possible standard 
deviation. 
We will use the Hybrid optimization method which requires more time to compute, but is 
powerful to solve complex optimization problems. 
 
Tip: To speed up this optimization, change the maximum number of iterations in Hybrid 
Midaco 1 (first MIDACO run) from 1000 to 100. Click Advanced Settings.  Select Midaco 1 
Maximum Iterations. Enter 100 as shown. Click OK. 

 
 

40. Click Run. 
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41. Scroll through the optimization report window to view the various optimization methods.  The 
initial method in Hybrid, MIDACO global optimization, found a solution that resulted in a world 
class Cpm value of 7.4!: 

 

 
 

42. The Genetic Algorithm uses the above optimal values as a starting point, but is unable to 
further improve on MIDACO’s Cpm value of 7.4 
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43. The final method in this Hybrid, Sequential Quadratic Programming local optimization, uses the 
Genetic Algorithm optimal values as a starting point but is unable to further improve on the 
Cpm value of 7.4. 

 

 
 

44. The constraint equations evaluated at this optimum are satisfied: 
 

 
 
Note: The constraint cell values in Excel will all appear as TRUE at the optimum. 
 

45. You are prompted to paste the optimal values into the spreadsheet: 
 

 
Click Yes. This replaces the nominal input control values to the optimum values. 
 

46. Select Run Simulation. Click Run. 
 

47. The resulting simulation report confirms the predicted dramatic improvement: 
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The slight discrepancy in predicted Cpm (Optimization 7.4 versus Simulation 7.35 is due to 
the difference in number of replications for Optimization (1000) versus Simulation (10,000). 
 

48. Recall the histogram for the initial simulation run: 
 

 
 
 

49. In summary, DiscoverSim was used to dramatically improve the Spring Force performance as 
follows: 
 

a. Mean centered from 21.6 to 22.0  
b. Standard Deviation reduced from 1.24 to 0.09, more than a ten-fold reduction! 
c. Ppk increased from 0.43 to 7.34, Cpm increased from 0.51 to 7.35! 
d. Actual % Total (out of spec) reduced from 12.3% to 0%! 

 

50. The benefits do not stop here. Since the design is now so robust, we can review the input 
tolerances to see if there is a cost saving opportunity by widening the feature tolerances, and 
re-running the simulation to study the impact. 
 

51. Finally the results predicted here should be validated with physical prototypes before 
proceeding to finalize the design parameters. Remember “All models are wrong, some are 
useful” (George Box)! 
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Case Study 6 – Multiple Response Optimization and 
Practical Tolerance Design 
 
Introduction: Optimizing Low Pass RC Filter 
 
The passive low pass RC (Resistor Capacitor) filter network shown below has been analyzed in 
several papers (see Case Study 6 References) and will be used to demonstrate how DiscoverSim 
allows you to easily solve the difficult problems of multiple response optimization for parameter 
design and practical tolerance design. 
 
The design approaches presented in the reference papers and books include: Axiomatic Design 
(Suh, El-Haik), Taguchi Methods (Filippone), Analytical Design for Six Sigma (Ferryanto), and 
Integrated Parameter and Tolerance Design using Factorial Design of Experiments and Loss 
Function (Feng). 
 
Acknowledgements and thanks to Dr. Eric Maass and Andrew Sleeper for their valuable feedback 
on this case study. 
 
The RC filter network to be designed (C, R1 and R2) suppresses the high-frequency carrier signal 
and passes only the desired low-frequency displacement signal from the strain-gage transducer to 
the recorder with a galvanometer/light-beam deflection indicator (El-Haik, Feng). Light beam 
galvanometers have been replaced with digital oscilloscopes, but they still have practical 
application today in laser scanning systems. 
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Vs is the demodulated transducer voltage and Rs is the transducer resistance (impedance). Rg is the 
galvanometer terminal resistance. Vo is the galvanometer output voltage which produces the 
deflection displacement. One of the output responses of interest, galvanometer full scale 
deflection D, is a function of Vo, Rg, and the galvanometer sensitivity Gs. The values for Vs, Rs, Rg, 
and Gs are determined by the transducer and galvanometer vendors and are therefore considered 
as noise factors.  We will use the nominal and tolerance values given by Feng and Filippone for the 
noise factors: Vs = 15 mV; Rs = 120 ohms; Rg = 84 ohms; Gs = 0.56364 mA/inch. All tolerance values 
are ± 0.15%. We will model these noise factors using a normal distribution with mean set to the 
nominal value and standard deviation calculated as nominal*(tolerance/100)/3 = 
nominal*0.0015/3.  
 
Capacitor C, and resistors R1, R2 are the components of the passive filter network. These are the 
design control factors of interest in this study. The mean values for C, R1, and R2 will be varied using 
parameter design optimization to meet the required output specifications with minimal variation. 
Tolerances on these components are also noise factors that contribute to variability in the output 
but we can select those tolerance values that are required to give us the desired performance. The 
starting nominal and tolerance values will be those given in Feng and Filippone: C = 257 uF, R1 = 
1060 ohms, and R2 = 464 ohms with tolerance = 5% for each. As with the noise factors, we will 
model the control factors using a normal distribution with mean initially set to the nominal value 
and standard deviation initially set to nominal*(tolerance/100)/3 = nominal*0.05/3. 
 
The output responses of interest are full scale deflection D and filter cut-off frequency F. The 
equations (derived from Kirchhoff's Current Law) are given as: 
 

 
Note: Resistors R1 and R2 affect both output responses, and capacitor C only affects the cut-off 
frequency F. 
 
The target value for Deflection D is 3.0 inches. We will use ± 1% as the tolerance for D so the lower 
specification limit LSLD = 2.97 and upper specification limit USLD = 3.03. The target value for Filter 
Cut-Off Frequency F is 6.84 Hz. We will use ± 5% as the tolerance for F so LSLF = 6.498 and USLF = 
7.182. Process Capability indices will be used to measure the quality of each output response, but 
optimization will be performed by minimizing the multiple output metric “Weighted Sum of Mean 
Squared Error (MSE),” also known as the Taguchi loss function: 
 
MSE (Loss) = WeightD[(MeanD – TargetD)2 + StdDevD2] + WeightF[(MeanF – TargetF)2 + StdDevF2] 
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The control and noise factor settings are summarized in the table below: 
 

 
 
The minimum and maximum mean values used for parameter optimization of the control factors 
are the values from Filippone for the Taguchi Inner Array: 

 
Note that if we did not have the above nominal mean values for control factors available as starting 
values, we would use the mid-point of the minimum/maximum to start the optimization. The final 
optimization result would be the same in either case because the optimizer is global not local. 
 
We will also consider standard component availability and cost in this case study (source: electronic 
component supplier www.mouser.com – note prices are subject to change). One practical concern 
will be the capacitor. Capacitors larger than 230 uF will typically be electrolytic with a 20% 
tolerance or more, so specifying a tolerance of 5% or less will significantly increase the component 
cost. 
  

Factor
Type

Factor
Name Factor Description

DiscoverSim Input
Distributions Mean StdDev

% Tolerance
(used to calculated StdDev)

Control C Filter Capacitor (uF) 257 257 4.283333333 5
Control R1 Filter Resistor 1 (ohms) 1060 1060 17.66666667 5
Control R2 Filter Resistor 2 (ohms) 464 464 7.733333333 5
Noise Vs Transducer Voltage (mV) 15 15 0.0075 0.15
Noise Rs Transducer Resistance (ohms) 120 120 0.06 0.15
Noise Rg Galvanometer Resistance (ohms) 84 84 0.042 0.15
Noise Gs Galvanometer Sensitivity (mA/inch) 0.56364 0.56364 0.00028182 0.15

Input Distribution Parameters

Name Min Max
C_Control 231 1400
R1_Control 20 100000
R2_Control 0.01 525

Input Control Parameters (Mean)

http://www.mouser.com/
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In this study we will use DiscoverSim to help us answer the following questions: 
 

• What are the predicted process capability indices with the published nominal settings? 
 

• What are the predicted process capability indices after parameter optimization? How do 
they compare to the baseline results above? 
 

• What are the key control factors (Xs) that influence Deflection D and Frequency F? 
 

• What standard components are available that are close to the optimal values obtained from 
parameter design? 
 

• What tolerances are available for those standard components? Can we minimize the 
component cost and achieve a Six Sigma quality design? 
 

 

Summary of DiscoverSim Features Demonstrated in Case Study 6: 
• Create Input Distributions (Continuous Normal) 
• DiscoverSim Copy/Paste Cell 
• Run Simulation with Sensitivity Chart of Correlation Coefficients 
• Create Continuous Input Controls for Parameter Optimization 
• Run Optimization for Multiple Outputs 
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Multiple Response Optimization and Practical Tolerance Design of 
Low Pass RC Filter with DiscoverSim 
 

1. Open the workbook Passive RC Filter Design. DiscoverSim Input Distributions will simulate the 
variability in control and noise component tolerances. The Normal Distribution (as used in the 
reference papers) will be specified in cells E17 to E23. The mean values are specified in cells F17 
to F23. The standard deviation values are calculated in cells G17 to G23 as discussed above to 
model the component tolerances, specified in cells H17 to H23. Input Controls will be added to 
cells F17 to F19 which will vary the mean for the control factors C, R1 and R2 in optimization. 
The outputs, Deflection and Frequency, will be specified in cells E26 and E27 using the formulas 
given above. 

 

 
 

2. Click on cell E17 to specify the Input Distribution for the Capacitor C. Select DiscoverSim > Input 
Distribution: 

 

 
 

3. We will use the default Normal Distribution. 
 

4. Click input Name cell reference  and specify cell C17 containing the input name “C.” After 
specifying a cell reference, the dropdown symbol changes from  to  . 
 

5. Click the Mean parameter cell reference  and specify cell F17 containing the mean parameter 
value = 257.  
 

6. Click the StdDev parameter cell reference  and specify cell G17 containing the standard 
deviation parameter value = Mean * (Tolerance/100)/3 = (257 * .05)/3 = 4.283. 
  

7. Click Update Chart to view the normal distribution as shown: 
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8. Click OK. Hover the cursor on cell E17 to view the DiscoverSim graphical comment showing the 
distribution and parameter values: 

 

 
 

9. Click on cell E17. Click the DiscoverSim Copy Cell menu button  (Do not use Excel’s 
Copy – it will not work!).  
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10. Select cells E18:E23. Click the DiscoverSim Paste Cell menu button   (Do not use 
Excel’s Paste – it will not work!). 
 

11. Review the input comments in cells E18 to E23: 
 

Cell E18: 
 

 
 
Cell E19: 
 

 
 
Cell E20: 
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Cell E21: 
 

 
 
Cell E22: 
 

 
 
Cell E23: 
 

 
 

12. Now we will specify the outputs. Click on cell E26. Note that the cell contains the Excel formula 
for Deflection: 
 =(_Vs*_Rg*_R1)/(_Gs*((_R2+_Rg)*(_Rs+_R1)+_Rs*_R1)).  

Excel range names are used rather than cell addresses to simplify interpretation. 
 

13. Select DiscoverSim > Output Response:  
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14. Enter the output Name as “Deflection.” Enter the Lower Specification Limit (LSL) as 2.97, Target 
as 3, and Upper Specification Limit (USL) as 3.03.  Weight = 1 and Output Goal should be 
“Target.” 

 

 
 
Click OK. 
 

15. Hover the cursor on cell E26 to view the DiscoverSim Output information.  
 

 
 

16. Click on cell E27. Note that the cell contains the Excel formula for Frequency: 
=((_R2+_Rg)*(_Rs+_R1)+_Rs*_R1)/(2*PI()*(_R2+_Rg)*_R1*_Rs*_C*0.000001) 
 

17. Select DiscoverSim > Output Response:  
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18. Enter the output Name as “Frequency.” Enter the Lower Specification Limit (LSL) as 6.498, 
Target as 6.84, and Upper Specification Limit (USL) as 7.182.  Weight = 1 and Output Goal 
should be “Target.” 

 

 
 
Click OK. 
 

19. Hover the cursor on cell E27 to view the DiscoverSim Output information.  
 

 
 

20. Now we are ready to perform a simulation run. This is our baseline, after which we will run 
parameter optimization and compare results. We will also perform a Sensitivity Analysis after 
optimization. 
 

21. Select DiscoverSim > Run Simulation:  
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22. Select Seed Value and enter “12” as shown, in order to replicate the simulation results given 
below. 

 

 
 
Click Run. 
 

23. The DiscoverSim Output Report shows a histogram, descriptive statistics and process capability 
indices for each output. 
 
Deflection Report: 
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From the histogram and capability report we see that the output Deflection is not capable 
of meeting the specification requirements using the baseline values. The process mean is off 
target and the variation due to component tolerance is unacceptably large. We expect that 
81.4% of the units would fail this requirement, so we must improve the design to center the 
mean and reduce the variation of Deflection, while simultaneously satisfying the Frequency 
requirement. 
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Frequency Report: 
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From the histogram and capability report we see that the output Frequency is slightly off 
target and just capable of meeting the specification requirements using the baseline values. 
We expect that 0.66% of the units would fail this requirement, so if possible we should 
improve the design to reduce the variation of Frequency while simultaneously improving 
Deflection. 
 

24. In order to run optimization, we will need to add the Input Controls in cells F17 to F19. Select 
Sheet1.  The Input Control parameters (min/max) are shown below (from Filippone): 

 

 
 
These controls will vary the nominal mean values for C, R1 and R2. The standard deviation 
will be recalculated with each optimization iteration, so that a 5% tolerance is preserved 
(see above for formula). 
 

25. Click on cell F17. Select Control:  
 

 
 

26. Click Input Name cell reference  and specify cell J17 containing the input control name 
“C_Control.” 
 

27. Click the Min value cell reference  and specify cell K17 containing the minimum optimization 
boundary value = 231. 
 

28. Click the Max value cell reference  and specify cell L17 containing the maximum optimization 
boundary value = 1400: 
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29. Click OK. Hover the cursor on cell F17 to view the comment displaying the input control 
settings: 

 

 
 

30. Click on cell F17. Click the DiscoverSim Copy Cell menu button  (Do not use Excel’s 
Copy – it will not work!).  
 

31. Select cells F18:F19. Click the DiscoverSim Paste Cell menu button  (Do not use 
Excel’s Paste – it will not work!). 
 

32. Review the Input Control comments in cells F18 and F19. 
 

33. The completed model is shown below: 
 

 
 

34. Now we are ready to perform the optimization.  Select DiscoverSim > Run Optimization: 
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35. Select “Minimize” for Optimization Goal, “Weighted Sum” for Multiple Output Metric and 
“Mean Squared Error” for Statistic. Select MIDACO (Global). Select Seed Value and enter “12,” 
in order to replicate the optimization results given below. Set Replications to 1000 to reduce 
the optimization time. All other settings will be the defaults as shown:   

 

 
 
Mean Squared Error is also known as the Taguchi Loss Function, and is calculated as: 
 
MSE (Loss) = WeightD[(MeanD – TargetD)2 + StdDevD2] + WeightF[(MeanF – TargetF)2 + 
StdDevF2] 
 
We want both the Deflection and Frequency outputs to be on target with minimal variation. 
The weights were set when the outputs were created and are the same for each output (= 
1). 
 
We will use the MIDACO optimization method which is powerful to solve complex 
optimization problems. 
 

36. Click Run. This optimization will take approximately 1 minute. 
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37. The final optimal parameter values are given as: 
 

 
38. You are prompted to paste the optimal values into the spreadsheet: 

 

 
 
Click Yes. This replaces the nominal input control values with the new optimum values. 
Note that the displayed values for the input distributions at cells E17 to E19 are not 
overwritten, but when the simulation is run, the referenced mean and standard deviation 
given in F17 to G19 will be applied. 
 

39. Select Run Simulation. Click Report Options/Sensitivity Analysis. Check Sensitivity Charts and 
Correlation Coefficients. Select Seed Value and enter “12,” in order to replicate the simulation 
results given below. Click Run. 
 

40. The DiscoverSim Output Report shows a histogram, descriptive statistics and process capability 
indices for each output. 

 
Deflection Report (after optimization):  
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From the histogram and capability report we see that the output Deflection is still not 
capable of meeting the specification requirements after optimization, however the mean is 
now on target (mean shifted from 3.062 to 3.000). The actual empirical performance failure 
rate was reduced from 81.43% to 40.53% due to centering the mean. Since we only saw a 
slight reduction in the standard deviation (0.0364 to 0.0360), the component tolerances will 
need to be tightened. The sensitivity analysis will help us to focus on which components are 
critical and require tighter tolerances. 
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Frequency Report (after optimization): 

 

 
From the histogram and capability report we see that the output Frequency after 
optimization is now on target (mean shifted from 6.880 to 6.841) but still just capable of 
meeting the specification. The actual performance failure rate was reduced from 0.66% to 
0.33% due to centering the mean. Since we did not see a reduction in the standard 
deviation, the component tolerances will need to be tightened. As with Deflection, the 
sensitivity analysis will help us to focus on which components are critical and require tighter 
tolerances. 
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41. Click on the Sensitivity Correlations sheet to view the sensitivity charts. 
 
Deflection Sensitivity Chart: 
 

 
 
Resistor R2 is the dominant component affecting Deflection. A search at the electronic 
component supplier www.mouser.com, shows that 510 ohm resistors (¼ watt axial) with a 
5% tolerance or 1% tolerance, cost approximately $0.04 each (qty. 100 pricing); resistors 
with a 0.1% tolerance are $0.29 to $1.00 each.  Since R2 has such a strong influence on the 
variability we will use 0.1 % tolerance, even with the higher cost.  Afterward, we will 
consider using 1% tolerance for R2 as a possible cost saving measure. Even though resistor 
R1 has negligible influence (on Deflection or Frequency below), we will use a 1% tolerance 
since the price is approximately the same as that of 5% tolerance resistors (5K ohms value).  
 

42. Frequency Sensitivity Chart: 
 

 
 
Capacitor C is the dominant component affecting Frequency, followed by Resistor R2. 
Unfortunately, capacitors larger than 230 uF will typically be electrolytic with a 20% 
tolerance or more.  Specifying a tolerance of 5% or less will significantly increase the 
component cost.  Another issue is that the number of available capacitor standard values is 
very limited compared to that of resistors.  We need to reduce the variability of Frequency 

http://www.mouser.com/
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so we will specify a 2% tolerance (electrolytic > 10V axial).  The lowest cost option available 
to us in the 230 to 300 uF range is a Vishay 280 uF @2%, at $11.79 each (qty. 101).  
If this cost is unacceptable then we would need to use a 20% tolerance and relax the output 
specifications for Frequency or accept the lower process capability/higher defect rate. The 
cost for a 250uF @20% is $1.84, qty. 100. 
 

43. Now we will modify the control factor settings and rerun the optimization for practical 
tolerance design, starting with the fixed capacitor value of 280 uF @2% tolerance. 
The capacitor is selected first because of the limited selection for available capacitor standard 
values. 
  

44. Enter the value 280 in control cell F17. Click on cell H17 and change the tolerance value to 2. 
This will result in a reduced standard deviation value in cell G17 for capacitor C. 

 

 
 
Note: The original E17 cell value of 257 for input distribution C is not overwritten in the 
sheet display, but the referenced control value in F17, 280, will be used in simulation and 
further optimization. 
 

45. Click on cell H18 and change the tolerance value to 1. This will result in a reduced standard 
deviation value in cell G18 for resistor R1. 

 

 
 

46. Click on cell H19 and change the tolerance value to 0.1. This will result in a reduced standard 
deviation value in cell G19 for resistor R2.  
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47. Enter the Input Control min/max values for C in cells K17 and L17 as 280. This fixes the C value 
so that it will not vary in optimization. 
 

 
 

48. Now we are ready to perform the optimization. Select DiscoverSim > Run Optimization: 
 

49. Select “Minimize” for Optimization Goal, “Weighted Sum” for Multiple Output Metric and 
“Mean Squared Error” for Statistic. Select MIDACO (Global). Select Seed Value and enter “12,” 
in order to replicate the optimization results given below. Set Replications to 1000 to reduce 
the optimization time. All other settings will be the defaults as shown:   

 

 
 

50. Click Run. This optimization will take approximately 1 minute. 
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51. The final optimal parameter values are given as: 
 

 
 
 

52. You are prompted to paste the optimal values into the spreadsheet: 
 

 
 

Click Yes. This replaces the nominal input control values with the new optimum values. 
 

53. For R2 we will use a ¼ watt axial 432 ohm 0.1% tolerance resistor, available at a cost of 0.64 
each (qty 100). Later we will consider using a 432 ohm 1% tolerance resistor as a possible cost 
saving measure since they are only .04 each (qty 100).  
 

54. For R1, we will use a ¼ watt axial 565 ohm 1% tolerance resistor for R1, which is the closest 
available standard value to 566.8 ohms. 
 

55. Enter the value 565 in control cell F18 for R1.  The 1.0% tolerance specified in cell H18 does not 
change. Enter the value 432 in control cell F19 for R2. The 0.1% tolerance specified in cell H19 
does not change.  

 

 
56. It is not necessary to “freeze” the R1 and R2 min/max values since we are no longer running 

optimization. 
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57. Now type in the C, R1 and R2 values in the Input Distributions cells E17 to E19. Note that this is 
not required to run the simulation, but allows us to quickly check what the expected values will 
be for the outputs Deflection (at E26) and Frequency (at E27). 

 

 
 

58. Now we are ready to perform the simulation. Select Run Simulation. Click Run. 
 

59. The DiscoverSim Output Report shows a histogram, descriptive statistics and process capability 
indices for each output and confirms that the RC design has dramatically improved: 
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60. Now that we have achieved beyond Six Sigma quality for this design (Ppk > 1.5 for each output), 
we need to consider if we can relax the tolerance for R2 from 0.1% to 1%, thus reducing the 
component cost (from 0.64 each to .04 each in qty. 100).  
 

61. Click on cell H19 and change the tolerance value from 0.1 to 1, resulting in an increased 
standard deviation value in cell G19 for resistor R2: 

 

 
 

62. Now re-run the simulation. Select Run Simulation. Click Run. 
 

63. The resulting simulation report for both outputs is shown below: 
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As expected from our sensitivity analysis, we see that Ppk for Deflection has dropped from 
3.10 to 1.24, and the expected ppm failure rate has increased from 0.0 to 112.33.  (Here we 
also display the Sum of PPM report which includes the sum of ppm values for both 
Deflection and Frequency). 
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We see that Ppk for Deflection has not changed from 2.42, so increasing the tolerance for 
R2 from 0.1% to 1% does not have any effect on Deflection. 
 

64. Now that we have run both simulations, we see the trade-off between a difference in predicted 
ppm failure rate of 112 and a cost difference of 0.60 per unit, thus enabling us to make an 
informed decision of which tolerance to use for R2. 
 

65. A similar analysis can be performed in the tolerance versus cost consideration for the capacitor. 
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Case Study 7 – The Travelling Salesperson Problem (TSP) 
 
Introduction: Optimizing Travel to 30 International Cities 
 
The travelling salesperson problem (TSP) asks the following question: “Given a list of cities and the 
distances between each pair of cities, what is the shortest possible route that visits each city exactly 
once and returns to the origin city?”  The problem was first formulated in 1930 and is one of the 
most intensively studied problems in optimization. It is used as a benchmark for many optimization 
methods. The TSP has several applications such as planning, logistics, and the manufacture of 
microchips. Slightly modified, it appears as a sub-problem in many areas, such as DNA sequencing. 
In these applications, the concept city represents, for example, customers, soldering points, or DNA 
fragments, and the concept distance represents travelling times or cost, or a similarity measure 
between DNA fragments. The TSP also appears in astronomy, as astronomers observing many 
sources will want to minimize the time spent moving the telescope between the sources. In many 
applications, additional constraints such as limited resources or time windows may be imposed. 
(Ref.: https://en.wikipedia.org/wiki/Travelling_salesman_problem). 
 
The books by Applegate and Cook (see Case Study 7 References) and the University of Waterloo 
TSP web site (http://www.math.uwaterloo.ca/tsp/index.html) are excellent resources for further 
study.  
 
We will now consider a 30 City TSP problem.  The data is from city distance dataset HA30 which 
describes the airline distances, in hundreds of miles, between 30 international cities: 
https://people.sc.fsu.edu/~jburkardt/datasets/cities/cities.html.  A 30 city problem has 29!/2 = 
4.42e30 possible solutions, so obviously this is not something that can be solved using the Discrete 
Exhaustive option!  The goal is to achieve the best known solution minimum of 503 (50,300 miles), 
as given in Ouyang (2013): 
 

 
 
The 3D plots were created using Mathematica with code adapted from Dr. Ben Nolting: 
(http://datavoreconsulting.com/programming-tips/a-traveling-salesman-on-a-sphere-pitbulls-
arctic-adventure/).   
 

https://en.wikipedia.org/wiki/Travelling_salesman_problem
http://www.math.uwaterloo.ca/tsp/index.html
https://people.sc.fsu.edu/%7Ejburkardt/datasets/cities/cities.html
http://datavoreconsulting.com/programming-tips/a-traveling-salesman-on-a-sphere-pitbulls-arctic-adventure/
http://datavoreconsulting.com/programming-tips/a-traveling-salesman-on-a-sphere-pitbulls-arctic-adventure/
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In DiscoverSim Version 2.1, the Genetic Algorithm has improved handling of the 
DSIM_IsAllDifferent function, so we will use the Genetic Algorithm to solve this TSP problem.  The 
DSIM_IsAllDifferent function will be used in a constraint in order to ensure that the only solutions 
considered are unique city sequences.   
 
Since this is a deterministic optimization problem, we technically only need a single replication, but 
DiscoverSim requires a minimum of 2 replications for internal consistency on stochastic problems.  
If the model included Input Distributions to represent uncertainty (for example if we were using 
travel times rather than distance), then we would typically use 1000 replications in the 
optimization settings. 
 

Summary of DiscoverSim Features Demonstrated in Case Study 7: 
• Create Discrete Input Controls 
• DiscoverSim Copy/Paste Cell 
• Insert DSIM_IsAllDifferent function 
• Create a Constraint that references the DSIM_IsAllDifferent function 
• Run Optimization with Genetic Algorithm 
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Optimizing Travel to 30 International Cities with DiscoverSim 
 

1. Open the workbook 30 International Cities TSP.  This is a matrix showing the distance between 
cities in hundreds of airline miles. The city names are shown in column B and row 3.  
DiscoverSim Discrete Input Controls will be created in cells C36 to AE36.  The output, Total 
Distance Travelled, will be specified in cell B40.  A constraint will be added at cell B42 that 
references a DSIM_IsAllDifferent function at cell B41. Excel’s OFFSET function is used to extract 
the city names and distances for the selected Input Control values.  Row 37 shows the names of 
the tour cities in the order visited. Row 38 shows the distances between the tour cities. 
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2. Click on cell C36. Select Control:  
 

 
 

3. Click Input Name cell reference  and specify cell C35 containing the input control name “1st”. 
 

4. Select Discrete. Set Step = 1, the Min value = 1 and the Max value = 29 as shown.  There are 30 
cities but the first city is defined as Azores, so only 29 need to be solved. 
 

 
 

5. Click OK. Hover the cursor on cell C36 to view the comment displaying the input control 
settings: 
 

 
 

6. With cell C36 selected, click the DiscoverSim Copy Cell menu button  (Do not use 
Excel’s Copy – it will not work!).  
 

7. Select cells D36:AE36 (do not include the empty cell AF36). Click the DiscoverSim Paste Cell 
menu button  (Do not use Excel’s Paste – it will not work!). 
 

8. Review the Input Control comments in cells D36 to AE36. 
 

9. Now we will specify the output. Click on cell B40. Note that the cell contains the Excel formula 
for Total Distance Travelled: 
 =SUM(C38:AF38).  
 

10. Select DiscoverSim > Output Response:  
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11. Enter the output Name as “Distance.”  We will not enter any specifications. 
 

 
 
Click OK. 
 

12. Hover the cursor on cell B40 to view the DiscoverSim Output information.  
 

 
 

13. Click on cell B41 and select DiscoverSim > DSIM Function: 
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Scroll down to select DSIM_IsAllDifferent. Click OK.  
 

14. Select the Range C36:AE36. 

 
Click OK. 
 

15. The DSIM function formula is now in cell B41: 
 
=DSim_IsAllDifferent('HA30'!C36:AE36) 
 
which returns a 1 since the default input control values are all different. 
 
Note:  All Discrete Input Controls should be included in the DSIM_IsAllDifferent range. 
DiscoverSim does not support a mixture of having some Discrete Input Controls constrained by 
DSIM_IsAllDifferent and some not constrained.  (However, it is possible to have a mixture with 
Continuous Input Controls). 
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16. Now we will add a constraint that references the DSIM function.  Click on cell B42. Select 
Constraint:  

 
 

17. Enter B41 in the “Left Hand Side” (LHS) or click the LHS cell reference  and select B41. Select = 
. Enter 1 in the “Right Hand Side” (RHS). 

 
 

18. Click OK. Review cell B41: 
 

 
 

 
 

19. The completed model is shown below: 
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20. Now we are ready to perform the optimization.  Select DiscoverSim > Run Optimization: 
 

 
 

21. Select “Minimize” for Optimization Goal, “Weighted Sum” for Multiple Output Metric and 
“Mean” for Statistic. Select Genetic Algorithm. Set Replications to 2.  Select Seed Value and 
enter “1234” in order to replicate the optimization results given below.  All other settings will 
be the defaults as shown:   

 

 
 
Note: As mentioned above, since this is a deterministic problem, we technically only need a 
single replication, but DiscoverSim requires a minimum of 2 replications for internal 
consistency on stochastic problems.   

22. Click Run. This optimization will take approximately 4 minutes. To save time, when the solution 
reaches the best known value of 503, click the Interrupt button. 
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23. The final optimal parameter values are given as: 
 

 
 
As discussed in the introduction, the final solution of 503 (50,300 miles) is the best known 
solution for this 30 International City problem. 
 

24. We can see that all of the values are all different satisfying the constraint using 
DSIM_IsAllDifferent and the “Amount Violated” is 0. 
 

 
 

25. You are prompted to paste the optimal values into the spreadsheet: 
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26. Click Yes. This replaces the input control values in cells C36 to AE36.with the optimum values. 
 

27. The final city tour is given in cells B37 to AF37: 
Azores → London →Paris → Rome → Berlin → Moscow → Istanbul → Cairo → Baghdad → 
Bombay → Manila → Shanghai → Tokyo → Guam → Melbourne → Sydney → Honolulu → San 
Francisco → Seattle → Juneau → Montreal → New York → Chicago → New Orleans → Mexico 
City → Panama City → Santiago → Buenos Aires → Rio de Janeiro → Capetown → Azores 
 

28. This matches the known best tour given in Ouyang (2013): 
 

 
 

29. If one wanted to evaluate flight times with uncertainty, rather than distances, then input 
distributions could be added to create a stochastic model.   
 

30. Another example where DSIM_IsAllDifferent would be used in a constraint is Stochastic Job 
Scheduling with Due Dates 
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Case Study 8 – Optimization of Yield for 5 Factor Definitive 
Screening Design 
 
This case study is adapted from Anderson et al., “Monte Carlo Simulation Experiments for 
Engineering Optimisation.” See Case Study 8 References. A 5 Factor, Three Level, 13 Run Definitive 
Screening Design (DSD) was used to characterize the Yield of a chemical process. As noted in the 
paper, when there are only three or fewer active main effects, DSDs allow a full response surface 
model with two-factor interactions and quadratic terms to be modelled. See the SigmaXL 
Workbook for further details on Definitive Screening Designs. 
 
The goal of the experiment is to maximize the Yield, with a lower specification limit = 75. A Yield 
value below 75 is a defect.   
 
The factor names and level settings are given as: 
Pressure: 10 – 15 
Modifier: 85 – 110 
Agitation: 100 – 120 
Temperature: 385 – 420 
Time: 5 – 30 
 
The experimental runs were randomized, but presented in standard order. 
 
For Monte Carlo simulation of the significant factor inputs, a Normal Distribution was used with 
Mean initially at the nominal mid-point settings and Standard Deviation = Factor Range/5. 
 
Note that the DSD design produced in SigmaXL is not identical to the one given in the paper (as 
produced by JMP software), but the design properties are identical. As a result, the Yield values 
given in the paper are not used, but estimated by simulation.   

This is similar to Case Study 4 - Catapult Variation Reduction, where we are looking for settings that 
will minimize the transmitted variation. 

 
 

Summary of DiscoverSim Features Demonstrated in Case Study 8: 
• Create and Analyze a Definitive Screening Design in SigmaXL 
• Convert SigmaXL Regression/DOE Model 
• Create Continuous Input Distributions and Controls 
• Add Model Error Term 
• Run Simulation at Nominal Settings 
• Optimization/Simulation: Maximize the Mean Yield 
• Optimization/Simulation: Maximize PpL to Minimize Defects  
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1. We will begin with the creation of the 5 Continuous Factor DSD in SigmaXL.  Click SigmaXL > 
Design of Experiments > Advanced Design of Experiments: Definitive Screening > Definitive 
Screening Designs. Select Number of Continuous Factors = 5, uncheck Randomize Runs and 
Fraction of Design Space (FDS) Plots.  Enter the Factor Names and Level Settings and Response 
Name as shown. 

 
 

2. Click OK. The Definitive Screening Design Worksheet is given as: 
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3. Open the file Chemical Process Yield Anderson Five Factor DSD.xlsx. This has the design 
worksheet populated with Yield values. 

 

4. Click SigmaXL > Design of Experiments > Advanced Design of Experiments: Definitive 
Screening > Analyze Definitive Screening Design. 

5. Select Response and Model Terms as shown with Term Generator as ME + 2-Way Interactions + 
Quadratic. Click Select All >>. Check Residual Plots.  Uncheck Main Effects Plots.  
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6. There are more terms in the model than runs in the design so we will use Stepwise Forward 
Selection. Click Advanced Options.  Check Stepwise/Best Subsets Regression, select Forward 
Selection, with Criterion AICc. 

 

Alternatively, Best Subsets can be used for a more thorough evaluation of possible models, but 
we will not do so here. See the SigmaXL Workbook for more information on Advanced Options 
for Regression models. 

7. Click OK. Click OK. 

 

The final model from Stepwise Forward Selection matches the one given in the paper.  R-
Square, R-Square Adjusted and R-Square Predicted are all excellent.  All terms are significant, 
VIF scores are close to 1 and the Residuals (Sheet DSD – Residuals Yield) look good with no 
obvious non-normality, outliers or patterns. 
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8. The Predicted Response Calculator is given as: 

 

9. Click on Cell L26 to view the Excel formula which uses Range Names for the Factor Settings: 

=  (75.1063829787234) + (3.76400000000001)*((_Modifier_-97.5)/12.5) + 
(4.21300000000001)*((_Temperature_-402.5)/17.5) + (5.23300000000001)*((_Time_-
17.5)/12.5) + (-4.82042553191488)*((_Modifier_-97.5)/12.5)*((_Temperature_-402.5)/17.5) + 
(-4.40329787234043)*((_Time_-17.5)/12.5)*((_Time_-17.5)/12.5) 

10. Now we will make a copy of this model in a new workbook for further analysis in DiscoverSim.  
Click on Sheet DSD – Model Yield. Click DiscoverSim > Help > Convert SigmaXL 
Regression/DOE Model. 

 

This conversion is necessary because the Predicted Response Calculator in the SigmaXL model 
uses Range Names that are scoped to the Sheet, but DiscoverSim requires Range Names that 
are scoped to the Workbook. 

11. Click OK. Rename the file (File > Save As) to Chemical Process Yield Anderson DSIM.xlsx.  

 

Click Save to keep the VBA script which computes the SE/CI/PI in the Predicted Response 
Calculator and the Optimize & Contour/Surface Plot button code.  Note that these will not be 
used by DiscoverSim, so can also be erased if desired.  
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12. First, we will add DiscoverSim Controls. Click on cell I26. Select Control:  
 

 
 

13. For Name enter Modifier_Control. Select Continuous. For Start enter the mid-point value = 
97.5. Set the Min value = 85 and the Max value = 110 as shown.   
 

 
 

14. Click OK. Hover the cursor on cell I26 to view the comment displaying the input control settings: 
 

 
 

15. Repeat steps 12-14 at cell I27 and I28 to create controls for Temperature and Time. 
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16. Next, we will create the Input Distributions.  Click on cell K26 to specify the Input Distribution 
for Modifier. Select DiscoverSim > Input Distribution: 

 
 

17. We will use the default Normal Distribution. For Name, enter Modifier. 

18. Click the Mean parameter cell reference  and specify cell I26, the Modifier_Control with the 
Nominal Start Value = 97.5. 

19. Enter StdDev = 5. As noted earlier, the Monte Carlo simulation standard deviation used in the 
paper is: (High – Low)/5. 

20. Click Update Chart to view the Normal Distribution as shown: 



DiscoverSim Case Studies 

208 

 
 

21. Click OK. Hover the cursor on cell K26 to view the DiscoverSim graphical comment showing the 
distribution and parameter values: 
 

 
 

22. Repeat Steps 16 – 21 at cells K27 and K28 to create Input Distributions for Temperature and 
Time: 
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23. Repeat Steps 16 – 21 at cell K29 to create an Input Distribution for Model Error. In this case, set 
Mean = 0 and StdDev references cell C22, the Model S (Root Mean Square Error): 
 

 

 
 

24. Next, we will add the Model Error to the Predicted Response formula. Click on cell L26. In the 
Formula Bar add +K29 as shown. 
=  (75.1063829787234) + (3.76400000000001)*((_Modifier_-97.5)/12.5) + 
(4.21300000000001)*((_Temperature_-402.5)/17.5) + (5.23300000000001)*((_Time_-
17.5)/12.5) + (-4.82042553191488)*((_Modifier_-97.5)/12.5)*((_Temperature_-402.5)/17.5) + 
(-4.40329787234043)*((_Time_-17.5)/12.5)*((_Time_-17.5)/12.5)+K29 
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25. Now we will specify the predicted response formula as the output. With the cursor on cell L26, 
select DiscoverSim > Output Response:  

 

 
 

26. Enter the output Name as “Yield” and the LSL = 75.  Set Output Goal to Maximize. 
 

 
 
Note that setting Output Goal to Maximize is for information purposes and is not strictly 
necessary as it would only be used in a Multiple Response Optimization. 
 

27. Click OK. 
 

28. Hover the cursor on cell L26 to view the DiscoverSim Output information.  
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29. Save the file. The completed model can optionally be labelled and formatted as shown: 

 
 

30. We are now ready to perform a simulation run. This is our baseline, after which we will run an 
optimization to maximize the Yield and compare the results. 

 

31. Select DiscoverSim > Run Simulation:  
 

 
 

32. Select Seed Value and enter “12” as shown, in order to replicate the simulation results given 
below. 

 

 
 

33. Click Run. 
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34. The DiscoverSim Output Report shows a Histogram, Descriptive Statistics, Normality Tests, 
Process Capability and Performance Indices: 

 

 
 
 

35. From the histogram and capability report we see that the output Yield is not capable of meeting 
the specification requirements using the baseline values. Since the response data is not normal, 
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we will use the Actual Performance (Empirical) for evaluation.  The % < LSL = 50.7, which is 
unacceptable. 
 

36. Now we will optimize the process by maximizing the Mean Yield. Select DiscoverSim > Run 
Optimization: 

 

 
 

37. Select “Maximize” for Optimization Goal, “Weighted Sum” for Multiple Output Metric and 
“Mean” for Statistic. Select Hybrid.  Select Seed Value and enter “12” in order to replicate the 
optimization results given below.  All other settings will be the defaults as shown:   

 

 
 
 

38. Click Run. This optimization will take approximately 2 minutes. To save time, you may wish to 
click the Interrupt button after a few seconds. 
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39. The final optimal parameter values are given as: 

 
 

40. Click Yes to paste the optimal control values into model cells I26 to I28. 
 

41. Select DiscoverSim > Run Simulation:  
 

 
 

42. Select Seed Value and enter “12” as shown, in order to replicate the simulation results given 
below. 
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43. Click Run. 
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44. The DiscoverSim Output Report shows a Histogram, Descriptive Statistics, Normality Tests, 
Process Capability and Performance Indices: 
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45. From the histogram and capability report, we see that the output Yield Mean has improved 
from 74.4 to 81.3.  Since the response data is not normal, we will use the Actual Performance 
(Empirical) for evaluation. The % < LSL has been dramatically reduced from 50.68 to 5.03.   
 

46. Now we will further optimize the process by maximizing the Process Capability Index PpL. Select 
DiscoverSim > Run Optimization: 

 

 
 

47. Select “Maximize” for Optimization Goal, “Weighted Sum” for Multiple Output Metric and 
“PpL” for Statistic. Select Hybrid.  Select Seed Value and enter “12” in order to replicate the 
optimization results given below.  All other settings will be the defaults as shown:   

 

 
 
 

48. Click Run. This optimization will take approximately 2-3 minutes. To save time, you may wish to 
click the Interrupt button after a few seconds. 
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49. The final optimal parameter values are given as: 

 
 

50. Click Yes to paste the optimal control values into model cells I26 to I28. 
 

51. Select DiscoverSim > Run Simulation:  
 

 
 

52. Select Seed Value and enter “12” as shown, in order to replicate the simulation results given 
below. 
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53. Click Run. 
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54. The DiscoverSim Output Report shows a Histogram, Descriptive Statistics, Normality Tests, 
Process Capability and Performance Indices: 
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55. From the histogram and capability report we see that the output Yield Mean has decreased 

slightly from 81.3 to 79.2, but the StDev has been dramatically reduced from 3.85 to 1.28, and 
the objective function process capability index PpL has increased from 0.54 to 1.1. The Actual 
Performance (Empirical) % < LSL has been further reduced from 5.03 to 1.05.   
 

56. These results are similar to those reported in the paper.  DiscoverSim was able to find the 
settings that minimize the transmitted variation, making the process robust and reduce the 
defect rate. 
 

Case Study 8 Reference 
 
Anderson, R., Wei, Z., Cox, I., Moore, M., Kussener, F. (2015). “Monte Carlo Simulation Experiments 
for Engineering Optimisation,” Studies in Engineering and Technology, Vol. 2, No. 1, Redfame 
Publishing, https://redfame.com/journal/index.php/set/article/view/901. 
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Statistical Details for Distributions and Optimization 
Methods 
 
DiscoverSim™ Engine and Excel Formula Interpreter 
 
DiscoverSim uses Excel for the user interface but random number generation, distribution fitting 
parameter estimation, accelerated simulation and optimization are performed using the Gauss 
Mathematical and Statistical Engine by Aptech (www.aptech.com).  GAUSS is a fast matrix 
programming language widely used by econometricians and financial analysts since 1984.  
Communication between Excel and the GAUSS Engine is performed with Mercury by Econotron 
Software (www.econotron.com).  Econotron Software has developed interprocess communication 
tools for a number of applications based on the Gauss Engine. 
 
Accelerated mode simulation and optimization use DiscoverSim’s Excel Formula Interpreter.  This is 
based on a Common Object Interface (COI) by Econotron Software to implement an Excel 
spreadsheet in GAUSS with speed increases up to 40 times. 
 
The interpreter supports the majority of all Excel numerical functions including those in the 
Analysis Toolpak, but currently does not support the following: 

• Excel 2007 CUBE functions 
• Excel 2010 AGGREGATE, NETWORKDAYS.INTL, WORKDAYS.INTL 
• Excel 2013 ARABIC, ENCODEURL, FILTERXML, FORMULATEXT, IFNA, ISFORMULA, SHEET, 

SHEETS, UNICHAR, UNICODE, WEBSERVICE 
• Excel 2016 FORECAST 
• CONVERT, GETPIVOTDATA, HYPERLINK 
• ISTEXT, ISNONTEXT, ISLOGICAL, ISREF 
• PowerPivot Data Analysis Expressions (DAX) Functions such as ISO.CEILING 
• LET, Dynamic Arrays 
• LAMBDA 
• Third party vba functions 

 
Functions supported but with limitations: 

• Excel functions that return an array or non-single value (e.g. LINEST, LOGEST, MINVERSE, 
MDETERM, MMULT, MUNIT, STANDARDIZE, TRANSPOSE and TREND) are limited to 
intermediate calculations. The final output result must be a scalar. 

• Excel functions that return a string value are limited to intermediate calculations. The final 
result must be a scalar. 
 

If the DiscoverSim interpreter sees a function that it does not support, you will be prompted to use 
Excel’s Native mode, where the transfer function, Y = f(X), calculations are performed in Excel.  
Note that in this native mode, DiscoverSim’s random input distributions are still generated with 
GAUSS.  
 

http://www.aptech.com/
http://www.econotron.com/


DiscoverSim: Appendix 

228 

The Excel Formula Interpreter can be validated using Accelerated Mode - Run Validation using 
Native Excel. This runs a validation test to compare Accelerated Mode versus Native Excel. Each 
output is assessed by comparing the simulation means. If the worst case relative difference is less 
than or equal to 1e-10%, the test passes and the status is “Success.” If the relative difference is 
between 1e-10% to 1e-4%, the status is “Good,” and if greater than or equal to 1e-4%, the test 
status is “Poor.” 
 
DiscoverSim can quickly perform millions of simulation replications, but is limited by system 
memory. If the user chooses to store the simulation data in Excel, then Excel’s row and column 
limitations will also apply (1,048,576 rows and 16,384 columns).  For large simulation and/or 
optimization models, 64 bit Excel is highly recommended. 
 
Input Distribution Random Number Generation 
 
A random number generator (RNG) is required when using Monte Carlo simulations in order to 
draw random samples from the specified distribution. On a computer, the creation of a random 
number involves an algorithm that can automatically create long runs of numbers with good 
random properties. These algorithms are called pseudo-random number generators. The state of 
the RNG after each iteration is used as an input for the generation of the next random number. The 
initial state is called a seed; this seed can be derived using the system clock, or it can be specified 
by the user. In the latter case, the same sequence of numbers will be created each time the same 
seed is specified, which can be useful, for example, in a classroom setting where you want all 
students to obtain the same results. Stochastic optimization requires a fixed seed in order to avoid 
“chatter” that would result in inconsistent comparisons.  
 
A good RNG will produce a long run of numbers which are independent, so that there is no 
correlation between successive numbers. Eventually, the sequence of numbers will repeat, since 
eventually the seed will repeat. The RNG used in DiscoverSim is based on a recur-with-carry 
“KISS+Monster” random number generator developed by George Marsaglia. This algorithm 
produces random integers between 0 and 232 – 1 and has a period of 108859. This implementation of 
the KISS+Monster algorithm has been tested and passes all of the Diehard tests (Marsaglia, 2003). 
 
 
Marsaglia, G. (2003). “Random Number Generators,” Journal Of Modern Applied Statistical 
Methods, Vol 2(1), pp. 2-13. 
 
 
  



DiscoverSim: Appendix 

229 

Input Distribution Correlations 
 
If input distribution correlations are specified, DiscoverSim utilizes correlation copulas to achieve 
the desired Spearman Rank correlation values.  
 
Copulas are functions that describe dependencies among variables, and provide a way to create 
distributions to model correlated multivariate data. Using a copula a data analyst can construct a 
multivariate distribution by specifying marginal univariate distributions, and choosing a particular 
copula to provide a correlation structure between variables. There are a number of different 
families of copulas; in this context we use a Gaussian copula. 
 
To take the simplest example, we would first generate pairs of values from a bivariate normal 
distribution - this is easily done by multiplying two independent normal draws using the Cholesky 
matrix. The copula is then generated simply by taking the CDF of each of the vectors of the 
bivariate draw, so that each is uniformly distributed U(0,1). Finally, applying the inverse CDF of any 
distribution, e.g., F, to a U(0,1) random variable results in a random variate whose distribution is 
exactly F, with the specified correlation structure. This is known as the Inverse method. For further 
details, see http://en.wikipedia.org/wiki/Copula_(statistics). 
 
  

http://en.wikipedia.org/wiki/Copula_(statistics)
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The following surface plots illustrate how a correlation copula changes the shape of a bivariate 
distribution (these plots were created using Excel’s 3D Surface Plot): 
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Input Distribution Sampling 
 
DiscoverSim supports two sampling methodologies: Monte Carlo and Latin Hypercube. 
 
Monte Carlo Sampling (MCS) involves the repeated drawing of random vectors from randomly 
distributed variates with the specified distribution. New sample points are generated without 
taking into account the previously generated sample points. When a correlation is specified 
between the draws, the sampling occurs from the individual copulas. 
 
Latin hypercube sampling (LHS) uses a technique known as “stratified sampling without 
replacement.” The probability distribution is split into 𝑛𝑛 intervals of equal probability, where 𝑛𝑛 is 
the number of samples that are to be performed on the model. For a simulation with 𝑘𝑘 variates, 
the hypercube will contain 𝑛𝑛 rows with 𝑘𝑘 columns. As the simulation progresses each of the 𝑛𝑛 
intervals in each of the 𝑘𝑘 columns is sampled once. Once the sample is generated, the uniform 
sample from a column can be transformed to any distribution by using the quantile functions. 
Different columns can have different distributions.  For further details, see: 
http://en.wikipedia.org/wiki/Latin_hypercube_sampling. 
 
When an identity matrix is specified for the correlation matrix, the basic LHS process is adjusted 
such that the sampling from each column is nearly orthogonal. This requires that all the random 
samples over the 𝑘𝑘 variates be generated simultaneously. A similar situation arises when 
correlation is specified between the sampled variates. 
 
Unlike simple random sampling, this method ensures a full coverage of the range of each variable 
by maximally stratifying each marginal distribution. Thus LHS has the advantage of generating a set 
of samples that more precisely reflect the shape of a sampled distribution than pure random MCS 
and therefore can perform well with fewer replications (n = 1000 is recommended). 
 
  

http://en.wikipedia.org/wiki/Latin_hypercube_sampling
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The following Histograms and Descriptive Statistics illustrate MCS and LHS for a normal distribution 
N(0,1) with n = 1000: 
 

 
 
Note the smoother shape for LHS as well as the very low Anderson Darling A Squared value. 
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Input Distribution Truncation 
 
A truncated distribution is a conditional distribution derived by restricting the domain of the 
original distribution. Consider a distribution, 𝑓𝑓(𝑥𝑥), and we wish to know what is the distribution of 
𝑥𝑥 if 𝑥𝑥 is to be restricted to the domain 𝑎𝑎 < 𝑥𝑥 ≤ 𝑏𝑏. The truncated distribution is then defined as: 
 

𝑓𝑓(𝑥𝑥|𝑎𝑎 < 𝑥𝑥 ≤ 𝑏𝑏) =
𝑔𝑔(𝑥𝑥)

𝐹𝐹(𝑏𝑏) − 𝐹𝐹(𝑎𝑎)
 

 
where 𝐹𝐹(𝑥𝑥) is the CDF of 𝑓𝑓(𝑥𝑥), and 𝑔𝑔(𝑥𝑥) = 𝑓𝑓(𝑥𝑥) for 𝑎𝑎 < 𝑥𝑥 ≤ 𝑏𝑏, and zero everywhere else. 
 
The following histogram illustrates a truncated normal distribution (Mean = 0, StdDev = 1) with 
Minimum = -2 and Maximum = 2. 
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Table of DSIM Functions 
 

DSIM Function  
(all arguments are 

required) 

Description Formula 

DSim_Cpm 
(variable, LSL, USL, 
tgt) 
 
 

Returns the Cpm 
process capability index 
of a DiscoverSim 
variable.  This is also 
known as the Taguchi 
Capability Index and 
includes a penalty for 
deviation from target. 
Requires lower spec. 
limit (LSL), upper spec. 
limit (USL) and target. 
 

 

𝐶𝐶𝑝𝑝𝑝𝑝 =
𝑚𝑚𝑚𝑚𝑚𝑚(𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑇𝑇,𝑇𝑇 − 𝐿𝐿𝐿𝐿𝐿𝐿)

3�𝑠𝑠2 + (𝑥̄𝑥 − 𝑇𝑇)2
 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑇𝑇 is the target value. 
𝑠𝑠 is the overall (long-term) sample 
standard deviation.  
 

DSim_DPM_Actual 
(variable, LSL, USL) 
 
 

Returns the Actual 
DPM (Defects per 
Million) of a 
DiscoverSim variable 
(also known as Actual 
PPM - Parts per 
Million). It is based on 
an empirical count of 
defects. A defect is an 
observation with a 
value that is less than 
the lower spec. limit 
(LSL) or greater than 
the upper spec. limit 
(USL). 
 

𝐷𝐷𝐷𝐷𝐷𝐷 =
106

𝑛𝑛
��(𝑥𝑥𝑖𝑖 < 𝐿𝐿𝐿𝐿𝐿𝐿)
𝑛𝑛

𝑖𝑖=1

+ �(𝑥𝑥𝑖𝑖 > 𝑈𝑈𝑈𝑈𝑈𝑈)
𝑛𝑛

𝑖𝑖=1

� 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥𝑥𝑖𝑖  is the 𝑖𝑖th observation in the sample. 
𝑛𝑛 is the number of observations in the 
sample.  
 

DSim_DPM_Calc 
(variable, LSL, USL) 
 

Returns the Calculated 
DPM (Defects per 
Million) of a 
DiscoverSim variable 
(also known as 
Expected PPM - Parts 
per Million).  It is based 
on the sample mean, 
standard deviation, 
lower specification limit 
(LSL), upper 

𝐷𝐷𝐷𝐷𝐷𝐷 = 106 �(1 − 𝛷𝛷(
𝑥̄𝑥 − 𝐿𝐿𝐿𝐿𝐿𝐿

𝑠𝑠
)) + (1 −𝛷𝛷(

𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑥̄𝑥
𝑠𝑠

))� 
where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the sample standard deviation. 
𝛷𝛷 is the cdf of the standard normal 
distribution. 
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DSIM Function  
(all arguments are 

required) 

Description Formula 

specification limit (USL) 
and assumes a normal 
distribution. 
 

DSim_DPML_Actual 
(variable, LSL) 
 

Returns the Actual 
DPML (Defects per 
Million - Lower) of a 
DiscoverSim variable. It 
is based on an 
empirical count of 
defects. A defect is an 
observation with a 
value that is less than 
the lower spec. limit 
(LSL). 
 

𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 =
106

𝑛𝑛
��(𝑥𝑥𝑖𝑖 < 𝐿𝐿𝐿𝐿𝐿𝐿)
𝑛𝑛

𝑖𝑖=1

� 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥𝑥𝑖𝑖  is the 𝑖𝑖th observation in the sample. 
𝑛𝑛 is the number of observations in the 
sample.  
 

DSim_DPML_Calc 
(variable, LSL) 
 

Returns the Calculated 
DPML (Defects per 
Million - Lower) of a 
DiscoverSim variable.  It 
is based on the sample 
mean, standard 
deviation, lower 
specification limit (LSL) 
and assumes a normal 
distribution. 
 

𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 = 106 �(1 − 𝛷𝛷(
𝑥̄𝑥 − 𝐿𝐿𝐿𝐿𝐿𝐿

𝑠𝑠
))� 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the sample standard deviation. 
𝛷𝛷 is the cdf of the standard normal 
distribution. 
 

DSim_DPMU_Actual 
(variable, USL) 
 

Returns the Actual 
DPMU (Defects per 
Million - Upper) of a 
DiscoverSim variable. It 
is based on an 
empirical count of 
defects. A defect is an 
observation with a 
value that is greater 
than the upper spec. 
limit (USL). 
 

𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 =
106

𝑛𝑛
��(𝑥𝑥𝑖𝑖 > 𝑈𝑈𝑈𝑈𝑈𝑈)
𝑛𝑛

𝑖𝑖=1

� 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥𝑥𝑖𝑖  is the 𝑖𝑖th observation in the sample. 
𝑛𝑛 is the number of observations in the 
sample.  
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DSIM Function  
(all arguments are 

required) 

Description Formula 

DSim_DPMU_Calc 
(variable, USL) 
 
 
 

Returns the Calculated 
DPMU (Defects per 
Million - Upper) of a 
DiscoverSim variable.  It 
is based on the sample 
mean, standard 
deviation, upper 
specification limit (USL) 
and assumes a normal 
distribution. 
 

𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 = 106 �(1 − 𝛷𝛷(
𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑥̄𝑥

𝑠𝑠
))� 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the sample standard deviation. 
𝛷𝛷 is the cdf of the standard normal 
distribution. 
 

DSim_IQR (variable) Returns the 
interquartile range (Q3 
- Q1) of a DiscoverSim 
variable. 
 

 
𝐼𝐼𝐼𝐼𝐼𝐼 = 𝑄𝑄3 − 𝑄𝑄1 

where:  

Q1 is the first quartile. 
Q3 is the third quartile.  

  
DSim_IsAllDifferent 
(rng) 

Returns unity if all 
elements of a range are 
different. 

 

DSim_IsAllSame Returns unity if all 
elements of a range are 
identical. 

 

DSim_Kurt(variable) Returns the kurtosis 
(g2) of a DiscoverSim 
variable. Kurtosis is a 
measure of the 
peakedness of the data 
set. A normal 
distribution has a 
kurtosis of zero. 

𝑔𝑔2 =
1
𝑛𝑛∑ (𝑥𝑥𝑖𝑖 − 𝑥𝑥)4𝑛𝑛

𝑖𝑖=1

�1
𝑛𝑛∑ (𝑥𝑥𝑖𝑖 − 𝑥𝑥)2𝑛𝑛

𝑖𝑖=1 �
2 − 3 

where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the sample. 
𝑥̄𝑥 is the sample mean.  
 

DSim_Max(variable) Returns the maximum 
value of a DiscoverSim 
variable. 

𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 = 𝑥𝑥𝑛𝑛 
where:  

𝑥𝑥𝑛𝑛 is the 𝑛𝑛th element in the ordered 
sample. 
𝑛𝑛 is the number of observations in the 
sample.  
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DSIM Function  
(all arguments are 

required) 

Description Formula 

DSim_Mean(variable) Returns the mean value 
of a DiscoverSim 
variable. 

𝑥̄𝑥 =
1
𝑛𝑛
�𝑥𝑥𝑖𝑖

𝑛𝑛

𝑖𝑖=1

 

 
where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the sample. 
𝑛𝑛 is the number of observations in the 
sample.  
 

DSim_Median 
(variable) 

Returns the median of 
a DiscoverSim variable.  
The median is the 
second quartile, or 50th 
percentile - the point 
that divides the 
ordered data into two 
equal groups. 

𝑃𝑃𝑃𝑃[𝑥𝑥𝑖𝑖 < 𝑥𝑥�] ≤ 0.5 
where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the ordered 
sample.  

If the number of observations in a data set is odd, 
the median is the value in the middle. If the 
number of observations in a data set is even, the 
median is the average of the values of the two 
middle terms.  

 
DSim_Min(variable) Returns the minimum 

value of a DiscoverSim 
variable. 

𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 = 𝑥𝑥1 
where:  

𝑥𝑥1 is the 1st element in the ordered 
sample. 

DSim_MSE 
(variable, tgt) 

Returns the mean 
squared error of a 
DiscoverSim variable. It 
is the expected value of 
the quadratic loss (also 
known as the Taguchi 
Loss Function) and 
incorporates both the 
variance of the 
estimator and its bias. 
Requires a target. 

𝑚𝑚𝑚𝑚𝑚𝑚 = (𝑥̄𝑥 − 𝑇𝑇)2 + 𝑠𝑠2 
where:  

 𝑥̄𝑥 is the sample mean. 
𝑇𝑇 is the specified target. 
𝑠𝑠2 is the sample variance.  
 

DSim_Pcntile 
(variable,k_prob) 

Returns the specified 
percentile of a 
DiscoverSim variable. 
k_prob is the percentile 
probability (0 < k_prob 
< 1), so a value of 0.95 
is the 95th percentile. 
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DSIM Function  
(all arguments are 

required) 

Description Formula 

DSim_Pp 
(variable,LSL,USL) 

Returns the Pp process 
capability index of a 
DiscoverSim variable. It 
assumes a normal 
distribution. 

𝑃𝑃𝑝𝑝 =
𝑈𝑈𝑈𝑈𝑈𝑈 − 𝐿𝐿𝐿𝐿𝐿𝐿

6𝑠𝑠
 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑠𝑠 is the overall (long-term) sample 
standard deviation.  

Note that 𝐶𝐶𝑝𝑝, which uses the within-subgroup 
(short term) standard deviation, as applied in Six 
Sigma and Statistical Process Control, is not 
included in DiscoverSim.  A typical Monte Carlo 
simulation run will use a stable mean and 
standard deviation, so there would be no 
statistically significant difference between 𝐶𝐶𝑝𝑝 and 
𝑃𝑃𝑝𝑝 or short-term versus long-term standard 
deviation. This note also applies to Ppu, Ppl, Ppk, 
and Cpm. 

 
DSim_Pp_Pcntile 
(variable,LSL,USL) 

Returns the Percentile 
Pp process capability 
index of a DiscoverSim 
variable. This index 
uses the 99.865 and 
0.135 percentiles, so is 
useful when the data 
are not normally 
distributed. 

%𝑃𝑃𝑝𝑝 =
𝑈𝑈𝑈𝑈𝑈𝑈 − 𝐿𝐿𝐿𝐿𝐿𝐿

𝑥𝑥0.99865 − 𝑥𝑥.00135
 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥𝑥𝑞𝑞 = is the 𝑞𝑞th percentile of 𝑥𝑥. 
 

DSim_Ppk 
(variable,LSL,USL) 

Returns the Ppk 
process capability index 
of a DiscoverSim 
variable. It assumes a 
normal distribution. 

𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑚𝑚𝑚𝑚𝑚𝑚(𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑥̄𝑥, 𝑥̄𝑥 − 𝐿𝐿𝐿𝐿𝐿𝐿)

3𝑠𝑠
 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the overall (long-term) sample 
standard deviation. 

 
DSim_Ppk_Pcntile 
(variable,LSL,USL) 

Returns the Percentile 
Ppk process capability 
index of a DiscoverSim 
variable. This index 

%𝑃𝑃𝑝𝑝𝑝𝑝 = 𝑚𝑚𝑚𝑚𝑚𝑚�%𝑃𝑃𝑝𝑝𝑝𝑝, %𝑃𝑃𝑝𝑝𝑝𝑝� 

%𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑥𝑥�
𝑥𝑥.99865 − 𝑥𝑥�
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DSIM Function  
(all arguments are 

required) 

Description Formula 

uses percentiles, so is 
useful when the data 
are not normally 
distributed. 

%𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑥𝑥� − 𝐿𝐿𝐿𝐿𝐿𝐿
𝑥𝑥� − 𝑥𝑥.00135

 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥𝑥� is the sample median. 
𝑥𝑥𝑞𝑞 = is the 𝑞𝑞th percentile of 𝑥𝑥. 

DSim_Ppl 
(variable,LSL) 

Returns the Ppl (lower) 
process capability index 
of a DiscoverSim 
variable. It assumes a 
normal distribution. 

𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑥̄𝑥 − 𝐿𝐿𝐿𝐿𝐿𝐿

3𝑠𝑠
 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the overall (long-term) sample 
standard deviation. 

 
DSim_Ppl_Pcntile 
(variable,LSL) 

Returns the Percentile 
Ppl (lower) process 
capability index of a 
DiscoverSim variable. 
This index uses the 
0.135 percentile and 
median, so is useful 
when the data are not 
normally distributed. 

%𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑥𝑥� − 𝐿𝐿𝐿𝐿𝐿𝐿
𝑥𝑥� − 𝑥𝑥.00135

 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥𝑥� is the sample median. 
𝑥𝑥𝑞𝑞 = is the 𝑞𝑞th percentile of 𝑥𝑥. 

 

DSim_Ppu 
(variable,USL) 

Returns the Ppu 
(upper) process 
capability index of a 
DiscoverSim variable. It 
assumes a normal 
distribution. 

𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑥̄𝑥

3𝑠𝑠
 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the overall (long-term) sample 
standard deviation. 

DSim_Ppu_Pcntile 
(variable,USL) 

Returns the Percentile 
Ppu (upper) process 
capability index of a 
DiscoverSim variable. 
This index uses the 
99.865 percentile and 
median, so is useful 

%𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑥𝑥�
𝑥𝑥.99865 − 𝑥𝑥�

 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈is the upper specification limit. 
𝑥𝑥� is the sample median. 
𝑥𝑥𝑞𝑞 = is the 𝑞𝑞th percentile of 𝑥𝑥.  
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DSIM Function  
(all arguments are 

required) 

Description Formula 

when the data are not 
normally distributed. 

DSim_Q1(variable) Returns the first 
quartile (25th 
percentile) of a 
DiscoverSim variable. 
This is the point that 
marks the first 
boundary when the 
ordered data is divided 
into four equal groups. 

𝑃𝑃𝑃𝑃[𝑥𝑥𝑖𝑖 < 𝑄𝑄1] ≤ 0.25 
where:  

 is the 𝑖𝑖th element in the ordered 
sample.  

If 𝑘𝑘 = (𝑛𝑛 + 1)/4 is an integer, the first quartile is 
taken as the 𝑥𝑥𝑘𝑘 element of the ordered 
observations; otherwise the first quartile is taken 
as the sum of the 𝑥𝑥𝑘𝑘 element and the fractional 
component applied to 𝑥𝑥𝑘𝑘+1 − 𝑥𝑥𝑘𝑘. 

DSim_Q3(variable) Returns the third 
quartile (75th 
percentile) of a 
DiscoverSim variable. 
This is the point that 
marks the third 
boundary when the 
ordered data is divided 
into four equal groups. 

𝑃𝑃𝑃𝑃[𝑥𝑥𝑖𝑖 < 𝑄𝑄3] ≤ 0.75 
where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the ordered 
sample.  

If 𝑘𝑘 = 3(𝑛𝑛 + 1)/4is an integer, the third quartile 
is taken as the 𝑥𝑥𝑘𝑘 element of the ordered 
observations; otherwise the third quartile is taken 
as the sum of the 𝑥𝑥𝑘𝑘 element and the fractional 
component applied to 𝑥𝑥𝑘𝑘+1 − 𝑥𝑥𝑘𝑘. 

DSim_Range 
(variable) 

Returns the range 
(maximum – minimum) 
of a DiscoverSim 
variable. 

𝑅𝑅𝑥𝑥 = 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 − 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 
where:  

𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 is the 1st element in the ordered 
sample. 
𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚  is the 𝑛𝑛th element in the ordered 
sample. 
n is the number of observations in the 
sample.  

DSim_Skew(variable) Returns the skewness 
(g1) of a DiscoverSim 
variable. This is a 
measure of the 
asymmetry of the data 
set. A negative value 
implies a long tail to 
the left of the mean, 
while a positive value 
implies a long tail to 
the right of the mean. A 

𝑔𝑔1 =
1
𝑛𝑛∑ (𝑥𝑥𝑖𝑖 − 𝑥𝑥)3𝑛𝑛

𝑖𝑖=1

�1
𝑛𝑛∑ (𝑥𝑥𝑖𝑖 − 𝑥𝑥)2𝑛𝑛

𝑖𝑖=1 �
3/2 

where:  

 𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the sample. 
𝑥̄𝑥 is the sample mean.  
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DSIM Function  
(all arguments are 

required) 

Description Formula 

normal distribution has 
a skew of zero. 

DSim_Span(variable) Returns the span (0.95 
– 0.05) of a 
DiscoverSim variable. 
This is less sensitive to 
outliers than the range. 

𝑆𝑆𝑥𝑥 = 𝑥𝑥.95 − 𝑥𝑥.05 
where:  

𝑥𝑥𝑞𝑞 = is the 𝑞𝑞th percentile of 𝑥𝑥. 

DSim_Stdev(variable) Returns the sample 
standard deviation of a 
DiscoverSim variable. 

𝑠𝑠 = �∑ (𝑥𝑥𝑖𝑖−𝑥𝑥)2𝑛𝑛
𝑖𝑖=1
𝑛𝑛−1

  

where:  

 𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the sample. 
𝑥̄𝑥 is the sample mean. 
𝑛𝑛is the number of observations in the 
sample.  

DSim_Var(variable) Returns the sample 
variance of a 
DiscoverSim variable. 

𝑠𝑠2 =
∑ (𝑥𝑥𝑖𝑖 − 𝑥𝑥)2𝑛𝑛
𝑖𝑖=1

𝑛𝑛 − 1
 

 
where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the sample. 
𝑥̄𝑥 is the sample mean. 
𝑛𝑛 is the number of observations in the 
sample. 
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Specifying the Optimization Objective Function 
 
The following tables give the options available to specify an optimization objective function in the 
Run Optimization dialog: 
 

Optimization 
Goal: 

Minimize 

Multiple 
Output 
Metric: 

Weighted Sum Deviation from Target 

Statistic: Mean 
Median 

1st quartile 
3rd quartile 

Percentile (%) 
Minimum 
Maximum 

Standard Deviation 
Variance 

Mean Squared Error (requires Target) 
Skewness 
Kurtosis 
Range 

IQR (75-25) 
Span (95-5) 

Actual DPM (defects per million – requires LSL/USL) 
Actual DPMU (Upper – requires USL) 
Actual DPML (Lower – requires LSL) 

Calculated DPM (defects per million assuming normal 
distribution – requires LSL/USL) 

Calculated DPMU (Upper – requires USL) 
Calculated DPML (Lower – requires LSL) 

 

Mean (requires Target) 
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Optimization 
Goal: 

Maximize 

Multiple 
Output 
Metric: 

Weighted Sum Desirability 

Statistic: Mean 
Median 

1st quartile 
3rd quartile 

Percentile (%) 
Minimum 
Maximum 

Standard Deviation 
Variance 

Mean Squared Error (requires Target) 
Skewness 
Kurtosis 
Range 

IQR (75-25) 
Span (95-5) 

Pp (requires LSL/USL) 
PpU (Upper – requires USL) 
PpL (Lower – requires LSL) 

Ppk (requires LSL/USL) 
Cpm (requires Target/LSL/USL) 

%Pp (Percentile Pp – requires LSL/USL) 
%PpU (Percentile PpU – requires USL) 
%PpL (Percentile PpL – requires LSL) 

%Ppk (Percentile Ppk – requires LSL/USL) 

Mean (requires Target 
and LSL, USL or 

LSL/USL) 
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Formulas for Multiple Output Metrics 
 

1. Minimize/Maximize Weighted Sum: minimize or maximize the weighted sum of selected 
statistic. Weights are specified for each output in the Output Response dialog. For example, if 
the selected statistic was the Mean, and there were two outputs, the objective function would 
be: 

 
Weight1Mean1 + Weight2Mean2 

If there is a single output in the model, this simplifies to minimize or maximize the statistic 
value. 
Note that the Output Goal specified in the Output Response dialog is not used here.  It is 
only used in Maximize Desirability. 
 

2. Minimize Deviation from Target: minimize the square root of weighted sum of deviations 
squared. A target must be specified for each output in the Output Response dialog. The only 
statistic available for this option is the mean.  This is also known as the Taguchi or Quadratic 
Loss Function. If there were two outputs, the objective function would be: 
 

SQRT( Weight1(Mean1 – Target1)2 + Weight2(Mean2 – Target2)2). 
 

3. Maximize Desirability: Maximize the weighted linear sum of the Derringer and Suich 
desirability measure (Derringer and Suich, 1980). Each output must specify: 
 

• Weight (default = 1). This is also referred to as “Importance.”  (Note, another factor, 
the desirability shape is sometimes called “weight.” In DiscoverSim, the desirability 
shape factor is fixed at 1.) 

• Output Goal (Target, Maximize or Minimize) – this is specific to an output. For 
example, if Output 1 is production rate, the goal would be set to maximize, and 
Output 2, cost, would have a minimize goal.  However, the specified overall 
Optimization Goal is to maximize desirability. 

o If the output goal is Target, then LSL, Target, and USL are required. LSL and 
USL are the lower and upper specification limits used for process capability 
and dpm calculations, but are also used as the lower and upper bounds for 
desirability. The objective function is: 
 

𝐹𝐹(𝑥𝑥) =

⎩
⎪⎪
⎨

⎪⎪
⎧

0 𝑖𝑖𝑖𝑖 𝑥𝑥  <   𝑥𝑥 𝑙𝑙𝑙𝑙

�
𝑥𝑥 − 𝑥𝑥𝑙𝑙𝑙𝑙
𝑥𝑥𝑡𝑡𝑡𝑡𝑡𝑡 − 𝑥𝑥𝑙𝑙𝑙𝑙

� 𝑖𝑖𝑖𝑖 𝑥𝑥 𝑙𝑙𝑙𝑙  ≤  𝑥𝑥  ≤  𝑥𝑥 𝑡𝑡𝑡𝑡𝑡𝑡

�
𝑥𝑥 − 𝑥𝑥𝑢𝑢𝑢𝑢
𝑥𝑥𝑡𝑡𝑡𝑡𝑡𝑡 − 𝑥𝑥𝑢𝑢𝑢𝑢

� 𝑖𝑖𝑖𝑖 𝑥𝑥 𝑡𝑡𝑡𝑡𝑡𝑡  ≤  𝑥𝑥  ≤ 𝑥𝑥 𝑢𝑢𝑢𝑢

0 𝑖𝑖𝑖𝑖 𝑥𝑥  >   𝑥𝑥 𝑢𝑢𝑢𝑢
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o If the output goal is Minimize, then Target and USL are required. The 
objective function is: 

𝐹𝐹(𝑥𝑥) =

⎩
⎪
⎨

⎪
⎧ 1 𝑖𝑖𝑖𝑖 𝑥𝑥  <   𝑥𝑥 𝑡𝑡𝑡𝑡𝑡𝑡

�
𝑥𝑥 − 𝑥𝑥𝑢𝑢𝑢𝑢
𝑥𝑥𝑡𝑡𝑡𝑡𝑡𝑡 − 𝑥𝑥𝑢𝑢𝑢𝑢

� 𝑖𝑖𝑖𝑖 𝑥𝑥 𝑡𝑡𝑡𝑡𝑡𝑡  ≤  𝑥𝑥  ≤ 𝑥𝑥 𝑢𝑢𝑢𝑢

0 𝑖𝑖𝑖𝑖 𝑥𝑥  >   𝑥𝑥 𝑢𝑢𝑢𝑢

 

o If the output goal is Maximize, then LSL and Target are required. The 
objective function is: 

𝐹𝐹(𝑥𝑥) =

⎩
⎪
⎨

⎪
⎧ 0 𝑖𝑖𝑖𝑖 𝑥𝑥  <   𝑥𝑥 𝑙𝑙𝑙𝑙

�
𝑥𝑥 − 𝑥𝑥𝑙𝑙𝑙𝑙
𝑥𝑥𝑡𝑡𝑡𝑡𝑡𝑡 − 𝑥𝑥𝑙𝑙𝑙𝑙

� 𝑖𝑖𝑖𝑖 𝑥𝑥 𝑙𝑙𝑙𝑙  ≤  𝑥𝑥  ≤  𝑥𝑥 𝑡𝑡𝑡𝑡𝑡𝑡

1 𝑖𝑖𝑖𝑖 𝑥𝑥  >   𝑥𝑥 𝑡𝑡𝑡𝑡𝑡𝑡

 

The only statistic available for the desirability option is the mean. 
 

4. Stochastic optimization requires a fixed seed in order to avoid “chatter” that would result in 
inconsistent comparisons.  If the Seed is set to Clock, the initial seed value will be obtained 
from the system clock and then kept fixed throughout the optimization. 

 
Reference for Multiple Output Metrics 
 
Derringer, G., and R. Suich (1980), “Simultaneous Optimization of Several Response Variables,” 
Journal of Quality Technology, 12(4), pp. 214-219.  
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Formulas for Statistical Measures 
 
Mean 𝑥̄𝑥: The average value of the elements in the vector 𝑥𝑥. It is the sample estimate of the 
population mean 𝜇𝜇. 

𝑥̄𝑥 =
1
𝑛𝑛
�𝑥𝑥𝑖𝑖

𝑛𝑛

𝑖𝑖=1

 

 
where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the sample. 
𝑛𝑛 is the number of observations in the sample.  

  
Median 𝑥𝑥�:The median is the second quartile, or 50th percentile - the point that divides the ordered 
data into two equal groups.  

𝑃𝑃𝑃𝑃[𝑥𝑥𝑖𝑖 < 𝑥𝑥�] ≤ 0.5 
where:  

 𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the ordered sample.  
If the number of observations in a data set is odd, the median is the value in the middle. If the 
number of observations in a data set is even, the median is the average of the values of the two 
middle terms.  
  
1st Quartile 𝑸𝑸𝑸𝑸: The first quartile, or 25th percentile - the point that marks the first boundary when 
the ordered data is divided into four equal groups.  

𝑃𝑃𝑃𝑃[𝑥𝑥𝑖𝑖 < 𝑄𝑄1] ≤ 0.25 
where:  

 is the 𝑖𝑖th element in the ordered sample.  
If 𝑘𝑘 = (𝑛𝑛 + 1)/4 is an integer, the first quartile is taken as the 𝑥𝑥𝑘𝑘 element of the ordered 
observations; otherwise the first quartile is taken as the sum of the 𝑥𝑥𝑘𝑘 element and the fractional 
component applied to 𝑥𝑥𝑘𝑘+1 − 𝑥𝑥𝑘𝑘.  
  
3rd Quartile 𝑸𝑸𝑸𝑸: The third quartile, or 75th percentile - the point that marks the third boundary 
when the ordered data is divided into four equal groups.  

𝑃𝑃𝑃𝑃[𝑥𝑥𝑖𝑖 < 𝑄𝑄3] ≤ 0.75 
where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the ordered sample.  
If 𝑘𝑘 = 3(𝑛𝑛 + 1)/4is an integer, the third quartile is taken as the 𝑥𝑥𝑘𝑘 element of the ordered 
observations; otherwise the third quartile is taken as the sum of the 𝑥𝑥𝑘𝑘 element and the fractional 
component applied to 𝑥𝑥𝑘𝑘+1 − 𝑥𝑥𝑘𝑘.  
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Percentile: The value below which a given percentage of observations in a group of observations 
fall. For example, the default 95th percentile is the value below which 95 percent of the 
observations may be found. 
 
Minimum 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚: The smallest elements in the vector 𝑥𝑥. 

𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 = 𝑥𝑥1 
where:  

𝑥𝑥1 is the 1st element in the ordered sample.  
 

Maximum 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚: The largest elements in the vector 𝑥𝑥.  

𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 = 𝑥𝑥𝑛𝑛 
where:  

𝑥𝑥𝑛𝑛 is the 𝑛𝑛th element in the ordered sample. 
𝑛𝑛 is the number of observations in the sample.  

  
Standard. Deviation 𝑠𝑠: The sample standard deviation is a measure of the dispersion from the 
mean in the vector 𝑥𝑥. It is the sample estimate of the population standard deviation 𝜎𝜎.  
 

𝑠𝑠 = �∑ (𝑥𝑥𝑖𝑖 − 𝑥𝑥)2𝑛𝑛
𝑖𝑖=1
𝑛𝑛 − 1

 

where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the sample. 
𝑥̄𝑥 is the sample mean. 
𝑛𝑛is the number of observations in the sample.  

  
Variance 𝑠𝑠2: The sample variance is the expected value of the square of the sample deviations from 
the mean in the vector 𝑥𝑥 It is the sample estimate of the population variance 𝜎𝜎2. 

𝑠𝑠2 =
∑𝑛𝑛
𝑖𝑖=1 (𝑥𝑥𝑖𝑖 − 𝑥𝑥)2

𝑛𝑛 − 1
 

 

where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the sample. 
𝑥̄𝑥 is the sample mean. 
𝑛𝑛 is the number of observations in the sample.  

  
Mean Squared Error mse: The mean squared error is the expected value of the quadratic loss and 
incorporates both the variance of the estimator and its bias.  This is also known as the Taguchi Loss 
Function. 

𝑚𝑚𝑚𝑚𝑚𝑚 = (𝑥̄𝑥 − 𝑇𝑇)2 + 𝑠𝑠2 
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where:  

𝑥̄𝑥 is the sample mean. 
𝑇𝑇 is the specified target. 
𝑠𝑠2 is the sample variance.  

  
Skewness 𝑔𝑔1:  Skewness is a measure of the asymmetry of the data set. A negative value implies a 
long tail to the left of the mean, while a positive value implies a long tail to the right of the mean. A 
normal distribution has a skew of zero.  

𝑔𝑔1 =
1
𝑛𝑛∑ (𝑥𝑥𝑖𝑖 − 𝑥𝑥)3𝑛𝑛

𝑖𝑖=1

�1
𝑛𝑛∑ (𝑥𝑥𝑖𝑖 − 𝑥𝑥)2𝑛𝑛

𝑖𝑖=1 �
3/2 

where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the sample. 
𝑥̄𝑥 is the sample mean.  

  
Kurtosis 𝑔𝑔2: Kurtosis is a measure of the peakedness of the data set. A normal distribution has a 
kurtosis of zero.  

𝑔𝑔2 =
1
𝑛𝑛∑ (𝑥𝑥𝑖𝑖 − 𝑥𝑥)4𝑛𝑛

𝑖𝑖=1

�1
𝑛𝑛∑ (𝑥𝑥𝑖𝑖 − 𝑥𝑥)2𝑛𝑛

𝑖𝑖=1 �
2 − 3 

where:  

𝑥𝑥𝑖𝑖  is the 𝑖𝑖th element in the sample. 
𝑥̄𝑥 is the sample mean.  

  
Range 𝑅𝑅𝑥𝑥: The difference between the largest and smallest elements in the vector x.  

𝑅𝑅𝑥𝑥 = 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 − 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 
where:  

𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 is the 1st element in the ordered sample. 
𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚  is the 𝑛𝑛th element in the ordered sample. 
n is the number of observations in the sample.  

  
IQR The interquartile range, a measure of dispersion, is the difference between the third and first 
quartiles.  

𝐼𝐼𝐼𝐼𝐼𝐼 = 𝑄𝑄3 − 𝑄𝑄1 
where:  

Q1 is the first quartile. 
Q3 is the third quartile.  

  
Span 𝑆𝑆𝑥𝑥: The range of the elements in the vector x, after discarding the lower and upper 5% of the 
sample. This is less sensitive to outliers than the range.  
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𝑆𝑆𝑥𝑥 = 𝑥𝑥.95 − 𝑥𝑥.05 
where:  

𝑥𝑥𝑞𝑞 = is the 𝑞𝑞th percentile of 𝑥𝑥. 
 
  



DiscoverSim: Appendix 

250 

Formulas for Quality and Process Capability Indices 
  
Actual DPM:  Actual DPM (Defects per Million), also known as Actual PPM (Parts per Million), is 
based on an empirical count of defects. A defect is an observation with a value that is less than the 
lower spec. limit (LSL) or greater than the upper spec. limit (USL). Requires LSL and USL. 
 

𝐷𝐷𝐷𝐷𝐷𝐷 =
106

𝑛𝑛
��(𝑥𝑥𝑖𝑖 < 𝐿𝐿𝐿𝐿𝐿𝐿)
𝑛𝑛

𝑖𝑖=1

+ �(𝑥𝑥𝑖𝑖 > 𝑈𝑈𝑈𝑈𝑈𝑈)
𝑛𝑛

𝑖𝑖=1

� 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥𝑥𝑖𝑖  is the 𝑖𝑖th observation in the sample. 
𝑛𝑛 is the number of observations in the sample.  

 
Actual DPMU:  Actual DPMU (Defects per Million - Upper), also known as Actual PPMU (Parts per 
Million - Upper), is based on an empirical count of defects. A defect is an observation with a value 
that is greater than the upper spec. limit (USL). Requires USL. 
 

𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 =
106

𝑛𝑛
��(𝑥𝑥𝑖𝑖 > 𝑈𝑈𝑈𝑈𝑈𝑈)
𝑛𝑛

𝑖𝑖=1

� 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥𝑥𝑖𝑖  is the 𝑖𝑖th observation in the sample. 
𝑛𝑛 is the number of observations in the sample.  

 
Actual DPML:  Actual DPML (Defects per Million - Lower), also known as Actual PPML (Parts per 
Million - Lower), is based on an empirical count of defects. A defect is an observation with a value 
that is less than the lower spec. limit (LSL). Requires LSL. 
 

𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 =
106

𝑛𝑛
��(𝑥𝑥𝑖𝑖 < 𝐿𝐿𝐿𝐿𝐿𝐿)
𝑛𝑛

𝑖𝑖=1

� 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥𝑥𝑖𝑖  is the 𝑖𝑖th observation in the sample. 
𝑛𝑛 is the number of observations in the sample.  

 
Calculated DPM: Calculated DPM (Defects per Million), also known as Expected PPM (Parts per 
Million), is based on the sample mean, standard deviation, lower specification limit (LSL), upper 
specification limit (USL) and assumes a normal distribution. Requires LSL and USL. 
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𝐷𝐷𝐷𝐷𝐷𝐷 = 106 �(1 − 𝛷𝛷(
𝑥̄𝑥 − 𝐿𝐿𝐿𝐿𝐿𝐿

𝑠𝑠
)) + (1 − 𝛷𝛷(

𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑥̄𝑥
𝑠𝑠

))� 
where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the sample standard deviation. 
𝛷𝛷 is the cdf of the standard normal distribution. 

 
Calculated DPMU: Calculated DPMU (Defects per Million - Upper), also known as Expected PPMU 
(Parts per Million - Upper), is based on the sample mean, standard deviation, upper specification 
limit (USL) and assumes a normal distribution. Requires USL. 
 

𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 =
106

𝑛𝑛
��(𝑥𝑥𝑖𝑖 > 𝑈𝑈𝑈𝑈𝑈𝑈)
𝑛𝑛

𝑖𝑖=1

� 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥𝑥𝑖𝑖  is the 𝑖𝑖th observation in the sample. 
𝑛𝑛 is the number of observations in the sample.  

 
Calculated DPML: Calculated DPML (Defects per Million - Lower), also known as Expected PPML 
(Parts per Million - Lower), is based on the sample mean, standard deviation, lower specification 
limit (LSL) and assumes a normal distribution. Requires LSL. 
 

𝐷𝐷𝐷𝐷𝐷𝐷𝐷𝐷 = 106 �(1 − 𝛷𝛷(
𝑥̄𝑥 − 𝐿𝐿𝐿𝐿𝐿𝐿

𝑠𝑠
))� 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the sample standard deviation. 
𝛷𝛷 is the cdf of the standard normal distribution. 

 
Pp: Process Capability (or Performance) Index. It assumes a normal distribution. Requires LSL and 
USL. 

𝑃𝑃𝑝𝑝 =
𝑈𝑈𝑈𝑈𝑈𝑈 − 𝐿𝐿𝐿𝐿𝐿𝐿

6𝑠𝑠
 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑠𝑠 is the overall (long-term) sample standard deviation.  
Note that 𝐶𝐶𝑝𝑝, which uses the within-subgroup (short term) standard deviation, as applied in 
Six Sigma and Statistical Process Control, is not included in DiscoverSim. A typical Monte 
Carlo simulation run will use a stable mean and standard deviation, so there would be no 
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statistically significant difference between 𝐶𝐶𝑝𝑝 and 𝑃𝑃𝑝𝑝 or short-term versus long-term 
standard deviation. This note also applies to PpU, PpL, Ppk, and Cpm. 

 
PpU: Process Capability (or Performance) Index.  It assumes a normal distribution. Requires USL. 

𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑥̄𝑥

3𝑠𝑠
 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the overall (long-term) sample standard deviation.  

 
PpL: Process Capability (or Performance) Index. It assumes a normal distribution. Requires LSL. 

𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑥̄𝑥 − 𝐿𝐿𝐿𝐿𝐿𝐿

3𝑠𝑠
 

where:  

 𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the overall (long-term) sample standard deviation.  

  
Ppk: Process Capability (or Performance) Index. It assumes a normal distribution. Requires LSL and 
USL. 

𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑚𝑚𝑚𝑚𝑚𝑚(𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑥̄𝑥, 𝑥̄𝑥 − 𝐿𝐿𝐿𝐿𝐿𝐿)

3𝑠𝑠
 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑠𝑠 is the overall (long-term) sample standard deviation.  

  
Cpm: Process Capability Index, is also known as the Taguchi Capability Index and it includes a 
penalty for deviation from target. It assumes a normal distribution. Requires LSL and USL. 

𝐶𝐶𝑝𝑝𝑝𝑝 =
𝑚𝑚𝑚𝑚𝑚𝑚(𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑇𝑇,𝑇𝑇 − 𝐿𝐿𝐿𝐿𝐿𝐿)

3�𝑠𝑠2 + (𝑥̄𝑥 − 𝑇𝑇)2
 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥̄𝑥 is the sample mean. 
𝑇𝑇 is the target value. 
𝑠𝑠 is the overall (long-term) sample standard deviation.  
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%Pp: Percentile Process Capability Index. This index uses the 99.865 and .135 percentiles, so is 
useful when the data are not normally distributed. Requires LSL and USL. 

%𝑃𝑃𝑝𝑝 =
𝑈𝑈𝑈𝑈𝑈𝑈 − 𝐿𝐿𝐿𝐿𝐿𝐿

𝑥𝑥0.99865 − 𝑥𝑥.00135
 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥𝑥𝑞𝑞 = is the 𝑞𝑞th percentile of 𝑥𝑥. 

  
%PpU: Percentile Process Capability Index. This index uses the 99.865 percentile and median, so is 
useful when the data are not normally distributed. Requires USL. 

%𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑈𝑈𝑈𝑈𝑈𝑈 − 𝑥𝑥�
𝑥𝑥.99865 − 𝑥𝑥�

 

where:  

𝑈𝑈𝑈𝑈𝑈𝑈 is the upper specification limit. 
𝑥𝑥� is the sample median. 
𝑥𝑥𝑞𝑞 = is the 𝑞𝑞th percentile of 𝑥𝑥.  

 
%PpL: Percentile Process Capability Index. This index uses the 0.135 percentile and median, so is 
useful when the data are not normally distributed. Requires LSL. 

%𝑃𝑃𝑝𝑝𝑝𝑝 =
𝑥𝑥� − 𝐿𝐿𝐿𝐿𝐿𝐿
𝑥𝑥� − 𝑥𝑥.00135

 

where:  

𝐿𝐿𝐿𝐿𝐿𝐿 is the lower specification limit. 
𝑥𝑥� is the sample median. 
𝑥𝑥𝑞𝑞 = is the 𝑞𝑞th percentile of 𝑥𝑥. 
 

  
%Ppk: Percentile Process Capability Index. This index uses percentiles, so is useful when the data 
are not normally distributed. Requires LSL and USL. 

%𝑃𝑃𝑝𝑝𝑝𝑝 = 𝑚𝑚𝑚𝑚𝑚𝑚�%𝑃𝑃𝑝𝑝𝑝𝑝, %𝑃𝑃𝑝𝑝𝑝𝑝� 
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MIDACO Mixed Integer Distributed Ant Colony Global 
Optimization 
 
From http://www.midaco-solver.com/index.php/about.  Used with permission from Martin 
Schlueter, MIDACO-SOLVER.com. 
 
MIDACO is a general-purpose software for solving mathematical optimization problems. Initially 
developed for Mixed Integer Nonlinear Programming (MINLP) problems arising from demanding 
space applications at the European Space Agency [3], [7] and Astrium (EADS) [7], the software can 
be applied to a wide range of optimization problems. MIDACO handles problems where the 
objective function f(x) depends on continuous, integer or both types (mixed integer case) of 
variables x. The problem might be further restricted to equality and/or inequality constraints g(x). 
 
Optimization Problem 

 
As a black-box optimizer, MIDACO does not require the objective and constraint functions to hold 
any particular property like convexity or differentiability. MIDACO can robustly solve problems with 
critical function properties like high non-convexity, non-differentiability, flat spots and even 
stochastic noise. Extensively tested on over a hundred benchmark problems [5] and several real 
world applications, the software represents the state of the art for evolutionary computing on 
MINLP. Comparisons with established deterministic algorithms (see [5], [6]) revealed that MIDACO 
is fully competitive in respect to the number of global optimal solutions and cpu-runtime 
behaviour.  
 

MIDACO holds the benchmark world record best solution to Full Messenger (Mission to Mercury), 
which is considered the most difficult space trajectory problem in the ESA Global Trajectory 
Optimization Database. See http://www.midaco-solver.com/index.php/about/benchmarks/esa-
gtop for record solution(s).  

Note that the use of MIDACO with DiscoverSim, as a user friendly Excel add-in, while extremely 
powerful for the environment, does add significant overhead resulting in performance degradation 
compared to the published benchmarks.  Users requiring the full speed capabilities of MIDACO 
including parallelization with high performance computing would need to purchase stand-alone 
MIDACO SOLVER (see http://www.midaco-solver.com/index.php/contact). 
 
The MIDACO algorithm is based on a mixed integer extension of the Ant Colony Optimization (ACO) 
metaheuristic in combination with the recently developed Oracle Penalty Method [4] for constraint 
handling. The key element of MIDACO's ACO algorithm are so called “multi-kernel gaussian 

http://www.midaco-solver.com/index.php/about
http://www.esa.int/
http://www.midaco-solver.com/index.php/about/publications
http://www.midaco-solver.com/index.php/about/publications
http://www.astrium.eads.net/
http://www.midaco-solver.com/index.php/about/publications
http://www.midaco-solver.com/index.php/about/publications
http://www.midaco-solver.com/index.php/about/publications
http://www.midaco-solver.com/index.php/about/publications
http://www.midaco-solver.com/index.php/about/benchmarks/esa-gtop
http://www.midaco-solver.com/index.php/about/benchmarks/esa-gtop
http://www.midaco-solver.com/index.php/contact
http://en.wikipedia.org/wiki/Ant_colony_optimization_algorithms
http://www.midaco-solver.com/index.php/more/oracle-penalty-method
http://www.midaco-solver.com/index.php/about/publications
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probability density functions” (Gauss PDF's), which are used to stochastically sample solution 
candidates (also called “ants” or “iterates”) for the optimization problem. In case of integer 
variables, a discretized version of the Gauss PDF is applied instead of the continuous version. 

 
Continuous (left) and discretized (right) multi-kernel gaussian probability density functions (Gauss 
PDF's) 
 
MIDACO References: 
 
[1] Schlueter M., Egea J. A., Banga J. R.: Extended Ant Colony Optimization for non-convex Mixed 
Integer Nonlinear Programming, Computers & Operations Research (Elsevier), Vol. 36, Issue 7, 
Pages 2217-2229 (2009). Preprint: http://www.midaco-
solver.com/data/pub/Extended_ACO_for_MINLP.pdf. 
 
[2] Schlueter M., Egea J. A., Antelo L.T., Alonso A.A., Banga J. R.: An extended Ant Colony 
Optimization Algorithm for Integrated Process and Control System Design, Industrial & Engineering 
Chemistry Res. (ACS), Vol. 48, Issue 14, Pages 6723-6738 (2009). Preprint: http://www.midaco-
solver.com/data/pub/Extended_ACO_for_Control_System_Design.pdf. 
 
[3] Schlueter M., Rückmann J.J., Gerdts M.: Non-linear Mixed-Integer-based Optimization 
Technique for Space Applications, ESA Conference - International NPI Day, European Space Agency, 
Noordwijk, Netherlands (2010). Poster: http://www.midaco-
solver.com/data/pub/ESA_NPI_Poster_2010.jpg. 
 
[4] Schlueter M., Gerdts, M.: The Oracle Penalty Method, Journal of Global Optimization (Springer), 
Vol. 47, Issue 2, Pages 293-325 (2010). Preprint: http://www.midaco-
solver.com/data/pub/The_Oracle_Penalty_Method.pdf. 
 
[5] Schlueter M., Gerdts M., Rückmann J.J.: A Numerical Study of MIDACO on 100 MINLP 
Benchmarks, Optimization (Taylor & Francis), Vol 61, Issue 7, Pages 873-900  (2012). Preprint: 
http://www.midaco-solver.com/data/pub/MIDACO_on_100_MINLP_Benchmarks.pdf. 
 

http://www.midaco-solver.com/index.php/about/publications
http://www.midaco-solver.com/data/pub/Extended_ACO_for_MINLP.pdf
http://www.midaco-solver.com/data/pub/Extended_ACO_for_MINLP.pdf
http://www.midaco-solver.com/data/pub/Extended_ACO_for_Control_System_Design.pdf
http://www.midaco-solver.com/data/pub/Extended_ACO_for_Control_System_Design.pdf
http://www.midaco-solver.com/data/pub/ESA_NPI_Poster_2010.jpg
http://www.midaco-solver.com/data/pub/ESA_NPI_Poster_2010.jpg
http://www.midaco-solver.com/data/pub/The_Oracle_Penalty_Method.pdf
http://www.midaco-solver.com/data/pub/The_Oracle_Penalty_Method.pdf
http://www.midaco-solver.com/data/pub/MIDACO_on_100_MINLP_Benchmarks.pdf
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[6] Schlueter M.: Nonlinear Mixed Integer based Optimization Technique for Space Applications, 
Ph.D. Thesis, School of Mathematics, University of Birmingham (UK) (2012). Thesis: 
http://www.midaco-solver.com/data/pub/Thesis_Schlueter.pdf. 
 
[7] Schlueter M., Erb S., Gerdts M., Kemble S., Rückmann  J.J.: MIDACO on MINLP Space 
Applications, Advances in Space Research (Elsevier), Vol 51, Issue 7, Pages 1116–1131 (2013). 
Preprint: http://www.midaco-solver.com/data/pub/MIDACO_on_Space_Applications.pdf.  
 
[8] Schlueter M., Munetomo M.: MIDACO User Guide, Technical Report, Hokkaido University, Japan 
(HUSCAP) (2013). PDF: http://www.midaco-solver.com/data/other/MIDACO_User_Guide.pdf. 
 
[9] Schlueter M., Munetomo M.: Parallelization Strategies for Evolutionary Algorithms for MINLP, 
Proceedings of the IEEE Congress on Evolutionary Computation (IEEE-CEC), pp.635-641 (2013). 
Preprint: http://www.midaco-solver.com/data/pub/MIDACO_CEC2013.pdf.  
 
[10] Schlueter M., Munetomo M.: Midaco-Solver, Global Optimization Software for Mixed Integer 
Nonlinear Programming, SC13 - Super Computing Conference, Exhibitor Booth Nr. 320, Denver, 
USA (2013). Poster: http://www.midaco-solver.com/data/other/SC13_MIDACO.pdf. 
 
[11] Schlueter M.: Global Optimization of MINLP by Evolutionary Algorithms, APMonitor Webinar 
(AIChE), Symposium on Modeling and Optimization, USA (2014). PDF: http://www.midaco-
solver.com/data/pub/MIDACO_APMonitor.pdf. Video: http://www.youtube.com/watch?v=oCVib-
sRbjY&list=UU2GuY-AxnNxIJFAVfEW0QFA&feature=c4-overview. 
 
[12] Schlueter M.: Recent Advances in Optimization Software for Space Applications, Invited 
Presentation, Japanese Space Exploration Agency (ISAS/JAXA), Japan (2014). PDF: 
http://www.midaco-solver.com/data/pub/MIDACO_JAXA_2014.pdf. 
 
[13] Schlueter M. Munetomo M.: Parallelization for Space Trajectory Optimization, Proceedings of 
the IEEE World Congress on Computational Intelligence (IEEE-WCCI), pp. 832 - 839 (2014). Preprint: 
http://www.midaco-solver.com/data/pub/CEC2014_Schlueter_Munetomo.pdf. 
 
[14] Schlueter M., MIDACO Software Performance on Interplanetary Trajectory Benchmarks, 
Advances in Space Research (Elsevier), Vol 54, Issue 4, Pages 744 - 754 (2014). Preprint: 
http://www.midaco-solver.com/data/pub/MIDACO_on_ESA_GTOP_Benchmarks.pdf. 
 
  

http://www.midaco-solver.com/data/pub/Thesis_Schlueter.pdf
http://www.midaco-solver.com/data/pub/MIDACO_on_Space_Applications.pdf
http://www.midaco-solver.com/data/other/MIDACO_User_Guide.pdf
http://www.midaco-solver.com/data/pub/MIDACO_CEC2013.pdf
http://www.midaco-solver.com/data/other/SC13_MIDACO.pdf
http://www.midaco-solver.com/data/pub/MIDACO_APMonitor.pdf
http://www.midaco-solver.com/data/pub/MIDACO_APMonitor.pdf
http://www.youtube.com/watch?v=oCVib-sRbjY&list=UU2GuY-AxnNxIJFAVfEW0QFA&feature=c4-overview
http://www.youtube.com/watch?v=oCVib-sRbjY&list=UU2GuY-AxnNxIJFAVfEW0QFA&feature=c4-overview
http://www.midaco-solver.com/data/pub/MIDACO_JAXA_2014.pdf
http://www.midaco-solver.com/data/pub/CEC2014_Schlueter_Munetomo.pdf
http://www.midaco-solver.com/data/pub/MIDACO_on_ESA_GTOP_Benchmarks.pdf
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ORACLE PENALTY METHOD 
 
From http://www.midaco-solver.com/index.php/more/oracle-penalty-method.  Used with 
permission from Martin Schlueter, MIDACO-SOLVER.com. 
 
The oracle penalty method is an advanced approach for constraint handling within evolutionary 
optimization algorithms. The method is based on a single parameter Omega (Ω), which is called an 
oracle due to its predictive nature. This parameter directly corresponds to the global optimal 
objective function value f(x). In case of real-world applications where the user has some (rough) 
guess about a possible global optimal f(x) value, this information can be exploited as oracle 
information to improve the convergence speed of the optimization algorithm. In case no such user 
guided information is available, an (automated) update rule can be applied for Ω, starting with a 
value of infinity (∞) and updating Ω after individual optimization runs, when better (feasible) 
solutions have been found.  
 
Algorithms implementing the oracle penalty method with automated update are classified as self-
tuning. The oracle penalty method has been applied for, example, in Ant Colony Optimization 
(ACO), see [1], [6], [7]; Genetic Algorithms (GA), see [2], [10]; Particle Swarm Optimization (PSO), 
see [3] and Differential Evolution (DE), see [4], [5], [8]. The most detailed introduction to the 
method can be found in [1]; a brief motivation of the key idea of the method can be found in this 
PDF presentation (slide 11-15). The oracle penalty method is one of the major reasons why 
MIDACO is capable to solve problems with up to hundreds of (non-linear) constraints (see 
Benchmarks). 

 
Mathematical Formulation of the Oracle Penalty Function 

 
 

http://www.midaco-solver.com/index.php/more/oracle-penalty-method
http://www.midaco-solver.com/data/pub/MIDACO_APMonitor.pdf
http://www.midaco-solver.com/index.php/about/benchmarks
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(Graphical illustration of the extended oracle penalty function for Omega = 0) 

 
ORACLE References: 
 
[1] Schlueter, Gerdts: The Oracle Penalty Method, Journal of Global Optimization (Springer), Vol. 
47, Issue 2, Pages 293-325 (2010). Preprint: http://www.midaco-
solver.com/data/pub/The_Oracle_Penalty_Method.pdf. 
 
[2] Munawar et al.: Advanced genetic algorithm to solve MINLP problems over GPU, IEEE Congress 
on Evolutionary Computation (CEC), 318 - 325 (2011). 
 
[3] Dong, Cheng, Niu: A Constrained Particle Swarm Optimization Algorithm with Oracle Penalty 
Method, Applied Mechanics and Material (AMM) 303-306, 1519 (2013). 
 
[4] Dong, Wang, Cheng, Jiang: Composite differential evolution with modified oracle penalty 
method for constrained optimization problems, Mathematical Problems in Engineering (2014). 
Preprint: http://downloads.hindawi.com/journals/mpe/aip/617905.pdf. 
 

http://www.midaco-solver.com/data/pub/The_Oracle_Penalty_Method.pdf
http://www.midaco-solver.com/data/pub/The_Oracle_Penalty_Method.pdf
http://downloads.hindawi.com/journals/mpe/aip/617905.pdf
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[5] Dong, Cheng, Niu: Adaptive Constrained Differential Evolution Algorithms based on Oracle 
Penalty Function, Computer Applications and Software (Chinese), DOI:10.3969/j.issn.1000-
386x.2014.01.078 (2014). 
 
[6] Gebreslassie, Diwekar: Efficient ant colony optimization for computer aided molecular design: 
case study solvent selection problem, Computers & Chemical Engineering (Elsevier) Volume 78, 
Pages 1–9 (2015). Preprint: http://www.midaco-solver.com/data/other/EACO.pdf. 
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The following MIDACO settings can be modified in DiscoverSim by clicking Run Optimization > 
Advanced Settings: 
 

• Maximum iterations. Default = 10,000. Note that 1 iteration is equivalent to 1000 function 
evaluations so default is maximum of 1e7 function evaluations.   

• Maximum time. Default 100,000 seconds. 
• Print frequency. Results are displayed with specified frequency. Default = 1 (at every 

iteration, result is displayed). 
• Convergence criteria - iterations [0 - auto].  The maximum number of iterations where the 

objective function has not changed (by more than 1e-9) to declare convergence.  If set to 0 
(auto), the convergence criteria varies with number of input controls as follows: 

o Number of input controls <= 4: Convergence criteria = 1000 (as noted above, this is 
1e6 function evaluations) 

o Number of input controls = 5 - 9: Convergence criteria = 500 
o Number of input controls >= 9: Convergence criteria = 100 

The rationale for these automatic settings is the simpler the model (with fewer controls) the 
less computation time is expected to be required. You can also set the convergence criteria 
– iterations to any specified value. 

• Autostop [0 – disable].  Automatic stopping criteria. Default = 0 (disabled). 
Examples of AUTOSTOP values and their possible impact on MIDACO (from MIDACO User 
Guide): 

o 1 Fastest runtime but very low chance of global optimality 

http://www.midaco-solver.com/data/other/EACO.pdf
http://www.midaco-solver.com/data/other/EACO.docx
http://www.midaco-solver.com/data/other/EACO.docx
http://dx.doi.org/10.1007/s10589-015-9739-3
http://dx.doi.org/10.1007/s10589-015-9739-3
http://www.midaco-solver.com/data/other/COAP-2015.pdf
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o 5 Fast runtime but low chance of global optimality 
o 50 Medium long runtime and medium chance of global optimality 
o 500 Long runtime but high chance of global optimality 
o 5000 Very long runtime but also very high chance of global optimality. 

• Focus [0 – auto]. From MIDACO User Guide:  
o This parameter forces MIDACO to focus its search process around the current best 

solution. For many problems, tuning this parameter is useful and will result in a 
faster convergence speed (e.g., for convex and semi-convex problems). This 
parameter is also especially useful for refining solutions (e.g. to improve the 
precision of their objective function value or constraint violation). 

o If FOCUS is not equal to zero, MIDACO will apply an upper bound for the standard 
deviation of its Gauss PDF's. The upper bound for the standard deviation for 
continuous variables is given by (XU(i)-XL(i))/FOCUS, whereas the upper bound for 
the standard deviation for integer variables is given by MAX((XU(i)-
XL(i))/FOCUS,1/SQRT(FOCUS)). 

o In other words, the larger the value of FOCUS, the closer MIDACO will concentrate 
its search around its current best solution. 

o The value for FOCUS must be an integer. Smaller values for FOCUS (e.g. 10 or 100) 
are recommended for first test runs (without a specific starting point). Larger values 
for FOCUS (e.g. 10000 or 100000) are normally only useful for refinement runs 
(where a specific solution is used as a starting point). 

• Ants [0 – auto]. From MIDACO User Guide:  
o This parameter allows the user to fix the number of ants (solution candidates) which 

MIDACO generates within one generation (major iteration of the evolutionary ACO 
algorithm).  

o This parameter must be used in combination with KERNEL. Using the ANTS and 
KERNEL parameters can be promising for some problems (in esp. large scale 
problems or cpu-time intensive applications). However, tuning these parameters 
might also significantly reduce the MIDACO performance. 

o If ANTS parameter is equal to zero, MIDACO will dynamically change the number of 
ants per generation. 

• Kernel [0 – auto]. From MIDACO User Guide:  
o This parameter allows the user to fix the number of kernels within MIDACO's multi-

kernel Gauss PDF's. The kernel size corresponds also to the number of solutions 
stored in MIDACO's solution archive.  

o On rather convex problems it can be observed, that a lower kernel number will 
result in faster convergence while a larger kernel number will result in lower 
convergence. On the contrary, a lower kernel number will increase the risk of 
MIDACO getting stuck in a local optimum, while a larger kernel number increases 
the chance of reaching the global optimum.  

o The KERNEL parameter must be used in combination with the ANTS parameter. 
Some examples of possible ants/kernel settings are given and explained below. 
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o The 1st setting is the smallest possible one. This setting might be useful for very cpu-
time expensive problems where only some hundreds of function evaluation are 
possible or for problems with a specific structure (e.g. convexity). The 2nd setting 
might also be used for cpu-time expensive problems, as a relatively low number of 
ANTS is considered. The 3rd and 4th setting would only be promising for problems 
with a fast evaluation time. As tuning the ants and kernel parameters is highly 
problem dependent, the user needs to experiment with those values. 

o Note that the maximum kernel number for MIDACO is fixed to 100. 
 

• Oracle eq. constraint tolerance. Oracle equality constraint tolerance. Default = 0.001. From 
MIDACO User Guide:  

o This parameter defines the accuracy tolerance for the equality constraints G(X). An 
equality constraint is considered feasible by MIDACO, if |G(X)| <= Oracle equality 
constraint tolerance. 

o This parameter has strong influence on the MIDACO performance on equality 
constraint problems. For problems with difficult constraints, it is recommended to 
start with some test runs using a less precise tolerance (e.g. 0.05 or even 0.1) and to 
apply some refinement runs with a higher precision afterwards (e.g. 1e-4 or 1e-6). 

• Oracle constraint penalty [0 - auto]. From MIDACO User Guide: 
o This parameter specifies a user given oracle parameter to the penalty function 

within MIDACO.  This parameter is only relevant for constrained problems. If this is 
equal to zero, MIDACO will use an Oracle constraint penalty of 1e9, otherwise the 
specified value is used. 

o This option can be especially useful for constrained problems where some 
background knowledge on the problem exists. For example: It is known that a given 
application has a feasible solution X corresponding to F(X)=1000 (e.g. plant operating 
cost in Dollars). Therefore it might be reasonable to submit an oracle value of 800 or 
600 to MIDACO, as this cost region might hold a new feasible solution (to operate 
the plant at this cost value). Whereas an oracle value of more than 1000 would be 
uninteresting to the user, while a too low value (e.g. 200) would be unreasonable.  

o See Oracle Penalty Method above for further information. 
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Genetic Algorithm (GA) Global Optimization 
 
The Genetic Algorithm (GA) is a derivative free global optimization method that attempts to find a 
global optimum by simulating an evolutionary process. Each member of a population (a 
chromosome or solution) has a set of genes (parameter values). The members breed (crossover), 
and the genes can mutate. Successful chromosomes – i.e., those that are most fit, as evaluated by 
the optimization process - survive, while the rest die. The parameters associated with the 
successful genes are returned. See http://en.wikipedia.org/wiki/Genetic_algorithm for further 
details. An online interactive tutorial is available at: http://www.obitko.com/tutorials/genetic-
algorithms/. 
 
GA is a useful complement to MIDACO and with some problems such as all continuous input 
control variables, may be faster to find a global optimum. 
 
The MIDACO Oracle Penalty Method for constraints described above has been implemented in 
DiscoverSim’s GA. 
 
The following GA settings can be modified by clicking Run Optimization > Advanced Settings: 
 

• Maximum iterations. Default = 10,000. 
• Maximum time. Default 100,000 seconds. 
• Print frequency. Results are displayed with specified frequency. Default = 1 (at every 

iteration, result is displayed). 
• Convergence criteria - iterations [0 - auto].  The maximum number of iterations where the 

objective function has not changed (by more than 1e-9) to declare convergence.  If set to 0 
(auto), the convergence criteria varies with number of input controls as follows: 

o Number of input controls <= 4: Convergence criteria = 1000 
o Number of input controls = 5 - 9: Convergence criteria = 500 
o Number of input controls >= 9: Convergence criteria = 100 

The rationale for these automatic settings is the simpler the model (with fewer controls) the 
less computation time is expected to be required. You can also set the convergence criteria 
– iterations to any specified value. 

• Convergence criteria - fit-stdev [0 - disable].  Standard deviation of chromosome set of 
objective function must be less than this for 10 iterations to declare convergence. Default = 
.00001. 

• Chromosomes [0 – auto]. Number of chromosomes (population size). Each chromosome 
(solution member) of the population has a set of genes which correspond to parameter 
values. The larger the population, the greater the variability which increases the chances of 
finding a global optimum, but the longer the estimation time. If set to default = 0 (auto), the 
number of chromosomes vary with the number of input controls as follows: 

o 10 * number of input control variables 
o Minimum = 40 

If the problem is highly non-linear with multiple minima (like the Schwefel function) we 
recommend 40* number of input control variables. 

http://en.wikipedia.org/wiki/Genetic_algorithm
http://www.obitko.com/tutorials/genetic-algorithms/
http://www.obitko.com/tutorials/genetic-algorithms/
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• Matings. Number of matings (crossovers). Multiple matings result in an increased 
population, but only the original population size is maintained by culling the least fit. 
Default = 4. 

• Prob. of mutation [0 – auto]. Genes can mutate on a chance basis, specified by this 
probability. Typically a low probability of mutation works well for global optimization with 
continuous variables. If set to default = 0 (auto), the probability of mutation = 
1/(10*number of input control variables). 

• Degree of mutation. Should mutation occur, this specifies the degree of mutation. Large 
values make for a faster solution, but can result in poorer optimization near the end. 
Default = 0.5. 

• Oracle eq. constraint tolerance. Oracle equality constraint tolerance. Default = 0.001. See 
MIDACO Oracle Penalty Method above for further details. 
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Discrete Exhaustive Global Optimization 
 
Discrete Exhaustive optimization is applicable for small problems where all of the input control 
variables are discrete.  All combinations are evaluated and the best solution that satisfies all 
constraints (if applicable) is selected. 
 
Obviously if the number of combinations (computed as # levels ^ # variables – assuming same # 
levels for each variable) is large then this method will not be feasible.  A user defined Time Limit 
(default = 120 seconds) sets the maximum computation time.  However, you won’t have to wait for 
this time to be exceeded if the problem is too large. After 50 trials, the average time per run is 
estimated and if this time, multiplied by the total number of combinations, exceeds the Time Limit, 
an error message is given and the optimization is stopped. 
 
Practically this method will work well with binary discrete (2 levels) and up to 13 or 14 variables. 
 
The following Discrete Exhaustive settings can be modified by clicking Run Optimization > 
Advanced Settings: 
 

• Maximum iterations. Default = 10,000. 
• Print frequency. Results are displayed with specified frequency. Default = 1 (at every 

iteration, result is displayed). 
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Sequential Quadratic Programming (SQP) Local Optimization 
 
SQP is a very fast and robust algorithm for smooth local nonlinear continuous optimization. The 
objective function and the constraints must be twice continuously differentiable. The method is 
based on solving a series of subproblems designed to minimize a quadratic model of the objective 
subject to a linearization of the constraints, using the Simplex algorithm. If the problem is 
unconstrained, then the method reduces to Newton's method for finding a point where the 
gradient of the objective vanishes. For further details see 
http://en.wikipedia.org/wiki/Sequential_quadratic_programming. 
 
The following SQP settings can be modified by clicking Run Optimization > Advanced Settings: 
 

• Maximum iterations. Default = 10,000. 
• Maximum time. Default 100,000 seconds. 
• Print frequency. Results are displayed with specified frequency. Default = 1 (at every 

iteration, result is displayed). 
• Convergence criteria - parameter slope.  Slope of each parameter must be less than this for 

convergence. Default = 0.00001. 
  

http://en.wikipedia.org/wiki/Sequential_quadratic_programming


DiscoverSim: Appendix 

266 

Nelder-Mead (NM) Local Optimization 
 
The Nelder Mead algorithm is a fast downhill simplex method that provides a local optimum for an 
objective function when the gradients are not known (non-differentiable), so is suitable for non-
smooth problems. 
 
NM creates a simplex – an n+1 space – where each point (vertex) in the space represents an initial 
starting value.  Each vertex is evaluated in terms of the criteria functions, the worst vertex is 
eliminated, and another vertex is added.  The process is continued until no further reduction in the 
criteria function occurs.   
 
The creation of the new vertex involves reflection, expansion, contraction and shrinkage – the 
simplex changes shape and size at each iteration.  The parameters allow one to influence how this 
process occurs. 
 
The MIDACO Oracle Penalty Method for constraints described above has been implemented in 
DiscoverSim’s NM. 
 
For further details see: 
 
https://en.wikipedia.org/wiki/Nelder%E2%80%93Mead_method 
 
http://www.scholarpedia.org/article/Nelder-Mead_algorithm 
 
Nelder, John A.; R. Mead (1965). "A simplex method for function minimization." Computer Journal 
7: 308–313.doi:10.1093/comjnl/7.4.308. 
 
The following NM settings can be modified by clicking Run Optimization > Advanced Settings: 
 

• Maximum iterations. Default = 10,000. 
• Maximum time. Default 100,000 seconds. 
• Print frequency. Results are displayed with specified frequency. Default = 1 (at every 

iteration, result is displayed). 
• Convergence criteria - iterations [0 - auto].  The maximum number of iterations where the 

objective function has not changed (by more than 1e-9) to declare convergence.  If set to 0 
(auto), the convergence criteria varies with number of input controls as follows: 

o Number of input controls <= 4: Convergence criteria = 1000 
o Number of input controls = 5 - 9: Convergence criteria = 500 
o Number of input controls >= 9: Convergence criteria = 100 

The rationale for these automatic settings is the simpler the model (with fewer controls) the 
less computation time is expected to be required. You can also set the convergence criteria 
– iterations to any specified value. 

• Reflection. (Reflection > 0), Default = 1. 
• Contraction. (0 < Contraction < 1), Default = 0.5. 

https://en.wikipedia.org/wiki/Nelder%E2%80%93Mead_method
http://www.scholarpedia.org/article/Nelder-Mead_algorithm
https://en.wikipedia.org/wiki/Digital_object_identifier
https://dx.doi.org/10.1093%2Fcomjnl%2F7.4.308
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• Expansion. (Expansion > 0), Default = 2. 
• Shrinkage is hard coded = 0.5. 
• Initial Perturbation. (Initial Simplex Perturbation > 0), Default = 0.1. 
• Oracle eq. constraint tolerance. Oracle equality constraint tolerance. Default = 0.001. See 

MIDACO Oracle Penalty Method above for further details. 
• Oracle update frequency. Default = 20. See MIDACO Oracle Penalty Method above for 

further details. 
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HYBRID Optimization 
 
HYBRID optimization is a powerful hybrid of the above 5 methods that takes advantage of the 
strengths of each method: 

1. All discrete controls: MIDACO or Exhaustive Discrete if applicable 

2. All continuous controls: MIDACO, GA, followed by SQP or NM (if SQP fails due to non-
smooth objective function). The solution from MIDACO provides starting values for GA. The 
solution for GA provides starting values for SQP/NM. 

3. Mixed continuous/discrete controls: MIDACO 1 (Default settings), MIDACO 2 (Fine FOCUS = 
100000), followed by SQP or NM (if SQP fails due to non-smooth objective function). The 
solution from MIDACO 1 provides starting values for MIDACO 2. The solution for MIDACO 2 
provides starting values for SQP/NM. 

Note that using Hybrid will be slower than using a specific method, so if a quick solution is required, 
it is recommended to select one of the specific methods. 
 
The following Hybrid settings can be modified by clicking Run Optimization > Advanced Settings: 

• GA Maximum Iterations. Default = 1000.  
• SQP Maximum Iterations. Default = 1000.  
• NM Maximum Iterations. Default = 1000 
• MIDACO 1 Maximum Iterations. Default = 1000 (1e6 function evaluations) 
• MIDACO 2 Maximum Iterations. Default = 1000 (1e6 function evaluations) 
 

To change other settings for a specific method, select the method of interest and modify the 
respective settings.  Going back to Hybrid, those modified settings will be used. 
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Distribution Fitting - Maximum Likelihood Estimation of 
Parameters 
 
Maximum likelihood (ML) estimates of the parameters are calculated by maximizing the likelihood 
function with respect to the parameters. The likelihood function is simply the sum of the log of the 
probability density function (PDF) for each observation. 
 
Initial parameter values are derived from method of moments estimates or, if applicable, ordinary 
least squares. 
 
The maximum likelihood parameter estimates are then calculated using the method of Broyden, 
Fletcher, Goldfarb, and Shanno (BFGS).  The BFGS method approximates Newton's method, a class 
of hill-climbing optimization techniques that seeks a stationary point of a (preferably twice 
continuously differentiable) function. These methods use both the first and second derivatives of 
the function. However, BFGS has proven to have good performance even for non-smooth 
optimizations. For further details see: 
 
https://en.wikipedia.org/wiki/Broyden%E2%80%93Fletcher%E2%80%93Goldfarb%E2%80%93Shan
no_algorithm 
 
If BFGS fails to converge, then the robust method of Nelder-Mead (described above) is employed. 
 
The standard errors of the parameter estimates are derived from the Hessian matrix. This matrix, 
which describes the curvature of a function, is the square matrix of second-order partial derivatives 
of the function. 
 
  

https://en.wikipedia.org/wiki/Broyden%E2%80%93Fletcher%E2%80%93Goldfarb%E2%80%93Shanno_algorithm
https://en.wikipedia.org/wiki/Broyden%E2%80%93Fletcher%E2%80%93Goldfarb%E2%80%93Shanno_algorithm
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Distribution Fitting – Percentiles to Parameters Calculator 
 
If one does not have sufficient data to do maximum likelihood distribution fitting but does know 
some percentile values of a specified distribution, these can be converted to parameter values for 
use in simulation. 
 
Consider a distribution in which there are 𝑘𝑘 parameters. Given only 𝑘𝑘 observations, and a 
knowledge of the order (percentile or quantile) of each observation, one can estimate the 𝑘𝑘 
parameters. 
   
As an example, consider estimating the scale (𝑏𝑏) and shape (𝑐𝑐) parameters for a gamma 
distribution. One has two observations, 𝑥𝑥1 and 𝑥𝑥2, which correspond to quantiles 𝑝𝑝1 and 𝑝𝑝2. Thus 
for 𝑝𝑝1 = .25, and 𝑝𝑝2 = .75, 𝑥𝑥1 and 𝑥𝑥2 correspond to the first and third quartile. Define 𝛷𝛷−1(𝑝𝑝, 𝑏𝑏, 𝑐𝑐) 
as the inverse gamma distribution function. We then have:  
 𝛷𝛷−1(𝑝𝑝1,𝑏𝑏, 𝑐𝑐) = 𝑥𝑥1 
 𝛷𝛷−1(𝑝𝑝2,𝑏𝑏, 𝑐𝑐) = 𝑥𝑥2 
These parameters can then be solved, either analytically, or numerically. The numerical solution 
involves writing the equations in the canonical form (𝑓𝑓(𝑣𝑣) = 0), where 𝑣𝑣 is the vector of 
parameters, specifying a starting value for 𝑣𝑣, and producing a sequence of estimates for 𝑣𝑣 using a 
Newton algorithm that converge towards the root as a limit. 
 

Reference for Percentiles to Parameters Calculator: 

 
Cook, J.D. (2010). “Determining distribution parameters from quantiles,”  
http://www.johndcook.com/quantiles_parameters.pdf, University of Texas. 
 
  

http://www.johndcook.com/quantiles_parameters.pdf
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Distribution Fitting – Threshold Distributions 
 
If the threshold parameter is not known, maximum likelihood is used to estimate the parameters.  
For some data sets, the likelihood function for threshold models is unbounded, and the maximum 
likelihood methodology fails (infinite likelihood). In other cases multiple modes are possible, 
leading to unstable results. 
 
An alternative method, the iterative bias reduction procedure by Lockhart (1994), and discussed in 
William (2011), is a robust alternative to maximum likelihood. This is an iterative methodology that 
evaluates the threshold based on the difference between the minimum value of the variate and the 
prediction for the minimum value (using cdf inverse), conditional on the current values of the 
remaining parameters (solved using BFGS maximum likelihood).   
 
The probability for the minimum used in the cdf inverse has several possible choices as used in 
probability plotting positions, including the most common:  

• (i-0.5)/N 
• i/N 
• i/(N+1) 
• (i-0.3)/(N+0.4) 

The minimum is specified with i=1. Using Monte Carlo small sample simulation we determined that 
cdf inverse((1-0.5)/N) produced the best overall result for threshold estimation (minimum bias 
against known).  The exception to this was the 2 Parameter Exponential where the predicted 
minimum value = scale/N gave minimum bias for small samples. 
 
Initial estimates of Threshold use bias reduction with method of moments (or least squares if 
applicable) on the other parameters. 
 
In some cases maximum likelihood will produce the best parameter estimates (e.g. 3 Parameter 
Weibull with shape > 2), in others the iterative bias procedure is the best or only solution (e.g. 3 
Parameter Weibull with shape < 1).  In the case of 3 Parameter Weibull, one can use likelihood 
profiling to select which method to use, see Lockhart (1994), but this “switch” is not generally 
applicable to all threshold distributions.  DiscoverSim will attempt to solve the threshold 
distribution using BFGS maximum likelihood as well as with iterative bias reduction. If maximum 
likelihood fails, then iterative bias reduction is used. If both successfully converge, the result 
producing the lowest Anderson Darling statistic is selected. 
 
There are good alternative methods to the iterative bias reduction, such as Maximum Product 
Spacing (see Akram, 2012), but in the context of batch distribution fitting, we consider the above 
hybrid to be the best overall approach.   
 
References for Threshold Distributions: 

Akram, M. and Hayat, A. (2012) “Comparison of estimators of the Weibull Distribution” Financial 
Econometrics Series, SWP 2012/04, Deakin University Australia,  
http://www.deakin.edu.au/buslaw/aef/workingpapers/fin-econometrics/2012_04.pdf. 

http://www.deakin.edu.au/buslaw/aef/workingpapers/fin-econometrics/2012_04.pdf
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David, H.A. (1981).  Order Statistics, John Wiley & Sons, New York. 
 
Giesbrecht, F. and Kempthorne, A.H. (1966). “Maximum Likelihood Estimation in the Three-
parameter Lognormal Distribution,”  Journal of the Royal Statistical Society, B 38, pp. 257-264. 
 
Lockhart, R.A. and Stephens, M.A. (1994). “Estimation and Tests of Fit for the Three-parameter 
Weibull Distribution,”  Journal of the Royal Statistical Society, Vol.56(3), pp. 491-500. 
 
William, V. H., Ted, G. E. & Thomas, R. J. (2011) “Concerns About Maximum Likelihood Estimation 
for the Three-Parameter Weibull Distribution: Case Study of Statistical Software,” The American 
Statistician, 65:1, 44-54, DOI: 10.1198/tast.2011.09103. 
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Distribution Fitting – Goodness of Fit 
 
The Anderson Darling statistic measures how well the data fits a particular continuous distribution - 
the smaller the AD value, the better the fit. In general, when comparing several distributions, the 
distribution with the smallest AD statistic has the best fit to the data.  
 
Anderson Darling p-values are obtained from tabular interpolation.  These tables were produced 
using extensive Monte Carlo simulations, varying sample size and the shape parameter(s) - if 
applicable.  A minimum of 50,000 replications were used to obtain the critical values.   
 
For those distribution cases where published critical values exist, see D’Agostino & Stephens 
(1986), the simulation results were compared and found to be a close match (within 1% error for 
large sample asymptotic, 2.5% for small sample). 
 
In batch mode, all of the distributions are sorted by the AD statistic, smallest to largest. If the data 
set is large (N > 500), then a random subset of 500 is selected and AD is estimated.  The 10 
distributions with the lowest AD statistic are then recomputed using the entire data set and 
resorted.  This process dramatically speeds up the batch process for large data sets. 
 
The Chi-Square goodness of fit test and associated p-value are used when distribution fitting with 
discrete distributions. 
 
Reference for Anderson Darling Goodness of Fit: 

D'Agostino, R.B. and M.A. Stephens (1986). Goodness-of-Fit Techniques, Marcel Dekker. 
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Distribution Fitting – Nonnormal Process Capability Indices 
 

Z-Score Method (Default) 

The Z-Score method for computing process capability indices utilizes the inverse cdf of the normal 
distribution on the cdf of the nonnormal distribution.  Normal based capability indices are then 
applied to the transformed z-values.  This approach offers two key advantages: the relationship 
between the capability indices and calculated defects per million is consistent across the normal 
distribution and all nonnormal distributions, and short term capability indices Cp and Cpk can be 
estimated using the standard deviation from control chart methods on the transformed z-values. 
The Z-Score method was initially developed by Davis Bothe and expanded on by Andrew Sleeper.  
For further details, see Sleeper, Six Sigma Distribution Modeling. 

Percentile (ISO) Method 

The Percentile method to calculate process capability indices uses the following formulas: 

Ppu = (USL – 50th percentile)/(99.865 percentile – 50th percentile) 

Ppl = (50th percentile – LSL)/(50th percentile – 0.135 percentile) 

Ppk = min(Ppu, Ppl) 

Pp = (USL – LSL)/( 99.865 percentile – 0.135 percentile) 
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Distribution Fitting – Nonnormal Control Charts 
 

Individuals – Original Data 

The Individuals – Original Data chart displays the untransformed data with control limits calculated 
as: 

UCL = 99.865 percentile  

CL = 50th percentile 

LCL = 0.135 percentile 

The benefit of displaying this chart is that one can observe the original untransformed data.  Since 
the control limits are based on percentiles, this represents the overall, long term variation rather 
than the typical short term variation. The limits will likely be nonsymmetrical. 

Individuals/Moving Range – Normalized Data 

The Individuals/Moving Range – Normalized Data chart displays the transformed z-values with 
control limits calculated using standard Shewhart formulas for Individuals and Moving Range 
charts. The benefit of using this chart is that tests for special causes can be applied and the control 
limits are based on short term variation.  The disadvantage is that one is observing transformed 
data on the chart rather than the original data. 

References for Nonnormal Process Capability Indices and Control Charts: 

Bothe, D.R. (1997). Measuring Process Capability, McGraw-Hill, New York. 

Chou,Y., A.M. Polansky, and R.L. Mason (1998). “Transforming Non-Normal Data to Normality in 
Statistical Process Control,”  Journal of Quality Technology, Vol. 30(2), pp. 133-141. 
 

Sleeper, A. (2006). Six Sigma Distribution Modeling, McGraw-Hill, New York. 
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Summary of Distributions 
 
The following table is a summary of all distributions in DiscoverSim.   
 

Common Continuous Advanced Continuous Discrete 

• Normal 
• Triangular 
• Uniform 
• Pearson Family 

(specify Mean, 
StdDev, Skewness, 
Kurtosis) 

• Log Normal** 
• Exponential**  
• Weibull** 
• PERT 
• Custom Continuous 

 

• Beta 
• Beta (4 Parameter) 
• Box-Cox** 
• Burr** 
• Cauchy 
• Chi-Squared** 
• Chi-Squared with Scale  

(3 Parameter)** 
• Error Function (ERF) 
• F** 
• F with Scale (4 Parameter)** 
• Fatigue Life** 
• Fisk** 
• Folded Normal 
• Frechet** 
• Gamma** 
• Generalized Error 
• Generalized Gamma** 
• Generalized Logistic 
• Generalized Pareto 
• Half Normal** 
• Inverse Gamma** 
• Inverse Gaussian 
• Johnson SB 
• Johnson SL 
• Johnson SU 
• Laplace 
• Largest Extreme Value 
• Levy 
• Logistic 
• Log Gamma** 

• Bernoulli 
(Yes/No) 

• Binomial 
• Geometric 
• Hypergeometric 
• Logarithmic 
• Negative 

Binomial 
• Poisson 
• Step 
• Uniform 

(Discrete) 
• Custom 

Discrete 
• SIP (Stochastic 

Information 
Packet – 
Unweighted 
Sequential 
Custom 
Discrete) 
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Common Continuous Advanced Continuous Discrete 
• Log Logistic** 
• Maxwell 
• Non-Central Chi-Squared** 
• Non-Central F** 
• Non-Central T 
• Pareto 
• Power 
• Rayleigh 
• Reciprocal 
• Skew Normal 
• Smallest Extreme Value 
• Student’s T 
• Student’s T with Location and 

Scale (3 Parameter) 
• Von Mises 

 
 
** denotes with/without Threshold 
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Custom Distributions 
 
Custom Continuous 
 
Custom continuous distributions give you the flexibility to specify a wide range of distributions by 
specifying data values and weights that result in continuous “ramps” or “steps” as shown in the 
following examples.  The user must specify a Data Range (excluding label), and optional Weight 
Range (excluding label), Minimum and Maximum.  If Weight Range is not specified a default weight 
of 1 is used for each data value. Upon selection of the Data Range, the default Minimum and 
Maximum are obtained from the data. 
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Example 1: 
 

 
 
In this example, the same results would be obtained with Weight Range unchecked. 
 
Example 2: 
 

 
 
In this example, the same results would be obtained with Weight Range unchecked. 
 
  

Data Weight
1 1
2 1
3 1
4 1
5 1

Minimum 0
Maximum 6

Data Weight
1 1
2 1
3 1
4 1
5 1

Minimum 1
Maximum 5
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Example 3: 
 

 
 
 
Example 4: 

 
 
  

Data Weight
1 2
2 3
3 4
4 3
5 2

Minimum 0
Maximum 6

Data Weight
0 1
1 1
1 2
2 2
2 3
3 3
3 2
4 2
4 1
5 1

Minimum 0
Maximum 5
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Formulas for Custom Continuous Distribution  
  
Probability Density Function (PDF): 
 

𝑝𝑝𝑖𝑖 + (
𝑥𝑥 − 𝑥𝑥𝑖𝑖

2(𝑥𝑥𝑖𝑖+1 − 𝑥𝑥𝑖𝑖)
)(𝑝𝑝𝑖𝑖+1 − 𝑝𝑝𝑖𝑖)    𝑥𝑥𝑖𝑖 ≤ 𝑥𝑥 ≤ 𝑥𝑥𝑖𝑖+1 

 
Cumulative Distribution Function (CDF): 
 

𝐹𝐹(𝑥𝑥𝑖𝑖) + (𝑥𝑥 − 𝑥𝑥𝑖𝑖)(𝑝𝑝𝑖𝑖 +
(𝑥𝑥 − 𝑥𝑥𝑖𝑖)(𝑝𝑝𝑖𝑖+1 − 𝑝𝑝𝑖𝑖)

2(𝑥𝑥𝑖𝑖+1 − 𝑥𝑥𝑖𝑖)
)    𝑥𝑥𝑖𝑖 ≤ 𝑥𝑥 ≤ 𝑥𝑥𝑖𝑖+1 

 
where 𝑝𝑝𝑖𝑖 = 𝑤𝑤𝑖𝑖/∑𝑁𝑁

𝑗𝑗=1 (𝑤𝑤𝑗𝑗) and 𝐹𝐹(𝑥𝑥𝑖𝑖) = ∑𝑖𝑖
𝑗𝑗=1 (𝑝𝑝𝑗𝑗). 

 
𝑁𝑁 ordered data values 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 < 𝑥𝑥 < 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚. 
Probability weights 𝑤𝑤 > 0. 
Minimum value 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 (𝑤𝑤𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 = 0) 
Maximum value 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚  (𝑤𝑤𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 = 0) 
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Custom Discrete 
 
Custom discrete distributions give you the flexibility to specify a wide range of distributions by 
specifying integer data values and weights as shown in the following examples.  The user must 
specify a Data Range (excluding label) and Weight Range (excluding label). 
 
Example 1: 
 

 
 
In this example, the same results would be obtained with Weight Range unchecked. 
 
Example 2a (Weighted): 
 

 
  

Data Weight
1 1
2 1
3 1
4 1
5 1

Data Weight
1 2
2 3
3 4
4 3
5 2
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Example 2b (Unweighted): 
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Formulas for Custom Discrete Distribution  
 
Probability Density Function (PDF):  

𝑝𝑝𝑖𝑖    𝑥𝑥 = 𝑥𝑥𝑖𝑖 
 
 
Cumulative Distribution Function (CDF):  

 

�
𝑖𝑖

𝑗𝑗=1

(𝑝𝑝𝑗𝑗)    𝑥𝑥 = 𝑥𝑥𝑖𝑖  

 
where 𝑝𝑝𝑖𝑖 = 𝑤𝑤𝑖𝑖/∑𝑁𝑁

𝑗𝑗=1 (𝑤𝑤𝑗𝑗). 
 
𝑁𝑁 data values 𝑥𝑥. 
Probability weights 𝑤𝑤 > 0. 
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SIP Import 
 
A SIP is a Stochastic Information Packet that is a standard library of data (see 
ProbabilityManagement.org for more details on this standard).  DiscoverSim treats this as a Custom 
Discrete distribution with unweighted data and is sampled sequentially (unrandomized).   
 
A SIP cannot be included in Specified Input Correlations, nor can it be truncated.  The number of 
rows (nrows) in the SIP data should match the number of replicates (nreps), or nreps/nrows should 
be evenly divisible. 

  

http://www.probabilitymanagement.org/
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Formulas for Continuous Distributions 
 
For 𝑥𝑥 to be distributed by a continuous distribution, 𝑥𝑥 must be continuous and smooth over the 
specified range.  The formulas provided are the Probability Density Function (PDF) and Cumulative 
Distribution Function (CDF).  
 
Beta Distribution 
 
PDF  

1
𝐵𝐵(𝛼𝛼,𝛽𝛽)

𝑥𝑥𝛼𝛼−1(1 − 𝑥𝑥)𝛽𝛽−1 

CDF  

�
𝑥𝑥

−∞

1
𝐵𝐵(𝛼𝛼,𝛽𝛽)

𝑡𝑡𝛼𝛼−1(1− 𝑡𝑡)𝛽𝛽−1𝑑𝑑𝑑𝑑 

where 𝐵𝐵 is the Beta function (see Functions below). 
 
Range 0 ≤ 𝑥𝑥 ≤ 1. 
Shape1 parameter 𝛼𝛼 > 0. 
Shape2 parameter 𝛽𝛽 > 0. 
 
Beta Distribution with Minimum and Maximum  
 
PDF  

1
𝐵𝐵(𝛼𝛼,𝛽𝛽)

�
𝑥𝑥 − 𝜃𝜃1
𝜃𝜃2 − 𝜃𝜃1

�
𝛼𝛼−1

�
𝜃𝜃2 − 𝑥𝑥
𝜃𝜃2 − 𝜃𝜃1

�
𝛽𝛽−1

 

CDF  

�
𝑥𝑥−𝜃𝜃1
𝜃𝜃2−𝜃𝜃1

−∞

1
𝐵𝐵(𝛼𝛼,𝛽𝛽)

𝑡𝑡𝛼𝛼−1(1− 𝑡𝑡)𝛽𝛽−1𝑑𝑑𝑑𝑑 

where 𝐵𝐵 is the Beta function. 
  
Range 𝜃𝜃1 ≤ 𝑥𝑥 < 𝜃𝜃2. 
Shape1 parameter 𝛼𝛼 > 0. 
Shape2 parameter 𝛽𝛽 > 0. 
Minimum (lower threshold) 𝜃𝜃1 
Maximum (upper threshold) 𝜃𝜃2 
 
Notes: Estimation of the 4 parameter Beta distribution is undertaken in two parts. In the first part, 
initial parameter estimates are derived using the method of moments. The threshold parameters 
are then held using these values, and the shape parameters are then estimated using maximum 
likelihood. 
 
 



DiscoverSim: Appendix 

287 

BoxCox Distribution  
 
PDF  

𝑥𝑥𝜆𝜆−1

𝜎𝜎√2𝜋𝜋
𝑒𝑒−((𝑥𝑥𝜆𝜆−1)/𝜆𝜆−𝜇𝜇)2/2𝜎𝜎2  

CDF  

�
(𝑥𝑥𝜆𝜆−1)/𝜆𝜆

−∞

1
𝜎𝜎√2𝜋𝜋

𝑒𝑒−(𝑡𝑡−𝜇𝜇)2/2𝜎𝜎2𝑑𝑑𝑑𝑑 

Range 0 < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇, the mean. 
Scale parameter, 𝜎𝜎 > 0, the standard deviation. 
Shape parameter 𝜆𝜆. 
 
Notes: The concentrated likelihood is used in the ML estimation. This implies that the location and 
scale parameters are not estimated freely, but are derived as the mean and standard deviation of 
the BoxCox transformed variate. 
  
BoxCox Distribution with Threshold  
 
PDF  

(𝑥𝑥 − 𝜃𝜃)𝜆𝜆−1

𝜎𝜎√2𝜋𝜋
𝑒𝑒−(((𝑥𝑥−𝜃𝜃)𝜆𝜆−1)/𝜆𝜆−𝜇𝜇)2/2𝜎𝜎2  

CDF  

�
[(𝑥𝑥−𝜃𝜃)𝜆𝜆−1]/𝜆𝜆

−∞

1
𝜎𝜎√2𝜋𝜋

𝑒𝑒−(𝑡𝑡−𝜇𝜇)2/2𝜎𝜎2𝑑𝑑𝑑𝑑 

Range 0 < 𝑥𝑥 − 𝜃𝜃 < ∞. 
Location parameter, 𝜇𝜇, the mean. 
Scale parameter, 𝜎𝜎 > 0, the standard deviation. 
Shape parameter 𝜆𝜆. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Notes: The concentrated likelihood is used in the ML estimation. This implies that the location and 
scale parameters are not estimated freely, but are derived as the mean and standard deviation of 
the BoxCox transformed variate. 
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Burr Distribution 
 
PDF  

𝑐𝑐𝑐𝑐(𝑥𝑥/𝛽𝛽)𝑐𝑐−1

𝛽𝛽(1 + (𝑥𝑥/𝛽𝛽)𝑐𝑐)𝑘𝑘+1
 

CDF  
1 − (1 + (𝑥𝑥/𝛽𝛽)𝑐𝑐)−𝑘𝑘 

Range 0 ≤ 𝑥𝑥 < ∞. 
Scale parameter 𝛽𝛽 > 0. 
Shape parameter, 𝑐𝑐 > 0. 
Shape parameter, 𝑘𝑘 > 0. 
 
Burr Distribution with Threshold  
 
PDF  

𝑐𝑐𝑐𝑐((𝑥𝑥 − 𝜃𝜃)/𝛽𝛽)𝑐𝑐−1

𝛽𝛽(1 + ((𝑥𝑥 − 𝜃𝜃)/𝛽𝛽)𝑐𝑐)𝑘𝑘+1
 

CDF  
1 − (1 + ((𝑥𝑥 − 𝜃𝜃)/𝛽𝛽)𝑐𝑐)−𝑘𝑘 

Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter 𝛽𝛽 > 0. 
Shape parameter, 𝑐𝑐 > 0. 
Shape parameter, 𝑘𝑘 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Cauchy Distribution  
 
PDF  

�𝜋𝜋𝜋𝜋 �1 + �
𝑥𝑥 − 𝛼𝛼
𝛽𝛽

�
2
��

−1

 

CDF  

0.5 +
1
𝜋𝜋

tan−1 �
𝑥𝑥 − 𝛼𝛼
𝛽𝛽

� 

Range −∞ < 𝑥𝑥 < ∞. 
Location parameter 𝛼𝛼, the median. 
Scale parameter 𝛽𝛽 > 0. 
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Chi-Squared Distribution  
 
PDF  

𝑥𝑥𝑣𝑣/2exp(−𝑥𝑥/2)
2𝑣𝑣/2Γ(𝑣𝑣/2)

 

CDF  
𝛾𝛾(𝑣𝑣/2, 𝑥𝑥/2)
Γ(𝑣𝑣/2)

 

where Γ(𝑘𝑘) is the Gamma function, and 𝛾𝛾(𝑘𝑘, 𝑧𝑧)  is the lower incomplete Gamma function.  See 
Functions below. 
   
Range 0 ≤ 𝑥𝑥 ≤ ∞. 
Shape parameter 𝑣𝑣 > 0, the degrees of freedom. 
 
Chi-Squared Distribution with Threshold 
 
 PDF  

(𝑥𝑥 − 𝜃𝜃)𝑣𝑣/2exp(−(𝑥𝑥 − 𝜃𝜃)/2)
2𝑣𝑣/2Γ(𝑣𝑣/2)

 

CDF  
𝛾𝛾(𝑣𝑣/2, (𝑥𝑥 − 𝜃𝜃)/2)

Γ(𝑣𝑣/2)
 

where Γ(𝑘𝑘) is the Gamma function, and 𝛾𝛾(𝑘𝑘, 𝑧𝑧) is the lower incomplete Gamma function. 
   
Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 ≤ ∞. 
Shape parameter 𝑣𝑣 > 0, the degrees of freedom. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Chisq3: Chi-Squared Distribution with Scale  
 
PDF  

(𝑥𝑥/𝛽𝛽).5𝜈𝜈−1𝑒𝑒−0.5𝑥𝑥/𝛽𝛽

𝛽𝛽  2.5𝜈𝜈Γ(.5𝜈𝜈)
 

CDF  

�
.5𝑥𝑥/𝛽𝛽

0

𝑒𝑒−𝑡𝑡𝑡𝑡 .5𝜈𝜈−1

Γ(.5𝜈𝜈)
𝑑𝑑𝑑𝑑 

where Γ is the gamma function. 
 
Range 0 ≤ 𝑥𝑥 < ∞. 
Shape parameter 𝜈𝜈 > 0. 
Scale parameter 𝛽𝛽 > 0. 
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Chisq3: Chi-Squared Distribution with Scale and Threshold  
 
PDF  

((𝑥𝑥 − 𝜃𝜃)/𝛽𝛽).5𝜈𝜈−1𝑒𝑒−0.5(𝑥𝑥−𝜃𝜃)/𝛽𝛽

𝛽𝛽  2.5𝜈𝜈Γ(.5𝜈𝜈)
 

CDF  

�
.5(𝑥𝑥−𝜃𝜃)/𝛽𝛽

0

𝑒𝑒−𝑡𝑡𝑡𝑡 .5𝜈𝜈−1

Γ(.5𝜈𝜈)
𝑑𝑑𝑑𝑑 

where Γ is the gamma function. 
 
Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Shape parameter 𝜈𝜈 > 0. 
Scale parameter 𝛽𝛽 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Custom Continuous Distribution  
 
PDF  

𝑝𝑝𝑖𝑖 + (
𝑥𝑥 − 𝑥𝑥𝑖𝑖

2(𝑥𝑥𝑖𝑖+1 − 𝑥𝑥𝑖𝑖)
)(𝑝𝑝𝑖𝑖+1 − 𝑝𝑝𝑖𝑖)    𝑥𝑥𝑖𝑖 ≤ 𝑥𝑥 ≤ 𝑥𝑥𝑖𝑖+1 

CDF  

𝐹𝐹(𝑥𝑥𝑖𝑖) + (𝑥𝑥 − 𝑥𝑥𝑖𝑖)(𝑝𝑝𝑖𝑖 +
(𝑥𝑥 − 𝑥𝑥𝑖𝑖)(𝑝𝑝𝑖𝑖+1 − 𝑝𝑝𝑖𝑖)

2(𝑥𝑥𝑖𝑖+1 − 𝑥𝑥𝑖𝑖)
)    𝑥𝑥𝑖𝑖 ≤ 𝑥𝑥 ≤ 𝑥𝑥𝑖𝑖+1 

 
where 𝑝𝑝𝑖𝑖 = 𝑤𝑤𝑖𝑖/∑𝑁𝑁

𝑗𝑗=1 (𝑤𝑤𝑗𝑗) and 𝐹𝐹(𝑥𝑥𝑖𝑖) = ∑𝑖𝑖
𝑗𝑗=1 (𝑝𝑝𝑗𝑗). 

 
𝑁𝑁 ordered data values 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 < 𝑥𝑥 < 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚. 
Probability weights 𝑤𝑤 > 0. 
Minimum value 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 (𝑤𝑤𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 = 0) 
Maximum value 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚  (𝑤𝑤𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 = 0) 
 
ERF Distribution 
 
PDF  

𝛽𝛽𝑒𝑒−(𝛽𝛽𝑥𝑥)2

√𝜋𝜋
 

CDF  

�
𝑥𝑥

−∞

𝑒𝑒−(𝛽𝛽𝑡𝑡)2

√𝜋𝜋
𝑑𝑑𝑑𝑑 

Range −∞ < 𝑥𝑥 < ∞. 
Scale parameter 𝛽𝛽 > 0. 
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Exponential Distribution 
 
PDF  

𝑒𝑒−𝑥𝑥/𝛼𝛼

𝛼𝛼
 

CDF  
1 − 𝑒𝑒−𝑥𝑥/𝛼𝛼 

Range 0 ≤ 𝑥𝑥 < ∞. 
Scale parameter, 𝛼𝛼 > 0, the mean. 
 
Exponential Distribution with Threshold  
 
PDF  

𝑒𝑒−(𝑥𝑥−𝜃𝜃)/𝛼𝛼

𝛼𝛼
 

CDF  
1 − 𝑒𝑒−(𝑥𝑥−𝜃𝜃)/𝛼𝛼 

Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter, 𝛼𝛼 > 0, the mean. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
F Distribution  
 
PDF  

(𝑣𝑣/𝑤𝑤)𝑣𝑣/2𝑥𝑥(𝑣𝑣/2−1)

𝐵𝐵(𝑣𝑣/2,𝑤𝑤/2)[1 + (𝑣𝑣/𝑤𝑤)𝑥𝑥](𝑣𝑣+𝑤𝑤)/2) 

CDF  
𝐼𝐼 𝑣𝑣𝑣𝑣
𝑣𝑣𝑣𝑣+𝑤𝑤

(𝑣𝑣/2,𝑤𝑤/2) 

 
where 𝐵𝐵(𝑎𝑎, 𝑏𝑏) is the Beta function, and where 𝐼𝐼𝑥𝑥(𝑎𝑎, 𝑏𝑏) is the regularized incomplete Beta function. 
 
Range 0 ≤ 𝑥𝑥 ≤ ∞. 
Shape1 parameter 𝑣𝑣 > 0, integer, first degrees of freedom. 
Shape2 parameter 𝑤𝑤 > 0, integer, second degrees of freedom. 
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F Distribution with Threshold 
 
PDF  

(𝑣𝑣/𝑤𝑤)𝑣𝑣/2(𝑥𝑥 − 𝜃𝜃)(𝑣𝑣/2−1)

𝐵𝐵(𝑣𝑣/2,𝑤𝑤/2)[1 + (𝑣𝑣/𝑤𝑤)(𝑥𝑥 − 𝜃𝜃)](𝑣𝑣+𝑤𝑤)/2) 

CDF  
𝐼𝐼 𝑣𝑣𝑣𝑣
𝑣𝑣(𝑥𝑥−𝜃𝜃)+𝑤𝑤

(𝑣𝑣/2,𝑤𝑤/2) 

 
where 𝐵𝐵 is the Beta function, and where 𝐼𝐼𝑥𝑥(𝑎𝑎, 𝑏𝑏) is the regularized incomplete Beta function. 
  
Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Shape1 parameter 𝑣𝑣 > 0, integer, first degrees of freedom. 
Shape2 parameter 𝑤𝑤 > 0, integer, second degrees of freedom. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
F4: F Distribution with Scale  
 
PDF  

1
𝑥𝑥 B(. 5𝜈𝜈, .5𝜔𝜔) �

(𝜈𝜈 𝑥𝑥/𝛼𝛼)𝜈𝜈  𝜔𝜔𝜔𝜔

(𝜈𝜈 𝑥𝑥/𝛼𝛼 + 𝜔𝜔)𝜈𝜈+𝜔𝜔
 

CDF  

�
𝑧𝑧

−∞

1
𝐵𝐵(.5 𝜈𝜈, .5 𝜔𝜔)

𝑡𝑡 .5𝜈𝜈−1(1 − 𝑡𝑡).5𝜔𝜔−1𝑑𝑑𝑑𝑑 

 
where  

𝑧𝑧 =
(𝜈𝜈 𝑥𝑥)

(𝜈𝜈 𝑥𝑥 + 𝛼𝛼𝛼𝛼)
 

and where 𝐵𝐵 is the Beta function. 
 
Range 0 ≤ 𝑥𝑥 < ∞. 
Scale parameter 𝛼𝛼 > 0.  
Shape parameter 𝜈𝜈 > 0.  
Shape parameter 𝜔𝜔 > 0. 
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F4: F Distribution with Scale and Threshold  
 
PDF  

1
(𝑥𝑥 − 𝜃𝜃) B(. 5𝜈𝜈, .5𝜔𝜔) �

(𝜈𝜈 (𝑥𝑥 − 𝜃𝜃)/𝛼𝛼)𝜈𝜈  𝜔𝜔𝜔𝜔

(𝜈𝜈 (𝑥𝑥 − 𝜃𝜃)/𝛼𝛼 + 𝜔𝜔)𝜈𝜈+𝜔𝜔
 

CDF  

�
𝑧𝑧

−∞

1
𝐵𝐵(.5 𝜈𝜈, .5 𝜔𝜔)

𝑡𝑡 .5𝜈𝜈−1(1 − 𝑡𝑡).5𝜔𝜔−1𝑑𝑑𝑑𝑑 

 
where  

𝑧𝑧 =
(𝜈𝜈 (𝑥𝑥 − 𝜃𝜃))
(𝜈𝜈 𝑥𝑥 + 𝛼𝛼𝛼𝛼)

 

and where 𝐵𝐵 is the Beta function. 
 
Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter 𝛼𝛼 > 0.  
Shape parameter 𝜈𝜈 > 0.  
Shape parameter 𝜔𝜔 > 0. Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Fatigue Life Distribution 
 
PDF  

�
𝑥𝑥
𝛽𝛽 + �𝛽𝛽𝑥𝑥
2𝛾𝛾𝑥𝑥)

𝜙𝜙

⎝

⎜
⎛�

𝑥𝑥
𝛽𝛽 − �𝛽𝛽𝑥𝑥
𝛾𝛾

⎠

⎟
⎞

 

CDF  

Φ

⎝

⎛
√𝑥𝑥 − �1

𝑥𝑥
𝛾𝛾

⎠

⎞ 

where 𝜙𝜙(𝑥𝑥) and Φ(𝑥𝑥) are respectively the PDF and CDF of the standard normal distribution. 
   
Range 0 < 𝑥𝑥 < ∞. 
Scale parameter, 𝛽𝛽 > 0. 
Shape parameter 𝛾𝛾 > 0. 
 
Notes: This is also known as the Birnbaum Saunders distribution. 
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Fatigue Life Distribution with Threshold  
 
PDF  

�𝑥𝑥 − 𝜃𝜃
𝛽𝛽 + � 𝛽𝛽

𝑥𝑥 − 𝜃𝜃
2𝛾𝛾(𝑥𝑥 − 𝜃𝜃) 𝜙𝜙

⎝

⎜
⎛�

𝑥𝑥 − 𝜃𝜃
𝛽𝛽 − � 𝛽𝛽

𝑥𝑥 − 𝜃𝜃
𝛾𝛾

⎠

⎟
⎞

 

CDF  

Φ

⎝

⎛
√𝑥𝑥 − 𝜃𝜃 − � 1

𝑥𝑥 − 𝜃𝜃
𝛾𝛾

⎠

⎞ 

where 𝜙𝜙(𝑥𝑥) and Φ(𝑥𝑥) are respectively the PDF and CDF of the standard normal distribution. 
   
Range 0 < 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter, 𝛽𝛽 > 0. 
Shape parameter 𝛾𝛾 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Notes: This is also known as the Birnbaum Saunders distribution. 
 
Fisk Distribution  
 
PDF  

(𝛽𝛽/𝛼𝛼)(𝑥𝑥/𝛼𝛼)𝛽𝛽−1

[1 + (𝑥𝑥/𝛼𝛼)𝛽𝛽]2  

CDF  
11 + (𝑥𝑥/𝛼𝛼)−𝛽𝛽 

Range 0 < 𝑥𝑥 < ∞. 
Scale parameter 𝛼𝛼 > 0.  
Shape parameter, 𝛽𝛽 > 0.  
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Fisk Distribution with Threshold  
 
PDF  

(𝛽𝛽/𝛼𝛼)((𝑥𝑥 − 𝜃𝜃)/𝛼𝛼)𝛽𝛽−1

[1 + ((𝑥𝑥 − 𝜃𝜃)/𝛼𝛼)𝛽𝛽]2  

CDF  
11 + ((𝑥𝑥 − 𝜃𝜃)/𝛼𝛼)−𝛽𝛽 

Range 0 < 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter 𝛼𝛼 > 0.  
Shape parameter, 𝛽𝛽 > 0.  
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Folded Normal Distribution  
 
PDF  

√2𝜋𝜋
𝜎𝜎

cosh(𝜇𝜇/𝜎𝜎2)𝑒𝑒−(𝑥𝑥2+𝜇𝜇2)/2𝜎𝜎2  

CDF  

Φ�
𝑥𝑥 − 𝜇𝜇
𝜎𝜎

� − Φ�
−𝑥𝑥 − 𝜇𝜇
𝜎𝜎

� 

where Φ(𝑥𝑥) is the CDF of the standard normal distribution. 
  
Range 0 ≤ 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇, the mean. 
Scale parameter, 𝜎𝜎 > 0, the standard deviation. 
 
Frechet Distribution  
 
PDF  

(𝛽𝛽/𝛼𝛼)(𝛼𝛼/𝑥𝑥)1+𝛽𝛽𝑒𝑒−(𝛼𝛼/𝑥𝑥)𝛽𝛽  
CDF  

𝑒𝑒−(𝛼𝛼/𝑥𝑥)𝛽𝛽  
Range 0 ≤ 𝑥𝑥 < ∞. 
Scale parameter, 𝛼𝛼 > 0. 
Shape parameter 𝛽𝛽 > 0. 
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Frechet Distribution with Threshold  
 
PDF  

(𝛽𝛽/𝛼𝛼)(𝛼𝛼/(𝑥𝑥 − 𝜃𝜃))1+𝛽𝛽𝑒𝑒−(𝛼𝛼/(𝑥𝑥−𝜃𝜃))𝛽𝛽  
CDF  

𝑒𝑒−(𝛼𝛼/(𝑥𝑥−𝜃𝜃))𝛽𝛽  
Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter, 𝛼𝛼 > 0. 
Shape parameter 𝛽𝛽 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Gamma Distribution 
 
PDF  

(𝑥𝑥/𝛼𝛼)𝛽𝛽−1𝑒𝑒−𝑥𝑥/𝛼𝛼

𝛼𝛼Γ(𝛽𝛽)
 

CDF  

�
𝑥𝑥/𝛼𝛼

0

𝑒𝑒−𝑡𝑡𝑡𝑡𝛽𝛽−1

Γ(𝛽𝛽)
𝑑𝑑𝑑𝑑 

where Γ(𝛽𝛽) is the the Gamma function. 
 
Gamma Distribution with Threshold  
 
PDF  

[(𝑥𝑥 − 𝜃𝜃)/𝛼𝛼])𝛽𝛽−1𝑒𝑒−(𝑥𝑥−𝜃𝜃)/𝛼𝛼

𝛼𝛼Γ(𝛽𝛽)
 

CDF  

�
(𝑥𝑥−𝜃𝜃)/𝛼𝛼

0

𝑒𝑒−𝑡𝑡𝑡𝑡𝛽𝛽−1

Γ(𝛽𝛽)
𝑑𝑑𝑑𝑑 

where Γ(𝛽𝛽) is the the Gamma function:   
Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter 𝛼𝛼 > 0. 
Shape parameter 𝛽𝛽 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
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Generalized Error Distribution  
 
PDF  

𝛽𝛽
2𝛼𝛼Γ(1/𝛽𝛽)

  𝑒𝑒−(|𝑥𝑥−𝜇𝜇|/𝛼𝛼)𝛽𝛽 

CDF  

1
2

+ sign(𝑥𝑥 − 𝜇𝜇)
𝛾𝛾 �1/𝛽𝛽, �|𝑥𝑥 − 𝜇𝜇|

𝛼𝛼 �
𝛽𝛽
�

2Γ(1/𝛽𝛽)
 

where Γ(𝛽𝛽) is the the Gamma function and 𝛾𝛾(𝑘𝑘, 𝑧𝑧) is the lower incomplete Gamma function. 
 
Range −∞ ≤ 𝑥𝑥 < ∞. 
Location parameter 𝜇𝜇. Scale parameter 𝛼𝛼 > 0. 
Shape parameter 𝛽𝛽 > 0. 
 
Notes: This is also known as the Exponential Power distribution or the Generalized Normal 
distribution. 
 
Generalized Gamma Distribution 
 
PDF  

𝑝𝑝𝑥𝑥(𝑝𝑝𝑝𝑝−1)𝑒𝑒(−𝑥𝑥/𝛼𝛼𝑝𝑝)

𝛼𝛼𝑘𝑘𝑘𝑘Γ(𝑘𝑘)
 

CDF  
𝛾𝛾(𝑘𝑘, (𝑥𝑥/𝛼𝛼)𝑝𝑝) 

where Γ(𝛽𝛽) is the the Gamma function and 𝛾𝛾(𝑘𝑘, 𝑧𝑧) is the lower incomplete Gamma function. 
   
Range 0 ≤ 𝑥𝑥 < ∞. 
Scale parameter 𝛼𝛼 > 0. 
Shape1 parameter 𝑘𝑘 > 0. 
Shape2 parameter 𝑝𝑝 > 0. 
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Generalized Gamma Distribution with Threshold  
 
PDF  

𝑝𝑝(𝑥𝑥 − 𝜃𝜃)(𝑝𝑝𝑝𝑝−1)𝑒𝑒(−(𝑥𝑥−𝜃𝜃)/𝛼𝛼𝑝𝑝)

𝛼𝛼𝑘𝑘𝑘𝑘Γ(𝑘𝑘)
 

CDF  
𝛾𝛾(𝑘𝑘, [(𝑥𝑥 − 𝜃𝜃)/𝛼𝛼]𝑝𝑝) 

where Γ(𝛽𝛽) is the the Gamma function and 𝛾𝛾(𝑘𝑘, 𝑧𝑧) is the lower incomplete Gamma function. 
 
Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter 𝛼𝛼 > 0. 
Shape1 parameter 𝑘𝑘 > 0. 
Shape2 parameter 𝑝𝑝 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Generalized Logistic Distribution  
 
PDF  

𝛼𝛼𝑒𝑒−(𝑥𝑥−𝜇𝜇)/𝜎𝜎

𝜎𝜎(1 + 𝑒𝑒−(𝑥𝑥−𝜇𝜇)/𝜎𝜎)1+𝛼𝛼
 

CDF  
1

(1 + 𝑒𝑒−(𝑥𝑥−𝜇𝜇)/𝜎𝜎)𝛼𝛼
 

Range −∞ < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇.  
Scale parameter 𝜎𝜎 > 0. 
Skew parameter 𝛼𝛼, < 1 for left skew, > 1 for right skew. 
   
Notes: This is a Type I Generalized Logistic distribution; it is also known as the Skew-Logistic 
distribution. 
 
Generalized Pareto Distribution  
 
PDF  

1
𝛼𝛼
�1 + 𝛽𝛽  

𝑥𝑥 − 𝜇𝜇
𝛼𝛼

�
−(1+1/𝛽𝛽)

 

CDF  

1 − �1 + 𝛽𝛽  
𝑥𝑥 − 𝜇𝜇
𝛼𝛼

�
−1/𝛽𝛽

 

Range 0 < 𝑥𝑥 < ∞. 
Location parameter 𝜇𝜇. 
Scale parameter 𝛼𝛼 > 0. 
Shape parameter 𝛽𝛽 > 0.  
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Half Normal Distribution  
 
PDF  

�2/𝜋𝜋
𝜎𝜎2

𝑒𝑒−𝑥𝑥2/2𝜎𝜎2  

CDF  

�
𝑥𝑥

−∞

�2/𝜋𝜋
𝜎𝜎

𝑒𝑒−𝑡𝑡2/2𝜎𝜎2𝑑𝑑𝑑𝑑 − 1 

Range 0 ≤ 𝑥𝑥 < ∞. 
Scale parameter, 𝜎𝜎 > 0, the standard deviation. 
 
Half Normal Distribution with Threshold. 
 
PDF  

�2/𝜋𝜋
𝜎𝜎2

𝑒𝑒−(𝑥𝑥−𝜃𝜃)2/2𝜎𝜎2  

CDF  

�
𝑥𝑥−𝜃𝜃

−∞

�2/𝜋𝜋
𝜎𝜎

𝑒𝑒−𝑡𝑡2/2𝜎𝜎2𝑑𝑑𝑑𝑑 − 1 

Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter, 𝜎𝜎 > 0, the standard deviation. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Inverse Gamma Distribution  
 
PDF  

𝛼𝛼𝛽𝛽

Γ(𝛽𝛽)
𝑥𝑥−𝛽𝛽−1𝑒𝑒−𝛼𝛼/𝑥𝑥 

CDF  
𝛾𝛾(𝛽𝛽,𝛼𝛼/𝑥𝑥)
Γ(𝛽𝛽)

 

where Γ(𝑠𝑠) is the the gamma function, and 𝛾𝛾(𝑠𝑠, 𝑥𝑥) is the lower incomplete gamma function. 
 
Range 0 ≤ 𝑥𝑥 < ∞. 
Scale parameter 𝛼𝛼 > 0. 
Shape parameter 𝛽𝛽 > 0. 
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Inverse Gamma Distribution with Threshold  
 
PDF  

𝛼𝛼𝛽𝛽

Γ(𝛽𝛽)
(𝑥𝑥 − 𝜃𝜃)−𝛽𝛽−1𝑒𝑒−𝛼𝛼/(𝑥𝑥−𝜃𝜃) 

CDF  
𝛾𝛾(𝛽𝛽,𝛼𝛼/(𝑥𝑥 − 𝜃𝜃))

Γ(𝛽𝛽)
 

where Γ(𝑠𝑠) is the the gamma function, and 𝛾𝛾(𝑠𝑠, 𝑥𝑥) is the incomplete gamma function. 
 
Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter 𝛼𝛼 > 0. 
Shape parameter 𝛽𝛽 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Inverse Gaussian Distribution  
 
PDF  

�
𝜆𝜆

2𝜋𝜋𝑥𝑥3
�
1/2

𝑒𝑒−𝜆𝜆(𝑥𝑥−𝜇𝜇)2/(2𝜇𝜇2𝑥𝑥) 

CDF  

Φ��
𝜆𝜆
𝑥𝑥
�
𝑥𝑥
𝜇𝜇
− 1�� + 𝑒𝑒2𝜆𝜆/𝜇𝜇 Φ�−�

𝜆𝜆
𝑥𝑥
�
𝑥𝑥
𝜇𝜇

+ 1�� 

where Φ(𝑥𝑥) is the CDF of the standard normal distribution. 
 
Range 0 < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇, the mean. 
Shape parameter 𝜆𝜆 > 0. 
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Johnson SB Distribution  
 
PDF  

𝛿𝛿𝑒𝑒−.5(𝛾𝛾+𝛿𝛿ln(𝑧𝑧/(1−𝑧𝑧)))2

𝜆𝜆√2𝜋𝜋𝑧𝑧(1 − 𝑧𝑧)
 

CDF  

Φ�𝛾𝛾 + 𝛿𝛿ln �
𝑧𝑧

1 − 𝑧𝑧
�� 

where 𝑧𝑧 = (𝑥𝑥 − 𝜂𝜂)/𝜆𝜆 and Φ(𝑥𝑥) is the CDF of the standard normal distribution. 
   
Range 𝜂𝜂 < 𝑥𝑥 < 𝜂𝜂 + 𝜆𝜆. 
Location parameter, 𝜂𝜂, the mean. 
Scale parameter 𝜆𝜆 > 0. 
Shape1 parameter 𝛾𝛾. 
Shape2 parameter 𝛿𝛿 > 0. 
 
Johnson SL Distribution  
 
PDF  

𝛿𝛿𝜙𝜙 �𝛾𝛾 + 𝛿𝛿ln �𝑥𝑥 − 𝜂𝜂
𝜆𝜆 ��

(𝑥𝑥 − 𝜂𝜂)
 

CDF  

Φ�𝛾𝛾 + 𝛿𝛿ln �
𝑥𝑥 − 𝜂𝜂
𝜆𝜆

�� 
where 𝜙𝜙(𝑥𝑥) and Φ(𝑥𝑥) are respectively the PDF and CDF of the standard normal distribution. 
   
Range −𝜂𝜂 < 𝑥𝑥 < ∞. 
Location parameter, 𝜂𝜂, the mean. 
Scale parameter 𝜆𝜆 = 1. 
Shape1 parameter 𝛾𝛾. 
Shape2 parameter 𝛿𝛿. 
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Johnson SU Distribution 
 
PDF  

𝛿𝛿𝑒𝑒−.5(𝛾𝛾+𝛿𝛿sinh−1(𝑧𝑧))2

𝜆𝜆�2𝜋𝜋(𝑧𝑧2 + 1)
 

CDF  
Φ(𝛾𝛾 + 𝛿𝛿sinh−1(𝑧𝑧)) 

where 𝑧𝑧 = (𝑥𝑥 − 𝜂𝜂)/𝜆𝜆 and Φ(𝑥𝑥) is the CDF of the standard normal distribution. 
   
Range −∞ < 𝑥𝑥 < ∞. 
Location parameter, 𝜂𝜂, the mean. 
Scale parameter 𝜆𝜆 > 0. 
Shape1 parameter 𝛾𝛾. 
Shape2 parameter 𝛿𝛿 > 0. 
 
Laplace Distribution  
 
PDF  

1
2𝜎𝜎

𝑒𝑒−
|𝑥𝑥−𝜇𝜇|
𝜎𝜎  

CDF  
1

2𝜎𝜎
𝑒𝑒−

𝜇𝜇−𝑥𝑥
𝜎𝜎      𝑖𝑖𝑖𝑖   𝑥𝑥 < 𝜇𝜇 

 
1

2𝜎𝜎
𝑒𝑒−

𝑥𝑥−𝜇𝜇
𝜎𝜎      𝑖𝑖𝑖𝑖   𝑥𝑥 ≥ 𝜇𝜇 

  
Range −∞ < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇, the mean. 
Scale parameter 𝜎𝜎 > 0. 
 
Largest Extreme Value Distribution  
 
PDF  

1
𝜎𝜎
𝑒𝑒−(𝑥𝑥−𝜇𝜇)/𝜎𝜎𝑒𝑒−𝑒𝑒−(𝑥𝑥−𝜇𝜇)/𝜎𝜎  

CDF  
𝑒𝑒−𝑒𝑒−(𝑥𝑥−𝜇𝜇)/𝜎𝜎  

Range −∞ < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇, the mode. 
Scale parameter 𝜎𝜎 > 0. 
  
Notes: The Gumbel distribution is equivalent to the Largest Extreme Value. 
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Levy Distribution  
 
PDF  

�
𝜎𝜎

2𝜋𝜋
𝑒𝑒−𝜎𝜎/2𝑥𝑥

𝑥𝑥3/2  

CDF  
𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒��𝜎𝜎/2𝑥𝑥� 

Range 0 < 𝑥𝑥 < ∞. 
Scale parameter 𝜎𝜎 > 0. 
 
Levy Distribution with Threshold  
 
PDF  

�
𝜎𝜎

2𝜋𝜋
𝑒𝑒−𝜎𝜎/2(𝑥𝑥−𝜃𝜃)

(𝑥𝑥 − 𝜃𝜃)3/2 

CDF  
𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒��𝜎𝜎/2(𝑥𝑥 − 𝜃𝜃)� 

Range 0 < 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter 𝜎𝜎 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Log Gamma Distribution  
 
PDF  

ln(𝑥𝑥)𝛽𝛽−1𝑒𝑒−ln(𝑥𝑥)/𝛼𝛼

𝑥𝑥𝛼𝛼𝛽𝛽Γ(𝛽𝛽)
 

CDF  

�
ln(𝑥𝑥)/𝛼𝛼

0

𝑒𝑒−𝑡𝑡𝑡𝑡𝛽𝛽−1

Γ(𝛽𝛽)
𝑑𝑑𝑑𝑑 

where Γ is the gamma function. 
 
Range 0 ≤ 𝑥𝑥 < ∞. 
Scale parameter 𝛼𝛼 > 0. 
Shape parameter 𝛽𝛽 > 0. 
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Log Gamma Distribution with Threshold  
 
PDF  

ln(𝑥𝑥 − 𝜃𝜃)𝛽𝛽−1𝑒𝑒−ln(𝑥𝑥−𝜃𝜃)/𝛼𝛼

(𝑥𝑥 − 𝜃𝜃)𝛼𝛼𝛽𝛽Γ(𝛽𝛽)
 

CDF  

�
ln(𝑥𝑥−𝜃𝜃)/𝛼𝛼

0

𝑒𝑒−𝑡𝑡𝑡𝑡𝛽𝛽−1

Γ(𝛽𝛽)
𝑑𝑑𝑑𝑑 

where Γ is the gamma function. 
 
Range 0 < 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter 𝛼𝛼 > 0. 
Shape parameter 𝛽𝛽 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Logistic Distribution 
 
PDF  

𝑒𝑒(𝑥𝑥−𝜇𝜇)/𝜎𝜎

𝜎𝜎(1 + 𝑒𝑒(𝑥𝑥−𝜇𝜇)/𝜎𝜎)2
 

CDF  
1

1 + 𝑒𝑒−(𝑥𝑥−𝜇𝜇)/𝜎𝜎 

Range −∞ < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇, the mean. 
Scale parameter 𝜎𝜎 > 0. 
 
Log Logistic Distribution 
 
PDF  

𝑒𝑒(ln(𝑥𝑥)−𝜇𝜇)/𝜎𝜎

𝑥𝑥𝜎𝜎(1 + 𝑒𝑒(ln(𝑥𝑥)−𝜇𝜇)/𝜎𝜎)2
 

CDF  
1

1 + 𝑒𝑒−(ln(𝑥𝑥)−𝜇𝜇)/𝜎𝜎 

Range 0 < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇, the mean. 
Scale parameter 𝜎𝜎 > 0. 
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Log Logistic Distribution with Threshold  
 
PDF  

𝑒𝑒(ln(𝑥𝑥−𝜃𝜃)−𝜇𝜇)/𝜎𝜎

(𝑥𝑥 − 𝜃𝜃)𝜎𝜎(1 + 𝑒𝑒(ln(𝑥𝑥−𝜃𝜃)−𝜇𝜇)/𝜎𝜎)2
 

CDF  
1

1 + 𝑒𝑒−(ln(𝑥𝑥−𝜃𝜃)−𝜇𝜇)/𝜎𝜎 

Range 0 < 𝑥𝑥 − 𝜃𝜃 < ∞. 
Location parameter, 𝜇𝜇, the mean. 
Scale parameter 𝜎𝜎 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Log Normal Distribution 
 
PDF  

1
𝑥𝑥√2𝜋𝜋𝜎𝜎2

𝑒𝑒−.5(ln(𝑥𝑥)−𝜇𝜇)2/𝜎𝜎2  

CDF  

�
𝑥𝑥

−∞

1
𝑡𝑡𝜎𝜎√2𝜋𝜋

𝑒𝑒−.5(ln(𝑡𝑡)−𝜇𝜇)2/𝜎𝜎2𝑑𝑑𝑑𝑑 

Range 0 < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇, the mean of ln(𝑥𝑥) . 
Scale parameter, 𝜎𝜎 > 0, the standard deviation of ln(𝑥𝑥) . 
 
Log Normal Distribution with Threshold  
 
PDF  

1
(𝑥𝑥 − 𝜃𝜃)√2𝜋𝜋𝜎𝜎2

𝑒𝑒−.5(ln(𝑥𝑥−𝜃𝜃))−𝜇𝜇)2/𝜎𝜎2  

CDF  

�
𝑥𝑥−𝜃𝜃

−∞

1
𝑡𝑡𝜎𝜎√2𝜋𝜋

𝑒𝑒−.5(ln(𝑡𝑡)−𝜇𝜇)2/𝜎𝜎2𝑑𝑑𝑑𝑑 

Range 0 < 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter, 𝜇𝜇, the mean of ln(𝑥𝑥) . 
Shape parameter, 𝜎𝜎 > 0, the standard deviation of ln(𝑥𝑥) . 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
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Maxwell Boltzmann Distribution  
 
PDF  

�2
𝜋𝜋
𝑥𝑥2𝑒𝑒−𝑥𝑥2/(2𝑎𝑎2)

𝑎𝑎3
 

CDF  

𝛾𝛾 �1.5,
𝑥𝑥2

2𝑎𝑎2
� 

where 𝛾𝛾(𝑠𝑠, 𝑧𝑧) is the lower incomplete Gamma function. 
   
Range 0 < 𝑥𝑥 < ∞. 
Scale parameter 𝑎𝑎 > 0. 
 
Maxwell Boltzmann Distribution with Threshold 
 
PDF  

�2
𝜋𝜋

(𝑥𝑥 − 𝜃𝜃)2𝑒𝑒−(𝑥𝑥−𝜃𝜃)2/(2𝑎𝑎2)

𝑎𝑎3
 

CDF  

𝛾𝛾 �1.5,
(𝑥𝑥 − 𝜃𝜃)2

2𝑎𝑎2
� 

where 𝛾𝛾(𝑠𝑠, 𝑧𝑧) is the lower incomplete Gamma function. 
   
Range 0 < 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter 𝑎𝑎 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Non-Central Chi-Squared Distribution  
 
PDF  

. 5𝑒𝑒−(𝑥𝑥+.5𝜆𝜆) �
𝑥𝑥
𝜆𝜆
�

.25𝜈𝜈−.5
𝐼𝐼.5𝜈𝜈−1(√𝜆𝜆𝑥𝑥) 

CDF  

�
∞

𝑗𝑗=0

𝑒𝑒−.5𝜆𝜆 (.5𝜆𝜆)𝑗𝑗

𝑗𝑗!
𝛾𝛾(𝑗𝑗 + .5𝜈𝜈, .5𝑥𝑥)
Γ(𝑗𝑗 + .5𝑘𝑘)

 

where Γ(𝑠𝑠) is the gamma function, 𝛾𝛾(𝑠𝑠, 𝑥𝑥) is the lower incomplete gamma function. and 𝐼𝐼 is the 
modified Bessel function of the first kind. 
 
Range 0 ≤ 𝑥𝑥 < ∞. 
Shape parameter 𝜈𝜈 > 0. 
Non-centrality parameter 𝜆𝜆 > 0. 
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Non-Central Chi-Squared Distribution with Threshold  
 
PDF  

. 5𝑒𝑒−(𝑥𝑥−𝜃𝜃+.5𝜆𝜆) �
𝑥𝑥 − 𝜃𝜃
𝜆𝜆

�
.25𝜈𝜈−.5

𝐼𝐼.5𝜈𝜈−1(�𝜆𝜆(𝑥𝑥 − 𝜃𝜃)) 

CDF  

�
∞

𝑗𝑗=0

𝑒𝑒−.5𝜆𝜆 (.5𝜆𝜆)𝑗𝑗

𝑗𝑗!
𝛾𝛾(𝑗𝑗 + .5𝜈𝜈, .5(𝑥𝑥 − 𝜃𝜃))

Γ(𝑗𝑗 + .5𝑘𝑘)
 

where Γ(𝑠𝑠) is the gamma function, 𝛾𝛾(𝑠𝑠, 𝑥𝑥) is the lower incomplete gamma function. and 𝐼𝐼 is the 
modified Bessel function of the first kind. 
 
Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Shape parameter 𝜈𝜈 > 0. 
Non-centrality parameter 𝜆𝜆 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Non-Central F Distribution 
 
PDF  

�
∞

𝑘𝑘=0

𝑒𝑒−.5𝜆𝜆(.5𝜆𝜆)𝑘𝑘

𝐵𝐵(. 5𝜈𝜈2, .5𝜈𝜈1 + 𝑘𝑘)𝑘𝑘!
�
𝜈𝜈1
𝜈𝜈2
�

.5𝜈𝜈1+𝑘𝑘
�

𝜈𝜈2
𝜈𝜈2 + 𝜈𝜈1𝑥𝑥

�
.5(𝜈𝜈1+𝜈𝜈2)+𝑘𝑘

𝑥𝑥 .5𝜈𝜈1−1+𝑘𝑘 

CDF  

�
∞

𝑗𝑗=0

(.5𝜆𝜆)𝑗𝑗  𝑒𝑒−.5𝜆𝜆

𝑗𝑗!
𝐵𝐵(𝑧𝑧;  .5𝜈𝜈1 + 𝑗𝑗, .5𝜈𝜈2) 

where  

𝑧𝑧 =
𝜈𝜈1 𝑥𝑥

𝜈𝜈1𝑥𝑥 + 𝜈𝜈2
 

 
where 𝐵𝐵(𝑎𝑎, 𝑏𝑏) is the beta function, and 𝐵𝐵(𝑧𝑧;  𝑎𝑎, 𝑏𝑏) is the incomplete beta function. 
 
Range 0 ≤ 𝑥𝑥 < ∞. 
Shape parameter 𝜈𝜈1 > 0. 
Shape parameter 𝜈𝜈2 > 0. 
Non-centrality parameter 𝜆𝜆 > 0. 
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Non-Central F Distribution with Threshold   
 
PDF  

�
∞

𝑘𝑘=0

𝑒𝑒−.5𝜆𝜆(.5𝜆𝜆)𝑘𝑘

𝐵𝐵(. 5𝜈𝜈2, .5𝜈𝜈1 + 𝑘𝑘)𝑘𝑘!
�
𝜈𝜈1
𝜈𝜈2
�

.5𝜈𝜈1+𝑘𝑘
�

𝜈𝜈2
𝜈𝜈2 + 𝜈𝜈1(𝑥𝑥 − 𝜃𝜃)

�
.5(𝜈𝜈1+𝜈𝜈2)+𝑘𝑘

(𝑥𝑥 − 𝜃𝜃).5𝜈𝜈1−1+𝑘𝑘 

CDF  

�
∞

𝑗𝑗=0

(.5𝜆𝜆)𝑗𝑗  𝑒𝑒−.5𝜆𝜆

𝑗𝑗!
𝐵𝐵(𝑧𝑧;  .5𝜈𝜈1 + 𝑗𝑗, .5𝜈𝜈2) 

where  

𝑧𝑧 =
𝜈𝜈1(𝑥𝑥 − 𝜃𝜃)

𝜈𝜈1(𝑥𝑥 − 𝜃𝜃) + 𝜈𝜈2
 

 
where 𝐵𝐵(𝑎𝑎, 𝑏𝑏) is the beta function, and 𝐵𝐵(𝑧𝑧;  𝑎𝑎, 𝑏𝑏) is the incomplete beta function. 
 
Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Shape parameter 𝜈𝜈1 > 0. 
Shape parameter 𝜈𝜈2 > 0. 
Non-centrality parameter 𝜆𝜆 > 0. Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
 
Non-Central T Distribution 
 
PDF  

𝜈𝜈 .5𝜈𝜈𝑒𝑒−𝜈𝜈𝜆𝜆2/(2𝑥𝑥2+2𝜈𝜈)

√𝜋𝜋Γ(.5𝜈𝜈) 2.5(𝜈𝜈−1)(𝑥𝑥2 + 𝜈𝜈).5(𝜈𝜈+1)
�
∞

0
𝑡𝑡𝜈𝜈𝑒𝑒−.5(𝑡𝑡−𝜆𝜆𝑥𝑥/√𝑥𝑥2+𝜈𝜈 )2 𝑑𝑑𝑑𝑑 

CDF (𝑥𝑥 ≥ 0)  

Φ(−𝜆𝜆) +
1
2
�
∞

𝑗𝑗=0

�𝑝𝑝𝑗𝑗𝐼𝐼𝑧𝑧 �𝑗𝑗 +
1
2

,
𝜈𝜈
2
� + 𝑞𝑞𝑗𝑗𝛽𝛽𝑧𝑧 �𝑗𝑗 + 1,

𝜈𝜈
2
�� 

where  

𝑧𝑧 =
𝑥𝑥2

𝑥𝑥2 + 𝜈𝜈
 

𝑝𝑝𝑗𝑗 =
𝑒𝑒−.5𝜆𝜆2

𝑗𝑗!
�
𝜆𝜆2

2
�
𝑗𝑗

 

𝑞𝑞𝑗𝑗 =
𝜆𝜆𝑒𝑒−.5𝜆𝜆2

√2Γ(𝑗𝑗 + 3/2)
�
𝜆𝜆2

2
�
𝑗𝑗

 

 and where Φ is the standard normal CDF, Γ is the gamma function, and 𝐼𝐼𝑧𝑧(𝑎𝑎, 𝑏𝑏) is the regularized 
incomplete beta function. 
 
Range −∞ ≤ 𝑥𝑥 < ∞. 
Shape parameter 𝜈𝜈 > 0. 
Non-centrality parameter 𝜆𝜆 > 0. 
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Normal Distribution  
 
PDF  

1
√2𝜋𝜋𝜎𝜎2

𝑒𝑒−.5(𝑥𝑥−𝜇𝜇)2/𝜎𝜎2  

CDF  

�
𝑥𝑥

−∞

1
√2𝜋𝜋𝜎𝜎2

𝑒𝑒−.5(𝑡𝑡−𝜇𝜇)2/𝜎𝜎2𝑑𝑑𝑑𝑑 

Range −∞ < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇, the mean. 
Scale parameter, 𝜎𝜎 > 0, the standard deviation. 
 
Pareto Distribution  
 
PDF  

𝛼𝛼 𝑥𝑥m𝛼𝛼

𝑥𝑥𝛼𝛼+1
 

CDF  

1 − �
𝑥𝑥m
𝑥𝑥
�
𝛼𝛼

 

Range 𝑥𝑥𝑚𝑚 < 𝑥𝑥 < ∞. 
Location parameter 𝑥𝑥𝑚𝑚 > 0, the minimum of 𝑥𝑥.  
Shape parameter 𝛼𝛼 > 0. 
 
Pearson Distribution 
 
The Pearson family consists of eight distributions:   
Type 0    Normal distribution.  
Type 1    Beta distribution with minimum and maximum.  
Type 2    Symmetric Beta distribution with minimum and maximum. The symmetry is imposed by 
requiring the two shape parameters to have the same value.  
Type 3    Gamma distribution with threshold.  
Type 4    Pearson IV distribution.  
Type 5    Inverse Gamma distribution with threshold.  
Type 6    F distribution with location and scale.  
Type 7    Student's T distribution with location and scale  
 The Pearson methodology selects one member of the family using the methodology described in 
Johnson, Kotz and Balakrishnan. 
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Pearson Type IV Distribution  
 
PDF  

𝑘𝑘(𝜈𝜈,𝜔𝜔)
𝜆𝜆

 �
1

1 + 𝑧𝑧2
�
𝜔𝜔

𝑒𝑒−𝜈𝜈 𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎(𝑧𝑧) 

CDF  

�
𝑧𝑧

−∞

𝑘𝑘(𝜈𝜈,𝜔𝜔)
𝜆𝜆

 �
1

1 + 𝑡𝑡2
�
𝜔𝜔

𝑒𝑒−𝜈𝜈 𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎(𝑡𝑡) 𝑑𝑑𝑑𝑑 

where  
𝑏𝑏 = 2(𝜔𝜔 − 1) 

𝑎𝑎 = �𝑏𝑏
3 − 𝑏𝑏2

𝑏𝑏2 + 𝜈𝜈2
 

𝑧𝑧 =
𝑥𝑥 − 𝜇𝜇
𝑎𝑎𝜆𝜆

−
𝜈𝜈
𝑏𝑏

 

 and 𝑘𝑘(𝜈𝜈,𝜔𝜔) is a scaling constant. 
  
Range 0 ≤ 𝑥𝑥 < ∞. 
Location parameter 𝜇𝜇  
Scale parameter, 𝜆𝜆 > 0. 
Shape parameter 𝜈𝜈. 
Shape parameter 𝜔𝜔 > 1.5. 
 
PERT Distribution  
 
PDF  

1
𝐵𝐵(𝛼𝛼,𝛽𝛽)

𝑥𝑥𝛼𝛼−1(1 − 𝑥𝑥)𝛽𝛽−1 

CDF  

�
𝑥𝑥

−∞

1
𝐵𝐵(𝛼𝛼,𝛽𝛽)

𝑡𝑡𝛼𝛼−1(1− 𝑡𝑡)𝛽𝛽−1𝑑𝑑𝑑𝑑 

where 𝐵𝐵 is the Beta function. 
  
Range 𝑙𝑙𝑙𝑙 ≤ 𝑧𝑧 ≤ 𝑢𝑢𝑢𝑢. 
Parameter 𝑙𝑙𝑙𝑙:    𝑙𝑙𝑙𝑙 < 𝑧𝑧𝑚𝑚𝑚𝑚𝑚𝑚, the lower bound of 𝑧𝑧. 
Parameter 𝑢𝑢𝑢𝑢:    𝑧𝑧𝑚𝑚𝑚𝑚𝑚𝑚 < 𝑢𝑢𝑢𝑢, the upper bound of 𝑧𝑧.  
Parameter 𝜂𝜂:    𝑙𝑙𝑙𝑙 < 𝜂𝜂 < 𝑢𝑢𝑢𝑢, the mode of 𝑧𝑧.  
 
Notes: The PERT argument 𝑧𝑧 and the three parameters, 𝑙𝑙𝑙𝑙, 𝑢𝑢𝑢𝑢 and 𝜂𝜂 are transformed using the PERT 
transform; the resulting argument, 𝑥𝑥 is distributed Beta, with shape parameters 𝛼𝛼 and 𝛽𝛽. 
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Power Distribution  
 
PDF  

𝜈𝜈(𝑥𝑥 − 𝑎𝑎)𝜈𝜈−1

(𝑏𝑏 − 𝑎𝑎)𝜈𝜈
 

CDF  
(𝑥𝑥 − 𝑎𝑎)𝜈𝜈

(𝑏𝑏 − 𝑎𝑎)𝜈𝜈
 

 
Range 𝑎𝑎 ≤ 𝑥𝑥 ≤ 𝑏𝑏. 
Lowerbound parameter 𝑎𝑎 > 0. 
Upperbound parameter b. 
Shape parameter 𝜈𝜈 > 0. 
 
Rayleigh Distribution  
 
PDF  

𝑥𝑥
𝛼𝛼2

𝑒𝑒−𝑥𝑥2/(2𝛼𝛼2) 

CDF  
1 − 𝑒𝑒−𝑥𝑥2/(2𝛼𝛼2) 

Range 0 ≤ 𝑥𝑥 < ∞. 
Scale parameter, 𝛼𝛼 > 0. 
 
Reciprocal Distribution  
 
PDF  

1
𝑥𝑥(ln(𝑏𝑏) − ln(𝑎𝑎))

 

CDF  
ln(𝑥𝑥) − ln(𝑎𝑎)
ln(𝑏𝑏) − ln(𝑎𝑎)

 

 
Range 𝑎𝑎 ≤ 𝑥𝑥 ≤ 𝑏𝑏. 
Lowerbound parameter 𝑎𝑎 > 0. 
Upperbound parameter b. 
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Skew Normal Distribution  
 
PDF  

2
𝜎𝜎
Φ�

𝛼𝛼(𝑥𝑥 − 𝜇𝜇)
𝜎𝜎

�𝜙𝜙 �
𝑥𝑥 − 𝜇𝜇
𝜎𝜎

� 

CDF  

2 cdfbvn �
𝑥𝑥 − 𝜇𝜇
𝜎𝜎

, 0,
−𝛼𝛼

√1 + 𝛼𝛼2
� 

where 𝜙𝜙(𝑥𝑥) and Φ(𝑥𝑥) are respectively the PDF and CDF of the standard normal distribution, and 
cdfbvn is the cumulative standardized bivariate normal distribution. 
  
Range −∞ < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇.  
Scale parameter 𝜎𝜎 > 0. 
Skew parameter 𝛼𝛼, negative for left skew, positive for right skew. 
 
Smallest Extreme Value Distribution  
 
PDF  

1
𝜎𝜎
𝑒𝑒(𝑥𝑥−𝜇𝜇)/𝜎𝜎𝑒𝑒−𝑒𝑒(𝑥𝑥−𝜇𝜇)/𝜎𝜎  

CDF  
1 − 𝑒𝑒−𝑒𝑒(𝑥𝑥−𝜇𝜇)/𝜎𝜎  

Range −∞ < 𝑥𝑥 < ∞. 
Location parameter, 𝜇𝜇, the mode. 
Scale parameter 𝜎𝜎 > 0. 
 
Student's T Distribution 
 
PDF  

Γ(𝜈𝜈 + 1
2 )

√𝜈𝜈𝜈𝜈 Γ(𝜈𝜈2)
�1 +

𝑥𝑥2

𝜈𝜈
�
−(𝜈𝜈+12 )

 

CDF  

1
2

+ 𝑥𝑥Γ �
𝜈𝜈 + 1

2
�

 2𝐹𝐹1 �
1
2 , 𝜈𝜈 + 1

2 ; 3
2 ;−𝑥𝑥

2

𝜈𝜈 �

√𝜋𝜋𝜋𝜋 Γ(𝜈𝜈2)
 

where  2𝐹𝐹1 is the hypergeometric function.  
  
Range −∞ < 𝑥𝑥 < ∞. 
Shape parameter 𝜈𝜈 > 0, degrees of freedom.  
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T3: Student's T Distribution with Location and Scale  
 
PDF  

1
𝛼𝛼 √𝜋𝜋 𝜈𝜈

Γ(.5(𝜈𝜈 + 1))
Γ(.5𝜈𝜈)

�
𝜈𝜈𝛼𝛼2

(𝑥𝑥 − 𝜇𝜇)2 + 𝜈𝜈𝛼𝛼2
�

.5(𝜈𝜈+1)

 

CDF  
. 5 + .5 𝐼𝐼𝑧𝑧(.5, .5𝜈𝜈)    𝑥𝑥 ≥ 0 

 
. 5 − .5 𝐼𝐼𝑧𝑧(.5, .5𝜈𝜈)    𝑥𝑥 < 0 

where  

𝑧𝑧 =
(𝑥𝑥 − 𝜇𝜇)2

(𝑥𝑥 − 𝜇𝜇)2 + 𝜈𝜈𝛼𝛼2
 

and where Γ is the gamma function, and 𝐼𝐼𝑧𝑧(𝑎𝑎, 𝑏𝑏) is the regularized incomplete beta function. 
 
Range −∞ ≤ 𝑥𝑥 < ∞. 
Location parameter 𝜇𝜇. 
Scale parameter 𝛼𝛼 > 0.  
Shape parameter 𝜈𝜈 > 0. 
 
Triangular Distribution  
 
PDF  

2(𝑥𝑥 − 𝑎𝑎)
(𝑏𝑏 − 𝑎𝑎)(𝑐𝑐 − 𝑎𝑎)

    for  𝑎𝑎 ≤ 𝑥𝑥 ≤ 𝑐𝑐 

 
2(𝑏𝑏 − 𝑥𝑥)

(𝑏𝑏 − 𝑎𝑎)(𝑏𝑏 − 𝑐𝑐)
    for  𝑐𝑐 ≤ 𝑥𝑥 ≤ 𝑏𝑏 

CDF  
(𝑥𝑥 − 𝑎𝑎)2

(𝑏𝑏 − 𝑎𝑎)(𝑐𝑐 − 𝑎𝑎)
    for  𝑎𝑎 ≤ 𝑥𝑥 ≤ 𝑐𝑐 

 

1 −
(𝑏𝑏 − 𝑥𝑥)2

(𝑏𝑏 − 𝑎𝑎)(𝑏𝑏 − 𝑐𝑐)
    for  𝑐𝑐 ≤ 𝑥𝑥 ≤ 𝑏𝑏 

  
Range 𝑎𝑎 ≤ 𝑥𝑥 ≤ 𝑏𝑏. 
Parameter 𝑎𝑎:    𝑎𝑎 ≤ 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚, the lower bound of 𝑥𝑥. 
Parameter 𝑏𝑏:    𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 ≤ 𝑏𝑏, the upper bound of 𝑥𝑥. 
Parameter 𝑐𝑐:    𝑎𝑎 < 𝑐𝑐 < 𝑏𝑏, the mode of 𝑥𝑥. 
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Uniform Distribution 
 
PDF  

1
𝑏𝑏 − 𝑎𝑎

 

CDF  
𝑥𝑥 − 𝑎𝑎
𝑏𝑏 − 𝑎𝑎

 

  
Range 𝑎𝑎 ≤ 𝑥𝑥 ≤ 𝑏𝑏. 
Parameter 𝑎𝑎:    𝑎𝑎 ≤ 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚, the lower bound of 𝑥𝑥. 
Parameter 𝑏𝑏:    𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 ≤ 𝑏𝑏, the upper bound of 𝑥𝑥. 
 
Von Mises Distribution  
 
PDF  

𝑒𝑒𝜅𝜅cos(𝑥𝑥−𝜇𝜇)

2𝜋𝜋𝐼𝐼0(𝜅𝜅)
 

CDF  

1
2𝜋𝜋

�𝑥𝑥 +
2

𝐼𝐼0(𝜅𝜅)
�
∞

𝑗𝑗=1

𝐼𝐼𝑗𝑗(𝜅𝜅)
sin[𝑗𝑗(𝑥𝑥 − 𝜇𝜇)]

𝑗𝑗
� 

where 𝐼𝐼𝑗𝑗(𝑥𝑥) is the modified Bessel function of order 𝑗𝑗.  
 
Range 0 ≤ 𝑥𝑥 < 2𝜋𝜋. 
Location parameter, 𝜇𝜇:    0 ≤ 𝜇𝜇 ≤ 2𝜋𝜋. 
Shape parameter 𝜅𝜅 > 0. 
 
Weibull Distribution 
 
PDF  

𝛽𝛽𝑥𝑥𝛽𝛽−1

𝛼𝛼𝛽𝛽
𝑒𝑒−(𝑥𝑥/𝛼𝛼)𝛽𝛽  

CDF  
1 − 𝑒𝑒−(𝑥𝑥/𝛼𝛼)𝛽𝛽 

Range 0 ≤ 𝑥𝑥 < ∞. 
Scale parameter, 𝛼𝛼 > 0, the characteristic life. 
Shape parameter 𝛽𝛽 > 0. 
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Weibull Distribution with Threshold  
 
PDF  

𝛽𝛽𝑥𝑥𝛽𝛽−1

𝛼𝛼𝛽𝛽
𝑒𝑒−[(𝑥𝑥−𝜃𝜃)/𝛼𝛼]𝛽𝛽 

CDF  
1 − 𝑒𝑒−[𝑥𝑥−𝜃𝜃)/𝛼𝛼]𝛽𝛽  

Range 0 ≤ 𝑥𝑥 − 𝜃𝜃 < ∞. 
Scale parameter, 𝛼𝛼 > 0. 
Shape parameter 𝛽𝛽 > 0. 
Threshold parameter 𝜃𝜃 < 𝑚𝑚𝑚𝑚𝑚𝑚(𝑥𝑥). 
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Formulas for Discrete Distributions 
 
For 𝑥𝑥 to be distributed by a discrete distribution, 𝑥𝑥 must only take discrete integer values over the 
specified range.  The formulas provided are the Probability Density Function (PDF) and Cumulative 
Distribution Function (CDF).  
 
Bernoulli Distribution  
 
The Bernoulli distribution takes a value 1 with probability 𝑝𝑝  and value 0 with probability 1 − 𝑝𝑝. 
 
PDF  

𝑥𝑥𝑥𝑥 + (1 − 𝑥𝑥)(1− 𝑝𝑝) 
CDF  

1 − 𝑝𝑝 + 𝑝𝑝𝑝𝑝 
 
Support 𝑥𝑥 ∈ {0,1}. 
Probability parameter, 𝑝𝑝:    0 ≤ 𝑝𝑝 ≤ 1. 
 
Binomial Distribution  
 
The binomial pdf is the probability of 𝑥𝑥 successes in 𝑛𝑛 independent trials, where 𝑝𝑝 is the probability 
of success in any given trial.  
  
PDF  

�𝑛𝑛𝑥𝑥� 𝑝𝑝
𝑥𝑥(1 − 𝑝𝑝)𝑛𝑛−𝑥𝑥 

CDF  
𝐼𝐼1−𝑝𝑝(𝑛𝑛 − 𝑥𝑥, 𝑥𝑥 + 1) 

where 𝐼𝐼𝑥𝑥(𝑎𝑎, 𝑏𝑏) is the regularized incomplete Beta function. 
  
Support 𝑥𝑥 ∈ {0, … ,𝑛𝑛}. 
Probability parameter, 𝑝𝑝:    0 ≤ 𝑝𝑝 ≤ 1. 
Trials parameter, 𝑛𝑛:    𝑛𝑛 > 0. 
 
Custom Discrete Distribution  
 
PDF  

𝑝𝑝𝑖𝑖    𝑥𝑥 = 𝑥𝑥𝑖𝑖 
CDF  

�
𝑖𝑖

𝑗𝑗=1

(𝑝𝑝𝑗𝑗)    𝑥𝑥 = 𝑥𝑥𝑖𝑖  

where 𝑝𝑝𝑖𝑖 = 𝑤𝑤𝑖𝑖/∑𝑁𝑁
𝑗𝑗=1 (𝑤𝑤𝑗𝑗). 
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𝑁𝑁 data values 𝑥𝑥. 
Probability weights 𝑤𝑤 > 0. 
 
 
Geometric Distribution  
 
The geometric pdf is the probability of 𝑥𝑥  failures before a success, where 𝑝𝑝 is the probability of 
success in any given trial.  
  
PDF  

𝑝𝑝(1 − 𝑝𝑝)𝑥𝑥 
CDF  

1 − (1 − 𝑝𝑝)𝑥𝑥+1 
  
Support 𝑥𝑥 ∈ {1,2,3, … }. 
Probability parameter, 𝑝𝑝:    0 ≤ 𝑝𝑝 ≤ 1. 
 
Hypergeometric Distribution  
 
The Hypergeometric pdf is the probability of drawing 𝑥𝑥 successes in 𝑛𝑛 draws, without replacement, 
from a population of size 𝑁𝑁 which contains 𝑚𝑚 successes. 
 
PDF 

 
 
 
CDF 

 
  
Support 𝑥𝑥 ∈ {1,2,3, … }. 
Population parameter, 𝑁𝑁:    𝑁𝑁 > 0.  
Success parameter, 𝑚𝑚:    𝑚𝑚 > 0.  
Sample parameter, 𝑛𝑛:    𝑛𝑛 > 0.  
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Logarithmic Distribution  
 
The Logarithmic pdf is a one parameter generalized power series distribution. 
 
PDF  

−𝑝𝑝𝑥𝑥

𝑥𝑥 ln(1 − 𝑝𝑝)
 

CDF  

1 +
𝐵𝐵(𝑝𝑝; 𝑥𝑥 + 1,0)

ln(1 − 𝑝𝑝)
 

 
where B(x; a,b) is the incomplete beta function. 
 
Support 𝑥𝑥 ∈ {1,2,3, … }. 
Probability parameter, 𝑝𝑝:    0 ≤ 𝑝𝑝 ≤ 1. 
 
Negative Binomial Distribution  
 
The Negative Binomial pdf is the probability of achieving 𝑟𝑟 failures before the 𝑥𝑥th success, with 𝑝𝑝 
being the probability of a success. 
  
PDF 

  
 
CDF  

1 − 𝐼𝐼𝑝𝑝(𝑥𝑥 + 1, 𝑟𝑟) 
 
where 𝐼𝐼𝑥𝑥(𝑎𝑎, 𝑏𝑏) is the regularized incomplete Beta function. 
 
Support 𝑥𝑥 ∈ {1,2,3, … }. 
Probability parameter, 𝑝𝑝:    0 ≤ 𝑝𝑝 ≤ 1. 
Failure parameter, 𝑟𝑟:    𝑟𝑟 > 0.  
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Poisson Distribution  
 
The Poisson pdf is the probability of 𝑥𝑥 events occurring within a period, where 𝜆𝜆 is the expected 
number of events in that period. 
 
PDF  

𝜆𝜆𝑥𝑥

𝑥𝑥!
 𝑒𝑒−𝜆𝜆 

CDF  

𝑒𝑒−𝜆𝜆�
𝑥𝑥

𝑖𝑖=0

�
𝜆𝜆𝑖𝑖

𝑖𝑖!
� 

 
Support 𝑥𝑥 ∈ {1,2,3, … }. 
Event parameter, 𝜆𝜆:    𝑟𝑟 > 0, the mean of 𝑥𝑥. 
 
Step Distribution  
 
The step pdf is the same for each step. 
  
PDF  

𝑠𝑠
𝑏𝑏 − 𝑎𝑎 + 𝑠𝑠

 

CDF  
𝑥𝑥 − 𝑎𝑎 + 𝑠𝑠
𝑏𝑏 − 𝑎𝑎 + 𝑠𝑠

 

  
Support 𝑥𝑥 ∈ {𝑎𝑎, … , 𝑏𝑏}. 
Parameter 𝑎𝑎:    𝑎𝑎 ≤ 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚, the lower bound of 𝑥𝑥. 
Parameter 𝑏𝑏:    𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 ≤ 𝑏𝑏, the upper bound of 𝑥𝑥.  
Parameter 𝑠𝑠, the stepsize.  
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Uniform Distribution  
 
The Uniform pdf is the same for each outcome. 
 
PDF  

1
𝑏𝑏 − 𝑎𝑎 + 1

 

CDF  
𝑥𝑥 − 𝑎𝑎 + 1
𝑏𝑏 − 𝑎𝑎 + 1

 

 
Support 𝑥𝑥 ∈ {𝑎𝑎, … , 𝑏𝑏}. 
Parameter 𝑎𝑎:    𝑎𝑎 ≤ 𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚, the lower bound of 𝑥𝑥. 
Parameter 𝑏𝑏:    𝑥𝑥𝑚𝑚𝑚𝑚𝑚𝑚 ≤ 𝑏𝑏, the upper bound of 𝑥𝑥.  
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Functions Used by Distributions 
 
Beta Function  
 

𝐵𝐵(𝛼𝛼,𝛽𝛽) =
Γ(𝛼𝛼)Γ(𝛽𝛽)
Γ(𝛼𝛼 + 𝛽𝛽)

 

  
Gamma Function  
 

Γ(𝛽𝛽) = �
∞

0
𝑒𝑒−𝑡𝑡𝑡𝑡𝛽𝛽−1𝑑𝑑𝑑𝑑 

  
Incomplete Beta Function  
 

𝐵𝐵(𝑥𝑥;  𝑎𝑎, 𝑏𝑏) = �
𝑥𝑥

0
𝑡𝑡𝑎𝑎−1 (1 − 𝑡𝑡)𝑏𝑏−1 𝑑𝑑𝑑𝑑 

  
Incomplete Beta Function (regularized)  
 

𝐼𝐼𝑥𝑥(𝑎𝑎, 𝑏𝑏) =
𝐵𝐵(𝑥𝑥;  𝑎𝑎, 𝑏𝑏)
𝐵𝐵(𝑎𝑎, 𝑏𝑏)

 

  
Incomplete Gamma Function (lower)  
 

𝛾𝛾(𝑠𝑠, 𝑥𝑥) = �
𝑥𝑥

0
𝑡𝑡𝑠𝑠−1 𝑒𝑒−𝑡𝑡 𝑑𝑑𝑑𝑑 

  
Incomplete Gamma Function (regularized)  
 

𝑃𝑃(𝑠𝑠, 𝑥𝑥) =
𝛾𝛾(𝑠𝑠, 𝑥𝑥)
Γ(𝑠𝑠)

 

  
Modified Bessel Function  
 

𝐼𝐼𝛼𝛼(𝑥𝑥) = �
∞

𝑚𝑚=0

1
𝑚𝑚! Γ(𝑚𝑚 + 𝛼𝛼 + 1)

�
𝑥𝑥
2
�
2𝑚𝑚+𝛼𝛼
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Psychometrika, Vol. 45(2), pp. 273-279. 
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About SigmaXL, Inc.   
 
Established in 1998, SigmaXL Inc. is a leading provider of user friendly Excel Add-ins for Lean Six 
Sigma graphical and statistical tools and Monte Carlo simulation.  

Our flagship product, SigmaXL®, was designed from the ground up to be a cost-effective, powerful, 
but easy to use tool that enables users to measure, analyze, improve and control their service, 
transactional, and manufacturing processes. As an add-in to the already familiar Microsoft Excel, 
SigmaXL® is ideal for Lean Six Sigma training and application, or use in a college statistics course. 

DiscoverSim™ enables you to quantify your risk through Monte Carlo simulation and minimize your 
risk with global optimization. Business decisions are often based on assumptions with a single point 
value estimate or an average, resulting in unexpected outcomes. DiscoverSim™ allows you to 
model the uncertainty in your inputs so that you know what to expect in your outputs. 

Contact Information: 
Technical Support: 1-866-475-2124 (Toll Free in North America) or  
1-519-579-5877 
Sales: 1-888-SigmaXL (888-744-6295) 
E-mail: support@SigmaXL.com Web: www.SigmaXL.com 
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